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Thank you for purchasing the MCE-202 MultiNA microchip electrophoresis system for DNA/RNA analysis (hereafter 
"MultiNA").

Original version approved in English.

Important:
• Read this manual thoroughly prior to operating this product.
• Keep this manual near the product in a safe location for future reference.
• Operate this product in accordance with the instructions given in this manual.
• Follow all WARNING and CAUTION instructions.
• For information on the basic operation of the Windows® operating system, please refer to that product's 

Instruction Manuals. 
• Do NOT disassemble or modify this product without permission from Shimadzu Corporation.
• Ensure that these instruction manuals are transferred if the user or site of use changes.
• Contact your Shimadzu representative if the following is required:

- Replacement of this manual, or any WARNING or CAUTION labels
- Product installation, adjustment, or re-installation after product movement, or for service and repairs

Notice
• Copyright of this manual is owned by Shimadzu Corporation. Reproduction or duplication of the content, in 

whole or part, without permission of the company is strictly prohibited.
• For the sake of improvement, the content of this manual is subject to modifications without notice.
• Every effort has been made to ensure that the content of this manual was correct at the time of creation. 

However, in the event that any mistakes or omissions are discovered, it may not be possible to correct them 
immediately.

• The MultiNA and dedicated consumables are for research use only. Do NOT use them for any other purpose.
• The contents of the hard disk in a PC can be lost due to accident. To protect your important data from accidents, 

back up your data.
• Registered trademark:

- MultiNA® and MCE® are registered trademarks of Shimadzu Corporation.
- SYBR® is a registered trademark of Invitrogen Corporation.
- GelStar® is a registered trademark of FMC Corporation.
- pGEM® is a registered trademark of Promega Corporation.
- MicroAmp® and RNaseZAP® are registered trademarks of Applied Biosystems Inc.
- Thermo-Fast® is a registered trademark of Advanced Biotechnologies Ltd.
- Intel® and Pentium® are registered trademarks of Intel Corporation.
- BEMCOT® is a registered trademark of Asahi Kasei Fibers Corporation.
- Microsoft® Windows®XP Professional operating system is written as Windows XP.
- Microsoft® Windows® 7 Professional operating system is written as Windows 7.
- Windows is the registered trademark of Microsoft Corporation USA, (USA) and in all other countries.
- Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation.
- Adobe, Acrobat and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the 

United States and/or other countries.
- All other brand names and product names may be trademarks or registered trademarks of their respective companies.

© 2010-2013 Shimadzu Corporation. All rights reserved.

Introduction
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The following manuals are provided.

The following symbols are used in this manual.

Instruction Manuals

List of Instruction Manuals

Name Media Description

MultiNA Instruction Manual Booklet + PDF Describes the complete MultiNA system, including handling, 
operation, maintenance, and troubleshooting.
Also describes the preparation and placement of reagents and 
samples in the system, execution of analysis, data analysis, and 
basic operation of the MultiNA system using the provided software.

Quick Manual Booklet + PDF This quick manual includes the essential information to allow 
operating the MultiNA system smoothly and in good condition. 
Please keep in a convenient location. 

Help Online Help Display the PDF files for the MultiNA Instruction Manual and Quick 
Manual via the [Help] menu at the top of the window in the provided 
software.

Manual Notation

Symbol Meaning

! WARNING Indicates a potentially hazardous situation which, if not avoided, could result in serious injury or possibly 
death.

! CAUTION Indicates a potentially hazardous situation which, if not avoided, may result in minor to moderate injury or 
equipment damage.

Emphasizes additional information that is provided to ensure the proper use of this product.

^ Reference Indicates location of related information.

[ ] Indicates text displayed on the screen, such as the names of buttons, menu items, settings, screens, and 
icons.
Example: Click [OK] (where "OK" is the name of a button in a dialog box)
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To ensure safe product operation, read these important safety instructions carefully before use and follow all 
WARNING and CAUTION instructions given in this section.

Product Applications

Installation Site

Safety Instructions

! WARNING

• This is a microchip electrophoresis system for DNA/RNA analysis. Do NOT use it for any other 
application.
Doing so may result in accidents.

• This instrument is for Research Use Only. Not for use in diagnostic procedures. 
If this instrument is used for non-research applications, please note that Shimadzu Corporation is in no way 
responsible for any problems related to the instrument, its data, claims from third parties, or any other problems 
that occur.

! WARNING

• Fire is prohibited in the vicinity of the instrument.
Fire must not be used at the site where the instrument is installed. In addition, avoid installation in the same 
room with equipment that generates sparks. Do NOT use flammable sprays (such as hairsprays or aerosol 
insecticides) or flammable solvents in the vicinity of this instrument. Provide fire extinguishers in case of an 
emergency.

• Install a sink in the vicinity of this instrument.
If reagent chemicals come in contact with the eyes or skin during operation, flush them away immediately with a large 
quantity of water. A sink should be installed in the vicinity of this equipment if at all possible.
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! CAUTION

• Installation of the instrument is prohibited at sites exposed to corrosive gases, or to significant debris 
and dust.
To ensure the life of the instrument and to maintain proper operation, avoid installation sites that are exposed to 
corrosive gases or to significant dust or debris.

• Do NOT install the instrument near equipment that generates strong magnetic fields.
To ensure normal operation of this instrument, avoid installation sites that are subject to strong magnetic fields. 
Add noise filters if there is significant noise on the power lines.

• To maintain performance, observe the following site conditions.
• Rooms with an ambient temperature between 18°C and 28°C, and minimal daily temperature fluctuations

(If the ambient temperature exceeds 28°C, a temperature control error can occur and instrument operation 
may stop.)

• Sites where the instrument is protected from direct exposure to drafts from coolers, heaters or air 
conditioners

• Sites protected from exposure to direct sunlight
• Sites not exposed to vibrations
• Sites where humidity is maintained between 40% and 80%
• Sites where condensation does not occur
• Sites with a maximum altitude of 2000 m.

• During analysis, ensure that the drain tubing ports and the gap between the top cover and the 
instrument are not exposed to direct light sources (such as desktop fluorescent lamps, flashlights, 
and camera flashes).
This may result in noise.
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Installation

! WARNING

• For safe instrument operation, after the instrument is moved to a different location, contact your 
Shimadzu representative for instrument installation, adjustment, or reinstallation.

• Always supply power from a power supply equipped with an electrical leakage breaker.

• The instrument's power supply voltage and power consumption are as follows. The power supply 
voltage is indicated on the label on the power connector on the back of the instrument. Connect the 
instrument to a suitable power source.
Connecting it to an improper power source may result in fire or shock.
The intended performance may not be obtained if the power supply voltage is unstable or the power capacity is 
insufficient. Check the power requirements for the entire system before arranging a suitable power source.

• Ground the instrument.
If malfunctions or leakages occur, shock may result if the equipment is not properly grounded. Grounding is also 
important to ensure stable instrument operations.

• Do NOT insert or touch the adaptor ground lead to the power outlet. 
This may result in fire or electric shock.

• Handle the power cable carefully.
If the following cautions are not observed, the cable may be damaged, resulting in fire, electric shock, or 
malfunction. If the cord does become damaged, contact your Shimadzu service representative immediately.

• Do NOT place it under heavy objects.
• Do NOT place it near heating equipment.
• Do NOT modify the cord.
• Do NOT forcibly bend or stretch the cord.
• Hold the plug when inserting and removing the cord.

Voltage (Indicated on the Label On 
the Back of the Instrument) 100-120/220-240 V ~

Power consumption 300 VA

Frequency 50/60 Hz

Voltage fluctuation Less than ±10%

Interrupting capacity 40 A

Installation category II

Pollution degree 2
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! CAUTION

• This instrument weighs 43 kg. When installing the system, consider the total system weight including 
the PC and other system components.
Install the instrument on a flat, stable desk or stand, capable of supporting the total system weight.

• Install on a flat desk or stand.
If the instrument is significantly inclined, the analysis performance will be adversely affected.

• Installation space for the instrument, PC, and glass rinse water bottle must be at least 1,015 mm to 
1,165 mm W (if a desktop PC is used) by 600 mm D by 980 mm H.
(See " Example Installation 1: Waste container positioned in front of the instrument" P.264.)
This does not include the waste container which is placed on the floor. The size displays the maximum height 
with the cover open.

• When installing the instrument against a wall, leave a gap of at least 50 mm between the rear of the 
instrument and the wall.
If this condition is not met, fan-driven air cooling will not be sufficient and the instrument may overheat and 
reduce performance. Also the top cover will not fully open.

• Install the instrument at a site where the rear of the instrument can be accessed easily.
The syringe cover on the rear of the instrument must be opened when replacing the syringe or plunger.

• Allow at least a 100 mm of space in front of the instrument.
The front cover must be opened to replace the pump cartridges.

• When installing the instrument, leave enough space to operate the power switch on the bottom right 
side of the instrument near the rear. 
The power must be turned OFF quickly in the event of an instrument or other emergencies. The power must be 
turned OFF quickly in the event of a problem with the instrument or other emergency.

• Place the waste container on the floor.
Waste fluid is conveyed to the waste container by gravity. Place the container at a position lower than the 
instrument.

• Note the following cautions regarding the waste tubing. Cut the tubing as necessary to suit the 
installation site.

• The tubing should not be bent.
• The tubing should not be elevated.
• The tip of the tubing should not be immersed in the waste fluid inside the waste container.

• If necessary, install safety fasteners and other earthquake measures.
Recommended product: Part No. S037-62401-03, FASTENER, RT-400 GRAY (set of two)
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Operation

Top Cover Usage

! WARNING

• Always wear protective equipment (protective clothing, gloves, eyewear, and mask) when handling 
reagents.
Reagents contain irritating and harmful chemical substances. If any type of reagent makes contact with the eyes 
or skin, immediately rinse the affected area with large amounts of water and seek medical attention from a 
doctor and follow their advice.
If a reagent is ingested or inhaled by accident, immediately seek medical attention from a doctor and follow their 
advice.

• Always read the MSDS before handling reagents.
The MSDS contains important safety information regarding the handling, storage, and disposal of reagents.

! CAUTION

• Dispose of the waste fluid in accordance with guidelines from the applicable management 
departments.
In addition to rinse water, the waste liquid contains a separation buffer, marker solution, and dyes. It will also 
contain formamide from RNA analysis.

• Discard waste fluid on a regular basis to prevent the waste container from overflowing.
If the waste tubing becomes clogged, waste fluid may leak from inside the instrument.

• Check the state of the waste container and tube before starting analysis.
There is a risk that waste fluid may overflow within the instrument. Check that:

• The tip of the waste tubing is not immersed in waste fluid in the waste container.
• There is enough empty space in the waste container.
• The waste tubing is not bent or elevated.

• Do NOT allow liquid to be spilt on the PC.

! WARNING

• Do NOT forcibly open the top cover during instrument operation (blinking green LED on front 
indicator).
During operation the top cover is locked and cannot be opened.

• Do NOT apply lateral force to the top cover when opening or closing.
This may deform the top cover and result in damage.

• Do NOT remove the top cover.
Injury or accident may occur.

• If the top cover does not open or close properly, contact your Shimadzu service representative 
immediately.
A field engineer from Shimadzu will perform repairs.
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Microchip Use

Reagent Kit Use

Chip Cleaning Kit Use

Drive Unit

! CAUTION

• Do NOT scrub the reservoir on the microchip when wiping away moisture.
Lint may clog the microchip channels.

• Do NOT touch the surfaces of the microchip with your bare hands.

• Do NOT scratch the microchip electrodes during handling.
If salt or other material has hardened on the electrodes, apply water to dissolve the salt and then gently wipe it 
away.

• Do NOT clean the microchip using an ultrasonic cleaner.
This will damage the microchip.

! WARNING

• The reagent kit provided with this instrument is only for experimental and research purposes.
It is not authorized for the diagnosis and treatment of human or animal illnesses. Do NOT use it for any 
applications that directly affects humans or animals, such as with medical products, cosmetics, or food.

• If reagent gets into the eyes or makes contact with the skin, immediately wash the applicable area 
with copious amounts of water and consult a medical professional. If reagent is accidentally 
swallowed or the vapor is inhaled, immediately consult a medical professional.
Refer to the MSDS for details.

• Use only the reagents specified in these instruction manuals.

! WARNING

• Always read the instruction manual provided with the chip cleaning kit before handling the contents of 
the kit.
The instruction manual for the chip cleaning kit describes safety precautions that are important to ensure safe 
use.

! WARNING

• Do NOT touch any parts other than those specified in these manuals.
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Maintenance and Servicing

Relocating the Product

! WARNING

• Turn the instrument OFF before maintenance.
Shock or accident may occur.

• If the instrument requires servicing, contact your Shimadzu service representative.

• Do NOT perform any disassembly or modification procedures that are not described in these 
manuals.
Injury or accident may occur.

! CAUTION

• Use only the parts described in "10 Parts Specifications" P.279.
Normal operations are not ensured if other parts are used.

• Do NOT leave the instrument wet.
This may result in rust or discoloration. To clean the instrument, wipe it with a soft cloth moistened slightly with 
water, then remove any moisture with a soft dry cloth.

• Do NOT wipe it with alcohol, paint thinner or other organic solvents.
These solvents may damage the paint on the instrument cover.

! CAUTION

• Before moving the instrument, the drives must be fastened with the transportation fixtures.
Contact your Shimadzu service representative.

• Unplug the LAN cable connected to the PC.

• Do NOT lift the instrument by the top cover.

• Do NOT pinch fingers or hands in gaps inside the product.
This may result in injury.

• Do NOT bump the instrument or subject it to excessive vibrations.
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Emergency Measures

During a Power Outage

! WARNING

• If a strange noise or smell emanates from the instrument, or some other irregularity is noticed, stop 
instrument operation using the following procedure, and contact your Shimadzu service representative.
1. Switch OFF the power switch on the lower right side of the product.

2. Detach the power cable.

! CAUTION

• If an electric power outage occurs during analysis, the instrument stops. If separation buffer is left 
remaining in a microchip or sample probe when the instrument stops it may dry out and obstruct the 
microchip or sample probe. To avoid such a condition, take the action described below.
1. Turn OFF the power of the instrument.
2. When the electric power comes back on, turn ON the instrument. If the power of the PC is OFF, turn it ON. 
3. Rinse the microchip with water according to the procedure described in "6.2.6 Inspecting and Washing 

Microchip Reservoirs" P.204 and reinstall it in the instrument.
4. Rinse the sample probe according to the procedure described in "6.2.2 Sample Probe and Aspirator" P.200.
5. Check if the sample probe is obstructed according to the procedure described in "  Inspection Procedure" 

P.218.
6. Rinse all microchips installed in the instrument according to the procedure described in "All Chip Washing" in 

"4.5.8 Wash" P.119.

Carrying out the procedure above enables regular operation. In case of any abnormal condition, see "8 
Troubleshooting" P.241 and take action accordingly.

• Files may not be normally created on rare occasions when the PC stops during a process to save data in a 
file.

• In MultiNA, results of analysis for each sample are saved in data files during analysis of multiple samples. 
Therefore, even if analysis is stopped due to a power outage during analysis, results of analyses up to right 
before the power outage are saved in files.

Power switch

OFF state
Instrument front
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Shimadzu provides the following warranty for this product.

* If there is a document, such as a warranty, provided with the product, or there is a separate contract agreed upon that includes warranty 
conditions, the provisions of those documents shall apply.

* Warranty periods for products with special specifications and systems are provided separately.

Warranty

1. Period: Please contact your Shimadzu representative for information about the period of this 
warranty.

2. Description: If a product/part failure occurs for reasons attributable to Shimadzu during the warranty 
period, Shimadzu will repair or replace the product/part free of charge. However, in the case 
of products which are usually available on the market only for a short time, such as personal 
computers and their peripherals/parts, Shimadzu may not be able to provide identical 
replacement products.

3. Limitation of 
Liability:

1) In no event will Shimadzu be liable for any lost revenue, profit or data, or for special, indirect, 
consequential, incidental or punitive damages, however caused regardless of the theory of 
liability, arising out of or related to the use of or inability to use the product, even if Shimadzu 
has been advised of the possibility of such damage.

2) In no event will Shimadzu's liability to you, whether in contract, tort (including negligence), or 
otherwise, exceed the amount you paid for the product.

4. Exceptions: Failures caused by the following are excluded from the warranty, even if they occur during 
the warranty period.

1) Improper product handling

2) Repairs or modifications performed by parties other than Shimadzu or Shimadzu designated 
companies

3) Product use in combination with hardware or software other than that designated by 
Shimadzu

4) Computer viruses leading to device failures and damage to data and software, including the 
product's basic software

5) Power failures, including power outages and sudden voltage drops, leading to device failures 
and damage to data and software, including the product's basic software

6) Turning OFF the product without following the proper shutdown procedure leading to device 
failures and damage to data and software, including the product's basic software

7) Reasons unrelated to the product itself

8) Product use in harsh environments, such as those subject to high temperature or humidity 
levels, corrosive gases, or strong vibrations

9) Fires, earthquakes, or any other act of nature, contamination by radioactive or hazardous 
substances, or any other force majeure event, including wars, riots, and crimes

10)Product movement or transportation after installation

11) Consumable items
Note: Recording media such as floppy disks and CD-ROMs are considered consumable items.

5. Non-Research 
Applications:

This instrument should be used only for research applications. It should not be used for 
diagnosis or examination purposes. If this instrument is used for non-research applications, 
please note that Shimadzu Corporation is in no way responsible for any problems related to 
the instrument, its data, claims from third parties, or any other problems that occur. 
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After-Sales Service
If a problem arises, inspect the product and take the appropriate corrective action described in "6 Inspection and 
Maintenance" P.197 and "8 Troubleshooting" P.241. If the problem persists or the symptoms are not covered in these 
chapters, contact your Shimadzu representative.

Replacement Parts Availability
Replacement parts for this product will be available for a period of seven (7) years after the product is discontinued. 
Thereafter, such parts may cease to be available. Note, however, that the availability of parts not manufactured by 
Shimadzu shall be determined by the relevant manufacturers.

In order to maintain the instrument's performance and obtain accurate measurement data, daily inspection and 
periodic inspection/calibration are necessary.
• For daily maintenance, inspection, and replacement parts, see "6 Inspection and Maintenance" P.197 of this 

Instruction Manual.
• Periodic inspection/calibration should be requested to your Shimadzu representative.
• Replacement cycles described for periodic replacement parts are rough estimate.  

Replacement may be required earlier than the described replacement cycles depending on usage environment and 
frequency. 

After-Sales Service and Availability of Replacement Parts

Maintenance, Inspections, and Adjustment
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PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THE SOFTWARE. 

SHIMADZU Corporation ("SMZ") is willing to license the SMZ software provided herein, together with accompanying documentation (collectively "SOFTWARE") to you only upon the 
condition that you accept all of the terms and conditions contained in this License Agreement. By using the SOFTWARE, you agree to be bound by the terms of this Agreement. If you do 
NOT agree to all these terms of this Agreement, promptly return the unused SOFTWARE to the party (either SMZ or its reseller) from whom you acquired it to receive a refund of the 
amount you paid.

1. LICENSE
SMZ grants you a non-exclusive and nontransferable license to use the SOFTWARE subject to the following terms and conditions.

2. LIMITATION OF USE
Except as specifically authorized by SMZ, you may NOT:
a.Use the SOFTWARE, or permit the SOFTWARE to be used, on more than one computer at any one time.
b.Copy the SOFTWARE except one (1) archival copy of the SOFTWARE.
c.Modify, reverse engineer, decompile, disassemble, or create derivative works based upon the SOFTWARE.
d.Transfer, rent, lease or grant any rights in the SOFTWARE in any form to anyone else.

3. TITLE AND OWNERSHIP
This license is not for sale and it may not be assigned or sublicensed to anyone else. Title and all associated intellectual property rights to the SOFTWARE shall remain in SMZ and/or its 
licensor.

4. UPGRADES
You are entitled to receive all official software upgrades for the SOFTWARE that SMZ will release as deemed necessary by SMZ. An upgrade means certain supplemental program 
modules and/or information for bug fixing and/or updates to the defects and/or failures of the SOFTWARE that are acknowledged or confirmed by SMZ. An upgrade excludes hardware, 
network, consulting services, third party products, operation and general computer system maintenance. All supplemental program module for upgrades and enhancements furnished to 
you shall be deemed to be part of the SOFTWARE and subject to the terms and conditions set forth in this Agreement.

5. LIMITED WARRANTY
SMZ warrants that for a period of one (1) year from the date of purchase, as evidenced by a copy of the receipt, the media on which SOFTWARE is furnished will be free of defects in 
materials and workmanship under normal use. 
Except for the foregoing, SOFTWARE is provided AS IS. Your exclusive remedy and the entire liability of SMZ and its suppliers under this limited warranty will be, at SMZ's option, repair, 
replacement, or refund of the Software if reported (or, upon request, returned) to the party supplying the SOFTWARE to you. In no event does SMZ warrant that the Software is error free 
or that you will be able to operate the SOFTWARE without problems or interruptions.
EXCEPT AS SPECIFIED IN THIS WARRANTY, ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS, AND WARRANTIES INCLUDING, WITHOUT LIMITATION, ANY 
IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT, ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE 
PRACTICE, ARE HEREBY EXCLUDED TO THE EXTENT ALLOWED BY APPLICABLE LAW. 

6. LIMITATION OF LIABILITY
IN NO EVENT WILL SMZ BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTIAL OR PUNITIVE DAMAGES, 
HOWEVER CAUSED REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF OR RELATED TO THE USE OF OR INABILITY TO USE SOFTWARE, EVEN IF SMZ HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. IN NO EVENT WILL SMZ'S LIABILITY TO YOU, WHETHER IN CONTRACT, TORT (INCLUDING NEGLIGENCE), OR 
OTHERWISE, EXCEED THE AMOUNT PAID FOR SOFTWARE.

7. TERMINATION
This License is effective until terminated. You may terminate this License at any time by destroying all copies of SOFTWARE including any documentation. This License will terminate 
immediately without notice from SMZ if you fail to comply with any provision of this License. Upon termination, you must destroy all copies of SOFTWARE.

8. GENERAL
a.This Agreement is the entire agreement. If any provision of this agreement is held invalid, the remainder of this agreement shall continue in full force and effect.
b.This Agreement shall be construed and governed in accordance with the laws of Japan, excluding its conflict of law rules.
c.The exclusive jurisdiction for any disputes arising out of or in connection with this Agreement shall be Kyoto District Court of Japan.
d.The invalidity or unenforceability of any provision of this Agreement shall not affect the validity or enforceability of any other provision.

Software License Agreement
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Disposal of the Instrument
Contact your Shimadzu service representative for details on returning the instrument for disposal.
If disposing of the instrument independently, segregate the instrument into general industrial waste and household 
waste and dispose of it according to the processing guidelines stipulated by law in your region.

Disposal
Dispose of waste fluid appropriately in accordance with prescriptions or guidelines from the applicable management 
department.

Disposal of this Product

! WARNING

• Always wear protective equipment (protective clothing, gloves, eyewear, and mask) when disposing 
of waste fluid.
Waste fluid may contain irritating and harmful chemical substances. If any type of waste fluid makes contact with 
the eyes or skin, immediately rinse the affected area with large amounts of water and seek medical attention 
from a doctor and follow their advice.
If waste fluid is ingested or inhaled by accident, immediately seek medical attention from a doctor and follow 
their advice.

! CAUTION

• Dispose of waste fluid appropriately in accordance with the laws, regulations, or rules of your country, 
municipality, or facility.
In addition to rinse water, waste fluid includes the separation buffer, marker solution, and dye. It also contains 
formamide from RNA analysis.
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For safety, warning labels are attached in locations where special attention is required.
Should any of these labels peel off or become damaged, contact your Shimadzu representative immediately for a 
replacement.

Warning Labels

•Indicates a high temperature area.

•Refer to the Instruction Manual before performing operations in this area.

•Fuses
Before fuse replacement, refer to "6.3.10 Fuse Replacement" P.234.
Warning label: Part No. S228-42603

• Class 1 LED Product
This is a Class 1 LED Product.
Warning label: Part No. S292-27990
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• Autosampler Motor Unit
CAUTION: HOT! Touching while hot can result in burns.
Warning label: Part No. S037-72999-12

• Chip Stage
The chip stage is kept at 37°C. During microchip replacement, prolonged contact with chip stage 
can result in low-temperature burns.
Warning label: Part No. S037-72123-00 (Japanese)/S037-72126-02 (English)

• Autosampler Cover
Do NOT remove or disassemble any part of the cover, except where specified in the Instruction 
Manual.
Warning label: Part No. S037-72999-02, S292-27778
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Descriptions in this section apply only to the following models: 
• S292-28000-38/44/58 MULTINA SYSTEM ASSY (230 VAC, English)

This product complies with European standard EN61326-1: 2006, class B for electromagnetic interference 
(Emissions) and basic test requirements for electromagnetic susceptibility (Immunity).

EN61326-1 Immunity (Electromagnetic Susceptibility)
Test conditions are as follows.

• IEC 61000-4-2 Electrostatic Discharge: 
Air: 2/ 4/ 8 kV, Contact: 2/ 4 kV

• IEC 61000-4-3 Radiated, Radio-Frequency, Electromagnetic Field: 
3 V/m (80 MHz to 1.0 GHz), 3 V/m (1.4 GHz to 2.0 GHz), 1 V/m (2.0 GHz to 2.7 GHz)

• IEC 61000-4-4 Transient/Burst (Electrical Fast Transients): 
2 kV on AC Power Port, 0.5/ 1 kV on Signal and Control Lines

• IEC 61000-4-5 Voltage Surge: 
0.5/ 1 kV line to line, 0.5/ 1/ 2 kV line to ground

• IEC 61000-4-6 Conducted RF Immunity: 
3 V on AC Power Port, 3 V on Signal and Control Lines

• IEC 61000-4-8 Power Frequency Magnetic Field: 
30 A/m, 50 Hz

• IEC 61000-4-11 Voltage Variations/Dips/Interrupts: 
0 % for 0.5/1 cycle, 40 % for 10 cycle, 70 % for 25 cycle, 0 % for 250 cycle

Compliance with these standards does not ensure that the product can operate at a level of electromagnetic 
interference that is stronger than the level tested. Interference stronger than the values specified above may cause 
the product to malfunction.

When installing or using this product, especially in an industrial location:
Locate the product away from any device emitting strong levels of electromagnetic noise.
Use a power source that is separated from the power source of any device emitting strong levels of 
electromagnetic noise.

To prevent static electricity:
Prior to touching the product, the operator should be sure to discharge the static electricity stored in their body by 
first touching a grounded metallic structure.
Do NOT touch any terminals or connectors that are not connected to cables while the product is turned ON.

Electromagnetic Compatibility
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To all users of Shimadzu equipment in the European Union:
Equipment marked with this symbol indicates that it was sold on or after 13th August 2005, 
which means it should not be disposed of with general household waste. Note that our 
equipment is for industrial/professional use only.

        WEEE Mark

Contact Shimadzu service representative when the equipment has reached the end of its life. They will 
advise you regarding the equipment take-back.

With your co-operation we are aiming to reduce contamination from waste electronic and electrical equipment and 
preserve natural resource through re-use and recycling.
Do not hesitate to ask Shimadzu service representative, if you require further information.

Action for Environment (WEEE)
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1Overview and System 
Configuration

1.1 Overview

• This instrument conducts electrophoresis in channels formed in a microchip with a quartz substrate.
• This instrument is fully automated, including the filling of the microchip with separation buffer, injection of the 

sample, application of voltage, the fluorescence detection of the separated fragments, and data analysis.
• The instrument consists of an autosampler, a pneumatic unit, a high voltage unit, and a detector using LED 

and PMT.
• The PC software performs analysis processing on the fluorescent signal obtained from the fluorescent 

detector.
• The ratio of 28S/18S rRNA is calculated during RNA analysis.
• The gel image, electropherogram, and data analysis results will be displayed and printed.

1.2 Features

Reduction of Running Costs
Reusing microchips repeatedly instead of disposing of them after a single use allows for low analysis costs 
that are equal to or less than those for agarose gel electrophoresis (as investigated by Shimadzu).

Equipped with Automatic Analysis Functions
Place the reagent and sample in the instrument and start the registered analysis schedule. Everything else 
is automatic until analysis is completed.

Parallel Processing with Four Microchips Increases Throughput
Up to four microchips can be installed.

Processing speed is increased by parallel processing of pretreatment (rinsing the microchips, dispensing 
and filling with separation buffer, and dispensing of samples), electrophoresis, and detection by using 
multiple chips. As a result, processing speeds of 12 samples/20 minutes, and 96 samples/124 minutes* 
have been achieved.

* The result of performing analysis using four microchips in DNA-1000 kit premix mode. The time does not 
include pre and post analysis rinsing. Indicated processing times are approximate.

! WARNING

• This instrument is a microchip electrophoresis system for DNA/RNA analysis. Do NOT use it 
for any other application.
Using this instrument for any purposes other than intended purposes (for DNA / RNA analysis) may 
result in equipment damage or personnel injury.



1  Overview and System Configuration

2   MultiNA Instruction Manual

High-Precision Size Estimation and Quantitation
By mixing markers with the samples for analysis, high-precision sample size estimation and quantitation 
results are obtained in comparison with agarose electrophoresis.

Gel Image Displays Comparable to Those for Agarose Electrophoresis
Analysis data can be typically obtained based on the migration time. This can be converted to images of 
migration distances, and the list of these images can be displayed. This is comparable to the gel images 
obtained by conventional agarose gel electrophoresis.

1.3 System Configuration
The structure of the MultiNA system is as shown below.

DNA Standard Analysis (DNA-1000, Premix) 

                             Analysis Data Acquisition (1st) 

#1   Microchip#1  Pretreatment   Electrophoresis            (2nd) 

#2   Microchip#2         Pretreatment   Electrophoresis                   (3rd) 

#3   Microchip#3                 Pretreatment   Electrophoresis                    (4th) 

#4   Microchip#4                        Pretreatment   Electrophoresis                   (5th) 

#5   Microchip#1                                Pretreatment   Electrophoresis  

Part Name Part No. Remarks

MULTINA SYSTEM 
ASSY

292-28000-XX For details on part names and functions, see "1.6 Instrument 
Description" P.8
For details on pump cartridge replacement, see "6.3.6 Pump 
Cartridge Replacement" P.223

Standard accessories For details, see "  Standard Accessories" P.279

PC To be provided by the 
customer.

For the required specifications, see "1.4 Specifications" P.3

Microchip S292-36000-91
S292-36010-41

Type WE-C
Type WT
Material: High purity synthetic quartz

Reagent Kit
DNA-500
DNA-1000
DNA-2500
DNA-12000
RNA

S292-27910-91
S292-27911-91
S292-27912-91
S292-36600-91
S292-27913-91

25 - 500 bp
100 - 1,000 bp
100 - 2,500 bp
100 - 12,000 bp
Up to 28S rRNA (4.7 knt to 5.0 knt)
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1.4 Specifications

Basic Analysis Performance*1

Type of Kit Four types for DNA analysis (DNA-500, DNA-1000, DNA-2500, and DNA-12000), and one 
type for RNA analysis
Five types in total

Size Range DNA-500 kit : 25 bp to 500 bp
DNA-1000 kit : 100 bp to 1,000 bp
DNA-2500 kit : 100 bp to 2,500 bp
DNA-12000 kit : 100 bp to 12,000 bp
RNA kit : Up to 28S rRNA (4.7 knt to 5.0 knt)

Sizing Resolution DNA-500 kit : 5 bp (25 bp to 100 bp), 5 % (100 bp to 500 bp)
DNA-1000 kit : 5 % (100 bp to 500 bp), 10 % (500 bp to 1,000 bp)
DNA-2500 kit : 10 % (100 bp to 1,000 bp), 20 % (1,000 bp to 2,500 bp)
DNA-12000 kit : 10 % (100 bp to 1,000 bp), 20 % (1,000 bp to 12,000 bp)

Sizing Accuracy DNA-500 kit : ±5bp (25 bp to 100 bp), ±5 % (100 bp to 500 bp)
DNA-1000 kit : ±15 % (100 bp to 1,000 bp)
DNA-2500 kit : ±15 % (100 bp to 2,500 bp)
DNA-12000 kit : ±15 % (100 bp to 12,000 bp)

Quantitative Range DNA analysis: 0.5 ng/μL to 50 ng/μL
(10 mM Tris-HCl buffer containing 50 mM KCl, 1.5 mM MgCl2)

RNA analysis: 25 ng/μL to 500 ng/μL (Total RNA), 25 ng/μL to 250 ng/μL (mRNA)
(10 mM Tris-HCl buffer containing 1 mM EDTA)

Quantitative Accuracy DNA-500 kit: ±30% 
(10 mM Tris-HCl buffer containing 50 mM KCI)

DNA-1000 kit: ±30% 
(10 mM Tris-HCl buffer containing 50 mM KCI)

DNA-2500 kit: ±30% 
(10 mM Tris-HCl buffer containing 50 mM KCI)

DNA-12000 kit: ±40 % *2
(10 mM Tris-HCl buffer containing 50 mM KCI)

Quantitative 
Repeatability

RNA analysis: CV 10 % max. (CV 20 % max. for 150 ng/μL or higher of total eukaryotic 
RNA)

Maximum Salt 
Concentration

DNA analysis: Maximum 10 mM Tris containing 125 mM KCl (NaCl)
RNA analysis: Maximum 10 mM Tris containing 1 mM EDTA

Limit of Detection DNA analysis: 0.2 ng/μL
(10 mM Tris-HCl buffer containing 50 mM KCl, 1.5 mM MgCl2)

RNA analysis: 5 ng/μL (Total RNA), 25 ng/μL (mRNA)
(10 mM Tris-HCl buffer containing 1 mM EDTA)

Sample Container 96-well plate
• Applied Biosystems: MicroAmp® Optical 96-well Reaction Plate

(Part No. N801-0560)
• ABgene: PCR plate (Part No. AB-0600)

8-strip tube (no caps)
• Applied Biosystems: MicroAmp® Strip Tubes (8 tubes/strip) 

(Part No. N801-0580)
• ABgene: Strips of 8 Thermo-Tubes (Part No. AB-0452)
• ABgene: 8 Low Profile Thermo-Strip (Part No. AB-0771)*3

12-strip tube (no caps)
• ABgene: Strips of 12 Thermo-Tubes (Part No. AB-1112)
• ABgene: 12 Low Profile Thermo-Strip (Part No. AB-0847)*3

Single-strip tube (no caps)
• Applied Biosystems: MicroAmp® Reaction Tubes (Part No. N801-0533)

Aluminum Seal ABgene: PCR foil seal #0626 (adhesive seal)
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Required Sample 
Volume

DNA analysis:
• Premix mode : 2 μL to 10 μL (6 μL to 30 μL after mixing with marker solution)
• On-chip mixing mode : 5 μL to 30 μL

RNA analysis:
• Premix mode : 3 μL to 15 μL (6 μL to 30 μL after mixing with marker solution)

*1 The above specifications have been verified with standard samples and analysis conditions prescribed by Shimadzu.
There are cases where these specifications will not be satisfied due to the sample for analysis and specified analysis 
conditions.

*2 The quantitative accuracy of the DNA-12000 kit is based on verification at 200 to 12000 bp.
*3 Since the tubes have tabs at both ends, they cannot be used with the extra sample stand.
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Hardware
MCE-202 MultiNA

PC Requirement

Software
MultiNA Control Software

Data Analysis Software MultiNA Viewer

Number of Microchips 
Installed

Up to four microchips

Maximum Number of 
Samples

108 samples (96 samples + extra 12 samples)

Maximum Number of 
Analyses per Analysis 
Schedule

120 analyses (multiple analyses are possible with the extra sample stand)

Size and Weight of 
Instrument

W415 × D545 × H508 mm, 43 kg

Power Supply 100 V AC to 120 V AC / 220 V AC to 240 V AC, 300 VA max.
Usage Conditions Temperature: 18°C to 28°C, Temperature fluctuations: 10°C/hr max., RH: 40 % to 80 % No 

condensation
Detection System Fluorescence, filter spectrum (cuton wavelength 525 nm)
Light Source Blue LED
Detector PMT
Temperature Control 37 °C
Power Supply for 
Electrophoresis

Max. rated voltage 1.5 kV, maximum current 250 μA

Separation Buffer Filling Offline filling using air cylinder pressurization

OS Windows® XP Professional SP2 or later (English/Japanese versions) 32-bit version
Windows® 7 Professional (English/Japanese versions) 32-bit version

CPU Intel® Pentium® III processor or equivalent, 1 GHz min.
Memory Windows XP: 512 MB min.

Windows 7: 1 GB min.
HDD 40 GB min.
Display 1,024 × 768 pixel min. resolution
LAN port 100Base-TX: 1 port min.

(Expansion LAN ports are required if connected to LAN since 1 port is dedicated for 
MultiNA control.)

Other CD-ROM drive (required for installation), printer (B/W or color)

Analysis Analysis schedule creation, real-time control, automatic analysis pretreatment, automatic 
analysis post-treatment, automatic error processing

Display Monitor and Log Real-time display, analysis log management, management of consumables and 
maintenance parts usage record

Maintenance Service Analysis performance check, and inspection following replacement of consumables
Data Formats Proprietary data format. Analysis sample information can be imported in CSV or EXCEL 

format.

Data Analysis Size estimation, concentration quantitation, data manipulation of automatic analysis 
results

Data Display Gel image, electropherogram list and detailed display, peak tables, RNA report display
Output Analysis information, gel images, electropherograms, and analysis results can be printed 

in various layouts, and exported in CSV format.
Utilities Data searches, display of inspection results for analysis performance
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1.5 Operating Principles

1.5.1 Flow of Automatic Analysis
The MultiNA automatically executes the following operations when analysis is started.

Pretreatment

Initial Checks and Analysis Preparation

•The following items are checked before proceeding to analysis.
• Mounted state of the sample plate holder
• Presence of chips
• Residual volume of reagent (separation buffer/marker)
•The following instrument preparation is executed.

• Probe rinsing
• Chip conditioning

•The following pretreatment is executed for each analysis.
• Microchip channel and reservoir rinsing
• The separation buffer filling to the channels and dispensing to the 

reservoir
• Dispensing sample/marker solution to reservoir No. 1.

Sample Loading

Voltage is applied to the microchip and the sample is introduced to the 
loading channel from reservoir No. 1.

Electrophoresis Separation/Detection

The direction of the voltage applied changes.
Part of the sample introduced to the loading channel is diverted into 
the separation channel and moved in the direction of the detector. 
This part of the sample undergoes separation in the separation 
channel while combining with the dye in the separation buffer. The 
detector detects fluorescent signals (excited by LED) using the 
confocal optical system.

Post Treatment

The microchip, sample probe, and aspirator are rinsed.
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1.5.2 Analysis and Data Processing
In MultiNA, the standard sample used to create the size calibration curve is referred to as a "ladder". First, 
the ladder is analyzed to create a calibration curve. Next, the sample is analyzed and size and 
concentration values are determined based on the created calibration curve.

When multiple ladders are analyzed at the same chip position, the latest ladder data is used in 
sample data analysis.

Step 1: Ladder analysis (P.64)

Step 2: Size calibration curve creation (P.173)

The ladder is analyzed on 
each microchip.

A size calibration curve is 
calculated for each 
microchip, based on the 
fragments contained in each 
ladder and their migration 
times.

Step 3: Sample analysis (P.69)

The sample is analyzed. The 
size of the fragments 
contained in the samples is 
predicted based on the size 
calibration curve. Fragment 
concentration is also 
quantified from the peak area 
and marker area.
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1.6 Instrument Description

Front

No. Item Explanation

1 Top cover Opening and closing cover on top of the instrument.
During operation the top cover is locked and cannot be opened.

2 Indicators LED indicators on the front of the instrument.

3 Front cover Cover on the bottom front of the instrument.
This cover is removed for replacement of the peristaltic pumps and their 
cartridges.

4 Peristaltic pump This is the suction pump at the bottom front of the instrument.
Five peristaltic pumps are arranged inside the front cover. Four of these 
(Nos. 1 to 4) correspond to the respective reservoir numbers. They 
suction out the buffer and sample within the reservoirs. The remaining 
pump (R) is used to supply water to the rinse pool.

1

2

4

Top Cover Closed

Front Cover Opened

Peristaltic Pump Names

Top Cover Opened

3
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Top Cover

The top cover must be closed to start analysis, automatic rinsing and other operations. During operation 
the top cover is locked and cannot be opened.

This instrument uses the following interlock systems as a safety mechanism.
• Commands from the PC to start analysis or other operations are only received if the top cover is closed.
• Voltage is only applied if the top cover is closed.
• The drives only operate if the top cover is closed.
• The top cover is locked when voltage is applied and during operation of the drives.
• If the top cover is accidentally opened during operation, the application of high voltage and the operation of 

mechanisms will stop immediately.

Opening the Top Cover

The top cover uses a "free-stop" mechanism, to stop the cover when it reaches an opening angle of 
approximately 60°. When the top cover is fully open, the instrument height is 98 cm.

Hold the front of the top cover and lift it upwards, confirm that the top cover will remain stationary, and then 
let go.

Indicators
The instrument's green LED indicator blinks during analysis, automatic rinsing, and other operations.
The following conditions are indicated by the combination of LED color and lit/blinking status.

! WARNING

• Do NOT forcibly open the top cover during instrument operation (blinking green LED on front 
indicator).
During operation the top cover is locked and cannot be opened.

• Do NOT apply lateral force to the top cover when opening or closing.
This may deform the top cover and result in damage.

• Do NOT remove the top cover.
Injury or accident may occur.

• If the top cover cannot be opened or closed properly, contact your Shimadzu service 
representative.
A field engineer from Shimadzu will perform repairs.

Type of LED Operation Details

Green (center) Blinking (0.3 second interval) Initializing after power is turned ON

Blinking (1 second interval) Operating

Lit Normal standby

Red (both sides) Lit An error has occurred (stays lit until the error is reset).
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Internal Parts

No. Item Explanation

1 Autosampler Dispenses sample, separation buffer, and marker solution to the 
microchip reservoirs.

2 Pneumatic unit Part to which the air cylinder and aspirators are attached.

3 Autosampler arm The part to which the autosampler is fastened.
Moves the autosampler forward and backward.

4 Autosampler motor Moves the autosampler right and left.

5 Aspirator Suctions the separation buffer and sample from the microchip reservoirs.

6 Rinse pool Where the aspirator is rinsed with rinse water.

7 Chip cover Holds the microchips, and is equipped with electrode contacts.

8 Extra sample stand Separate from the sample stand, and capable of holding up to 12 samples 
or ladders.
The wells are named X1 to X12.

9 Sample stand Where the sample tubes or sample plates are placed.

0 Reagent holder Where the separation buffer, marker solution, and probe rinsing solution 
are placed.

a Air cylinder Pressurization cylinder that fills the microchips with separation buffer.

b Piercing needle Pierces the aluminum seal on the sample plate prior to dispensing the 
sample.

c Sample probe Dispenses sample, ladder, and separation buffer to the microchips.

123

4

5
6

7 8 9 0

c

b

0

a

5

7

d

e

9

Bottom of Autosampler, Bottom Right

Chip Cover Opened

8
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Chip Stage and Microchips
The microchips are made of quartz and up to four microchips can be used with a single instrument.

Reagent Holder, Sample Stand, and Extra Sample Stand
The sample plate or sample tube set in the sample stand and extra sample stand are held down from 
above.

d Chip stage The base used to install microchips
A temperature control function is installed in the stage.

e Rinse port Where the sample probe is rinsed with rinse water.

No. Item Explanation

Chip Position 4 3 2 1Front

Chip Stage DetectorSerial number

Microchip

Channel Pattern Diagram

Reservoir No. 3 Reservoir No. 1

Reservoir No. 2
Reservoir No. 4

Reagent Holder, Sample Stand, and Extra Sample Stand Sample Holder

Probe Rinsing Solution

 Rinse Port Separation Buffer

Marker Solution
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Right Side

No. Item Explanation

1 Drain tube Delivers waste fluid discharged from the instrument to the waste 
container.

2 Serial number label Indicates the instrument's model and serial number.

3 Power switch Turns the instrument ON/OFF.

4 Suction filter Filter at the end of the water line.

5 Water line Tubing between the instrument and the glass rinse water bottle.

3 4

1

5

2
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1.6  Instrument Description

1

Rear

No. Item Explanation

1 Syringe cover Syringe pump cover
The syringe pump is located inside the cover. Open to replace the 
syringe or the plunger.

2 AC adapter with fuse box Fuse location

3 Power supply connector Where the power cable is inserted.

4 Screws for transportation fixtures Holds the 3 types of transportation fixtures to the rear of the 
instrument.

5 Transportation fixtures Fasten the autosampler, arm, and pneumatic unit respectively.

6 LAN port Where the cable connecting the instrument and PC is inserted.

6

2

3

4 5 4 5 5 4

1



1  Overview and System Configuration

14   MultiNA Instruction Manual

1.7 Main Window of MultiNA Control Software
This window is displayed when the MultiNA control software starts (hereafter referred to as the MultiNA 
window).

No. Name Reference

1 Menu bar "4.1.1 Menu Bar" P.74

2 Toolbar "4.1.2 Toolbar" P.75

3 Well status display "4.1.3 Well Status Display" P.75

4 Analysis schedule list "4.1.4 Analysis Schedule List" P.76

5 Detect Remaining Reagent Amount button "4.1.5 Detect Remaining Reagent Amount Button" P.76

6 Reagent information "4.1.6 Reagent Information" P.77

7 Status bar "4.1.7 Status Bar" P.77

3

1 2

4567
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1.8  Main Window of MultiNA Viewer

1

1.8 Main Window of MultiNA Viewer
This window is displayed when the data analysis software, MultiNA Viewer, starts (hereafter referred to as 
the Viewer window).

No. Name Reference

1 Menu bar "5.1.1 Menu Bar" P.126

2 Toolbar "5.1.2 Toolbar" P.128

3 Sample name tree "5.1.5 Sample Name Tree" P.129

4 Well display "5.1.4 Well Display" P.129

5 Gel image "5.1.6 Gel Image" P.129

6 Status bar "5.4.3 Status Bar" P.166

7 Electropherogram (Multi) "5.1.10 Electropherogram (Multi)" P.137

8 Electropherogram (Single) "5.1.9 Electropherogram (Single)" P.135

9 Peak table "5.1.7 Peak Table" P.133

1

789 6

4

3

5

2
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2Before Analysis

This chapter explains the microchip used with the MultiNA as well as reagents and mixing marker solution.

2.1 Microchip
Up to four chips may be used with a single MultiNA instrument. The more chips used, the shorter the time 
required for the overall analysis schedule.

For details on the microchips, refer to the instruction manual included with the product.

• A record of the number of runs is managed by the serial number (chip ID) in the software.
• The chip ID is stamped on the surface of the microchip, and is also listed in the instruction manual that 

comes with the microchip (indicated on the right side of S/N.)
• The microchip is composed of a quartz microchip and a plastic protective frame (chip frame).

Shimadzu recommends only using a single type of dye per microchip.

• Continuous usage of different dye types (such as SYBR® Gold, SYBR® Green II, GelStar®) may have an 
adverse effect on analysis results.

• When changing the type of dye used for a microchip, refer to the following procedure to wash the 
microchip.

^ Reference
"11.6 Changing the Type of Dye to Be Used" P.293

If the separation performance of a microchip has deteriorated, perform chip cleaning using the dedicated 
washing fluid.

Part Name Part No. Specification

Microchip Type WE-C
Type WT

S292-36000-91
S292-36010-41

Material: High purity synthetic quartz

Part Name Part No. Specification

Chip cleaning kit -RA S292-35925-91 250 mL, main constituent: ethanol



2  Before Analysis

18   MultiNA Instruction Manual

For information on the chip cleaning method, refer to the following references or the instruction manual 
included with the chip cleaning kit.

^ Reference
"3.5.5 Chip Cleaning Solution Placement" P.50, "6.2.9 Chip Cleaning" P.209

2.2 Reagent Kit
The reagent kit comprises DNA analysis kits (four types) and an RNA analysis kit (one type). The customer 
must provide dyes and ladders in addition to the reagent kit.

^ Reference
"10.3 Reagents and Apparatus Required for Analysis" P.281

Contents of the DNA Kit
The DNA-500/1000/2500/12000 kits are composed of the following items. When the kit is delivered, 
immediately open it, check the part names and quantity, and then store them at the temperatures specified 
for each part.

Part Name Part No. Specification (Size Range)

DNA-500 KIT ASSY S292-27910-91 DNA-500 kit (25 bp to 500 bp*)

DNA-1000 KIT ASSY S292-27911-91 DNA-1000 kit (100 bp to 1,000 bp*)

DNA-2500 ASSY S292-27912-91 DNA-2500 kit (100 bp to 2,500 bp*)

DNA-12000 ASSY S292-36600-91 DNA-12000 kit (100 bp to 12,000 bp*)

RNA KIT ASSY S292-27913-91 RNA kit (28S rRNA: Up to 4.7 knt to 5.0 knt*)

*bp: Size unit of double-strand DNA. "bp" is an abbreviation for "base pair." nt: Size unit of RNA. "nt" is an abbreviation for 
"nucleotide."

No. Part Name Volume Quantity Remarks

1 Separation buffer 30 mL 1 Refrigerated storage at 2°C to 8°C (PP bottle)
(Up to 1000 analyses)

2 Marker solution 1.2 mL 4 Frozen storage at -20°C (Aluminum pack)
(Up to 1000 analyses)

3 Buffer bottle (5 mL) 1 Separation buffer dispensing container (with cap)

4 Vial (0.6 mL) 2 Marker solution dispensing tube (without cap)

5 Manual - 1 -
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2.2  Reagent Kit

2

• Expiration dates are noted on the labels. Use reagent before its expiration date.

• Store separation buffer in refrigeration at 2 to 8°C. Do NOT put separation buffer in frozen storage.

• If undissolved substances, dust, or salt residue on the cap get inside the buffer bottle, salt precipitation 
can collect on the bottom of the bottle.

• Do NOT use reagent kits with salt precipitation inside their containers. Use a new reagent kit.

• When repeating schedules with a small number of analyses, the number of analyses per reagent kit may 
fall below 1000.

• When analyzing restriction enzyme digests, inactivate the enzyme activity according to the 
manufacturer's instruction. If any enzyme activity remains, components in the marker solution will 
degrade and this may prevent normal performance from being achieved.

• Avoid excessive agitation of the marker solution using vortex mixers, etc. Components in the marker 
solution will degrade and this may prevent normal performance from being achieved.

Contents of the RNA Kit
The RNA kit is composed of the following items. When the kit is delivered, immediately open it, check the 
part names and quantity, and then store them at the temperatures specified for each part.

• Expiration dates are noted on the labels. Use reagent before its expiration date.

• Store separation buffer in refrigeration at 2 to 8°C. Do NOT put separation buffer in frozen storage.

• If undissolved substances, dust, or salt residue on the cap get inside the buffer bottle, salt precipitation 
can collect on the bottom of the bottle.

• Do NOT use reagent kits with salt precipitation inside their containers. Use a new reagent kit.

• When repeating schedules with a small number of analyses, the number of analyses per reagent kit may 
fall below 1000.

No. Part Name Volume Quantity Remarks

1 RNA separation buffer 30 mL 1 Refrigerated storage at 2°C to 8°C (PP bottle)
(Up to 1000 analyses)

2 RNA marker solution 1.2 mL 4 Frozen storage at -20°C (Aluminum pack)
(Up to 1000 analyses)

3 Buffer bottle (5 mL) 2 Separation buffer and probe rinsing solution dispensing 
container (with cap)

4 Vial (0.6 mL) 2 Marker solution dispensing tube (without cap)

5 Manual - 1 -
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2.3 Mixing the Marker Solution
This instrument mixes an internal standard substance (marker), required for high-precision sample sizing 
and quantitation, with a ladder or sample and then performs analysis. The marker solutions in the DNA 
analysis kits include two types of markers, a lower marker and an upper marker. The marker solution in the 
RNA analysis kit includes only the lower marker.

The following two methods (marker mixing modes) are used for mixing the marker solution into the ladder 
or sample.

Characteristics of the two modes are shown below.

The sample for preparation, required volume of marker solution, and preparation method differ depending 
on the type of marker mixing mode.

On-chip mixing mode The ladder or sample is automatically mixed with the marker solution in a 
reservoir on the microchip. This method involves placing the ladder or sample 
into a sample tube (or sample plate) and placing the marker solution into a 
dedicated vial and then into the reagent holder.

Premix mode* This method involves manually mixing the sample and marker solution and then 
placing them in the instrument.

* In RNA analysis only the premix mode is used.

Mixing Mode On-Chip Mixing Premix

Mixing method Automatic (mixed inside microchip reservoir 
No.1)

Manual mixing

Minimum required 
sample or ladder 
solution volume

5 μL to 30 μL (sample/ladder solution only) DNA: 2 μL to 10 μL (after mixing in marker 
solution: 6 μL to 30 μL)
RNA: 3 μL to 15 μL (after mixing in marker 
solution: 6 μL to 30 μL)

Addition of marker 
solution to sample or 

ladder

Not required Required

Marker solution 
preparation

The marker solution is added to a dedicated 
vial (0.6 mL tube), and then it is placed in the 
reagent holder.

Placement in the reagent holder is not 
required

Features A sample tube or sample plate for the 
completed PCR reaction can be placed 
directly into the instrument and analyzed.

Can perform analysis with a small volume of 
sample.

Premix mode
• Manually mix the sample 
and marker solution and 
place them in the instrument

On-chip mixing mode
• Place the sample into a 
sample tube and place the 
marker solution into a dedicated 
vial and then into the reagent 
holder

Separation buffer



MultiNA Instruction Manual   21

3

3
3
3
3
3
3
3
3
3
3
3
3
3
3
3

3

3Basic Operation of 
Analysis

This chapter explains the how to start up and shutdown the instrument as well as the basic operations 
required to perform normal analysis.

3.1 Flow of Basic Operations

Start up the instrument and software

Register the analysis schedule

Prepare for DNA or RNA analysis

Start the analysis

Perform data processing/Print analysis results

Shutdown

Prepare for analysis

^Reference "3.2.1 Startup" P.22

^Reference "3.3 Pre-Analysis Preparation" P.27

^Reference "3.4 Analysis Schedule Registration" P.34

^Reference "3.5 Preparation for DNA Analysis" P.44
"3.6 Preparation for RNA Analysis" P.52

^Reference "3.7 Analysis" P.57

^Reference "3.8 Data Analysis" P.62

^Reference "3.2.2 Shutdown" P.24

"3.9 Printing Data" P.71
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3.2 Startup and Shutdown

3.2.1 Startup

1 Turn ON the power switch located on the right side of the MultiNA instrument.

The instrument is initialized. The green LED indicator blinks during initialization.
Once initialization is complete, the green LED stops blinking and becomes constantly lit and a buzzer 
sounds.

2 Turn ON the PC.

3 Enter your user ID and password to logon to Windows.

Use the same user ID as when the MultiNA software was installed.
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3.2  Startup and Shutdown

3

4 Double click  (MultiNA Control Software) on the desktop.
The MultiNA Control Software starts up.

• The instrument name will be shown at the left end of the toolbar in light blue if the MultiNA 
instrument and PC are connected. It will be shown in light orange if they are disconnected.

• In the default setting, the PC automatically connects with the instrument at startup.

^ Reference
"4.1.2 Toolbar" P.75

If the following window is displayed when starting the MultiNA Control Software program, click 
[Unblock]. The window will not be displayed from the next startup.
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When the Instrument and PC Cannot Connect
In the event that the MultiNA Control Software is started before power to the MultiNA instrument is turned 
ON or settings are configured to prevent connection on startup, a message is displayed indicating that a 
connection could not be established.

5 Click [OK].

6 Select [Connect] from the [Instrument] menu on the menu bar.

The software connects with the instrument and the instrument name on the toolbar changes to light blue.

3.2.2 Shutdown

1 Click  (Close) at the top right corner of the MultiNA window.

The MultiNA Control Software program closes.

The software cannot be shutdown when analysis or rinsing is in progress.

2  Click  (Close) at the top right corner of the Viewer window.

The MultiNA Viewer program closes.
This procedure is not required if the MultiNA Viewer program was not started.
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3.2  Startup and Shutdown

3

3 Turn OFF the power switch located on the right side of the MultiNA instrument.

4 Turn OFF the PC.

Shutting Down the Instrument Only
Use the procedure below to only shut down the instrument for maintenance or other reasons.

1  Select [Connect] from the [Instrument] menu in the MultiNA window.

A message is displayed to confirm whether to close the connection with the instrument.

2 Click [Yes].
The instrument name on the toolbar changes to light orange (disconnected).

3 Turn OFF the power switch on the MultiNA instrument.
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3.2.3 Precautions Regarding Windows

Precaution for Stable PC Operation
Depending on the PC operating environment, memory leaks or memory fragmentation may occur if the 
system is run continuously for long periods of time, resulting in unstable PC operation. To avoid this kind of 
unexpected Windows-derived problem, either turn OFF the PC or restart the PC at regular intervals (about 
once a week).

Precautions Regarding the Windows Low Power Mode
Windows 7

Never use the sleep function during analysis. Communications with the instrument will be cut and analysis 
will not be able to proceed. In particular, do not select [Sleep] or [Hibernate] that are displayed in the Start 
menu.

Windows XP

If you attempt to activate sleep mode during analysis, the message "Cannot put computer on standby or 
into hibernation." is displayed and the computer does not enter the sleep state.

3.2.4 Precautions Regarding the MultiNA Software

Precautions Regarding Software Versions
This instruction manual describes the functions incorporated into the latest version of the MultiNA software. 
Some of these functions cannot be used in previous versions of the software. Refer to the release notes for 
the software change log (select [All Programs] - [MultiNA] - [Release Notes] in the Windows start menu).

Always use the latest version of the MultiNA software. Opening data files with a previous version of the 
MultiNA software may cause problems. Be particularly vigilant when using multiple instances of the 
MultiNA software.

^ Reference
"4.7.3 About MultiNA" P.124, "5.8.2 About MultiNA Viewer" P.195

Precautions Regarding Reagent Information
The "Required" amounts displayed in the [Reagent Information] window of the MultiNA Control Software 
are the minimum amounts of reagents required to analyze registered samples. When preparing the 
separation buffer, follow the "Guidelines for Required Volumes of Separation Buffer and Diluted Dye 
Solution," which is found in "3.5.1 Diluted Dye Solution and Separation Buffer Preparation" P.44 or "3.6.1 
Diluted Dye Solution and Separation Buffer Preparation" P.52 of the instruction manual.

Precautions Regarding Remaining Time
The remaining time displayed in the status bar of the MultiNA Control Software is the estimated remaining 
time when predetermined conditions are met. The actual operating time may significantly differ from the 
remaining time when the analysis schedule deviates from predetermined conditions such as the following.

• After an error occurs during the analysis schedule.
• After you stop the analysis schedule.
• You run all chip washing or all chip cleaning when three or less microchips are placed in the instrument. (It is 

assumed for the remaining time that four microchips are placed in the instrument.)
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3.3  Pre-Analysis Preparation

3

3.3 Pre-Analysis Preparation
This section describes how to replenish the rinse water, set the waste container, and prepare the 
microchip.

3.3.1 Replenishing the Rinse Water
Replenish the rinse water.

1 Remove the cap from the glass rinse water bottle.

2 Replenish the glass bottle with Milli-Q ultrapure water.

Fill the 2000 mL glass rinse water bottle with rinse water until the bottle is full. The amount of rinse 
water consumption varies depending on the project used, number of rinses, number of times chip 
cleaning is performed, and instrument state. The amount of rinse water may exceed 2000 mL 
depending on conditions so refill the rinse water bottle during analysis as necessary.

After obtaining water, storing the water for long periods can cause the suction filter to clog. Discard 
any water that has not been used for 3 days or more and replenish with fresh water.

3 Reattach the cap and immerse the tip of the suction filter all the way to the bottom of the 
bottle.

! WARNING

• Uncap the rinse water bottle and fill the bottle away from the instrument.
Spilled water on the MultiNA instrument risks electrical leak or electrical shock.

! CAUTION

• Only use Milli-Q ultrapure water for the rinse water.
Use of other types of water could result in defective rinsing or equipment malfunction.

• Before starting analysis, verify that the volume of rinse water in the glass rinse water bottle is 
sufficient.
Insufficient rinse water during analysis could result in deteriorated data, clog the microchip so that it 
becomes unusable, or cause other problems.

Suction filter

Cap
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3.3.2 Checking the Waste Container
Check that the waste container is not full and the liquid waste tube is not bent.
If the waste container is full, discard its contents.

1 If waste fluid has accumulated in the container, remove the drain hook attached to the 
waste container.

2 Dispose of the waste fluid accumulated in the waste container.

3 Attach the drain hook to the waste container.
The waste container is now ready for use. 

! WARNING

• Always wear protective equipment (protective clothing, gloves, eyewear, and mask) when 
disposing of waste fluid.
Waste fluid may contain irritating and harmful chemical substances. If any type of waste fluid makes 
contact with the eyes or skin, immediately rinse the affected area with large amounts of water and 
seek medical attention from a doctor and follow their advice.
If waste fluid is ingested or inhaled by accident, immediately seek medical attention from a doctor and 
follow their advice.

! CAUTION

• Treat the waste fluid appropriately in accordance with prescriptions or guidelines from the 
applicable management department.
In addition to rinse water, waste fluid includes the separation buffer, marker solution, and dye. It will 
also contain formamide from RNA analysis.

• Discard waste fluid on a regular basis to prevent the waste container from overflowing.
If the waste tubing becomes clogged, waste fluid may leak from inside the instrument.

• Check the state of the waste container and tube before starting analysis.
There is a risk that waste fluid may overflow within the instrument.

• The tip of the liquid waste tube is not immersed in waste fluid in the waste container.
• There is enough empty space in the waste container.
• The waste tubing is not bent or elevated.

Drain hook
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3.3  Pre-Analysis Preparation

3

3.3.3 Drive Positions

1 Open the instrument top cover.

2 Ensure that the drive positions (autosampler and pneumatic unit) are at the back of the 
instrument (home position) as shown in the figure below.

If the drives are not positioned at their home position, refer to the procedure described in "6.1.1 
Moving All Axes to Home Position" P.198 to return the drives to their home position (note that the 
drives do not move to the home position during initialization after power is turned ON).

Pneumatic unit

Autosampler
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3.3.4 Microchip Registration
Register microchips and select the microchips to be used in analysis.

1 Select [Chip Management] from the [Instrument] menu in the MultiNA window.

The [Chip Management] window is displayed.

2 Click the  (Change) button corresponding to the position of the chip to be installed 
(chips 1 to 4).

The [Chip # Change] window is displayed.

^ Reference
For details, see "4.5.3 Chip Management" P.110.

The chip positions are arranged in 1, 2, 3 order from the back, with the front-most position being No. 
4.

4 3 2 1
Front
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3.3  Pre-Analysis Preparation

3

3 Enter the chip ID (e.g.: ND060-1) into the chip ID column.

4 Click  (Change).
The microchip is registered and a check mark appears next to the chip to be used.

5 Repeat steps 2 to 4 for all of the microchips that will be used.

6 Verify that all of the microchips to be used in analysis have been selected.

Microchips without check marks will not be used in analysis even if they are installed in the 
instrument.
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3.3.5 Microchip Installation

1 Remove the chip cover.

1 Loosen the knurled screws (2 locations) on the chip cover.
2 Remove the chip cover and set it upright.

2 Install the microchips into the chip stage.

! CAUTION

• Do NOT touch the electrode pins in the back of the chip cover.
Deformed electrode pins may cause defective contact with electrodes on the microchip surface 
and result in improper voltage application.

1 2

! CAUTION

• Do NOT press too firmly on the quartz section at center of the microchip.
Doing so could damage the chip.

• Do NOT touch the quartz section at center of the microchip directly with your finger.
Contamination may cause a decrease in sensitivity.

Microchip
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3.3  Pre-Analysis Preparation

3

• If the microchip surface shows any trace of leakage, it cannot be used. In this case, contact your 
Shimadzu service representative.

• Do NOT rub too hard around the reservoir. Doing so could cause lint to fall in the reservoir and 
clog the flow channels.

3 Press lightly near the center of the microchip, with microchip cleaning wipes (P.285), to 
confirm that the microchip is not raised off the stage.

4 Close the chip cover and tighten the screws.

This fastens the chip cover in place.

• Align the chip cover with the guide pins and close the cover. Use both hands to hold the chip 
cover in place and tighten the knurled screws.

Screws
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3.4 Analysis Schedule Registration
Configure project settings, create a sample sheet, and register the analysis schedule.

Configure a project (P.35)

Create a sample sheet (P.38)

Select the configured project. Using the 
on-screen well display, enter all the 
ladder and sample information, such as 
where ladders and samples are set.

Configure information including the 
marker solution mixing method (on-chip 
or premix), default data file name, and 
graph scale.

Register an analysis schedule (P.42)

A data file is created (P.62)

Perform analysis (P.57)

Prepare for DNA analysis (P.44) or RNA analysis (P.52)

Register the created sample sheet into 
an analysis schedule.

The data file (raw data/analyzed data) 
registered in the analysis schedule is 
created. Inspect the electropherograms 
of all of the ladders and samples 
included in the data file. Reanalyze the 
data, if necessary.
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3.4  Analysis Schedule Registration
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3.4.1 Project Settings
A project* must be configured before registering samples into an analysis schedule.
*A project is used to configure and store information required for analysis, including the reagent kit, marker 
solution mixing method (on-chip or premix), default data file name, and graph scale.

^ Reference
If using a project that is already configured, proceed to "3.4.2 Sample Sheet Creation" P.38.

1 Select [Project Settings] on the [Edit] menu.

The [Project List] window is displayed.

2 Click [New].

The [Project Settings] window is displayed.
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3 Fill in the fields on the [General] tab.

^ Reference
For details on field settings, see "  New" P.94

4 Click the [Sample] tab and configure the conditions.

4

1

2

4

3
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3.4  Analysis Schedule Registration

3

1 Select the type of sample (separation buffer).
2 Select the marker mixing mode (on-chip or premix).
3 When performing DNA analysis, select the type of dye to use.
4 Configure any other conditions.

^ Reference
For details on the dyes to use, see "3.5.1 Diluted Dye Solution and Separation Buffer Preparation" 
P.44.

• Ladder analysis is essential for size estimation, quantitation, and other data analysis. (For details, 
see "1.5.2 Analysis and Data Processing" P.7)

• Select the check mark for [Auto ladder entry] and configure the well position for the ladder (X1 to 
X12).

• The ladder is analyzed once at the start of the sample sheet for all microchips used in the 
analysis.

• The performance specifications for this instrument ("1.4 Specifications" P.3) are based on using a 
standard ladder. Performance may differ from the specifications if an optional ladder or user 
ladder is selected.

5 Configure settings on the other tabs, if necessary.

6 Click [OK] in the [Project Settings] window.

The settings are saved and the [Project Settings] window closes.

7 In the [Project List] window, click [Close].
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3.4.2 Sample Sheet Creation
Create a sample sheet once the project is configured.

The following rules apply when creating a sample sheet.

This section explains the method for specifying the ladder and sample positions using the on-screen well 
display when creating a sample sheet.

Use one of the following methods to enter information into the sample sheet.

• Enter the position name of wells directly (P.81)
• Only enter the number of analysis samples (P.80)
• Import information from Excel or a CSV file (P.86)
• Load information from the default sample sheet (P.85)

1 Click  (New Entry) on the toolbar in the MultiNA window.

The [Sample Entry - New] window is displayed.

2 Select the project to use and click [OK].

The [Sample Entry] window is displayed.

Rules for Creating a Sample Sheet

• Information in the selected project is reflected in the sample sheet.
• The well name for the set sample/ladder, sample name, comments, and type (ladder or sample) can be entered.
• A sample or ladder set in the sample stand (well position from A1 to H12) is analyzed only once. If it is set in the 

extra sample stand (well position from X1 to X12), analysis can be performed multiple times (assuming it is 
registered multiple times in the sample sheet).

• The maximum number of analyses that can be entered for both ladders and samples combined is 120.
• Ensure that the ladder is analyzed first for each of the microchips that are used.

While analysis can be performed in sample sheets that do not include a ladder, analyzing a ladder first 
is recommended for obtaining analysis data with the highest precision.
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The file name shown below the [Data file name] field is the name of the data file that will be created. 
Clicking [Enter] confirms the file name.

3 In the well status display, click each well or drag with the mouse to enclose multiple 
wells.

This selects the specified wells, changes their color in the sample stand and extra sample stand to green, 
and specifies the position where the ladders and samples are set.

• Each well on the sample stand can only be analyzed once, whereas each well on the extra 
sample stand can be analyzed multiple times. Choose the appropriate well positions according to 
the sample and number of analyses.

• When performing analysis multiple times on wells in the extra sample stand, use one of the 
following methods to create multiple lines in the sample sheet.

• In the well display, re-select the wells in X1 to X12, and click the  button.

• Right-click the X1 to X12 lines that you want to copy, go to the menu to select [Copy], right-
click the line in the vacant column, and select [Paste].

• Enter X1 to X12 lines directly into the sample sheet.

Drag with the 
mouse to 
enclose wells

Extra sample stand

Sample stand
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^ Reference
"4.2.1 New" P.79

4 Click .
The [Well Name] and [Type] are automatically entered in the column on the right side. The [Type] is 
always [Sample].

5 Enter the sample name and comment, and change the type.

• Clicking the [Type] cell displays a drop-down list. The type can be changed to [Ladder].

• The ladder for analysis can be selected from the standard ladder (STD), an optional ladder, or a 
user ladder.

^ Reference
"11.7 Using Optional Ladders" P.294, "11.8 User Ladders" P.295
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6 Repeat steps 4 to 5 as often as necessary to enter information for all of the ladders and 
samples to be analyzed.

• If necessary, click [Save] to save the information as a sample sheet.

• Selecting [Save as default sample sheet] and then clicking [Save] will save it as the default 
sample sheet.
If [Load default sample sheet while starting up] was selected in the project settings, this default 
sample sheet will automatically be displayed when a new [Sample Entry] window is opened.

^ Reference
"4.2.1 New" P.79

Creating a Schedule for RNA Analysis
Observe the following rules when creating a schedule for RNA analysis.

• To ensure stable analysis, enter a blank analysis as the first analysis for each microchip. Select [Ladder] 
as the [Type] for the blank analysis.

• Refer to the table below for the number of samples that can be entered for a single analysis.
Note that the denatured state of RNA samples cannot be maintained over a long period of time because 
the instrument is not equipped with a sample refrigeration function.

Number of Microchips Used 1 2 3 4

Blank Analysis 1 2 3 4

Ladder Analysis 1 2 3 4

Sample Number 1 - 6 2 - 12 3 - 16 4 - 14

Total Number of Analyses 8 max. 16 max. 22 max. 22 max.
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3.4.3 Analysis Schedule Registration
Register the analysis schedule into the created sample sheet.

The following rules apply when registering an analysis schedule.

1 Click [Enter].

The created sample sheet is registered to the analysis schedule in the MultiNA window.
The separation buffer and marker solution volumes required for analysis are displayed in [Reagent 
Information].

^ Reference
"4.1.6 Reagent Information" P.77

Separation buffer and marker solution placement is described in sections 3.5 to 3.6.

Rules for Registering an Analysis Schedule

• The maximum number of analyses that can be registered into a schedule is 120.
• Analyses are performed in the order shown in the analysis schedule.
• All available microchips are used to execute the analysis schedule.

Reagent 
Information
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If ladder analysis is not included in the sample sheet, the following message is displayed.

• Select [Yes] to enter the sample sheet without a ladder analysis into the analysis schedule. You 
cannot automatically obtain size estimation and quantitation results in the analysis data. However, 
you can import a ladder file created for other analysis data to perform a reanalysis and obtain the 
size estimation and quantitation.

^ Reference
"5.7.3 Change Ladder and Analyze" P.189

• Selecting [No] stops registration in the analysis schedule, and returns focus to the [Sample Entry] 
window.

If a sample sheet is created during analysis, although it can be saved using [Save], it cannot entered 
into the analysis schedule using [Enter]. [Enter] is not displayed in the [Sample Entry] window.

2 If necessary, click [Add] on the [Sample Entry] menu to add the sample sheet.
The [Sample Entry] window for adding entries is displayed.
For details, see "4.2.2 Add" P.92.

3 Perform "Preparation for DNA Analysis" P.44 (or "Preparation for RNA Analysis" P.52).
To perform chip cleaning upon completion of the analysis schedule, see "  [Analysis Schedule] Tab" 
P.109 in "4.5.2 Options".
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3.5 Preparation for DNA Analysis
This section explains how to prepare the separation buffer solution, ladder solution, sample, and marker 
solution for DNA analysis.

^ Reference
For details on reagents and apparatus required for analysis, see "  DNA Analysis" P.281
For RNA analysis preparation, see "3.6 Preparation for RNA Analysis" P.52

• Leave reagent at room temperature for a minimum of 30 minutes before use.

• Do NOT mix and use reagents of different lot numbers.
The lot number is displayed on the buffer bottle or aluminum pack of the marker solution.

• Use a micropipette that can dispense fluid accurately.
Inaccurate dispensing and mixing ratios will cause incorrect analysis results.

3.5.1 Diluted Dye Solution and Separation Buffer Preparation
Mix the separation buffer and the diluted dye solution.

Reagent and Apparatus Used

! WARNING

• Always wear protective equipment (protective clothing, gloves, eyewear, and mask) when 
handling reagents.
Reagents contain irritating and harmful chemical substances. If any type of reagent makes contact 
with the eyes or skin, immediately rinse the affected area with large amounts of water and seek 
medical attention from a doctor and follow their advice.
If a reagent is ingested or inhaled by accident, immediately seek medical attention from a doctor and 
follow their advice.

• Always read the MSDS before handling reagents.
The MSDS contains important safety information regarding the handling, storage, and disposal of 
reagents.

! CAUTION

• Use the recommended reagents and apparatus correctly.
Failure to do so may result in instrument damage or the inability to obtain the prescribed analysis 
performance.

Reagent and Apparatus to Prepare

• Dye (GelStar® or SYBR® Gold)
• TE buffer
• Micropipette
• Vortex mixer
• Separation buffer (P.18)

• Microtube
(200 μL to 1.5 mL capacity)

• Buffer bottle
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• Divide the dye into microtubes in small aliquots (about 10 μL) and keep them shielded from light in frozen 
storage.
The dye deteriorates when repeatedly frozen and thawed or when exposed to light.

• Use diluted dye solution within 3 days if kept refrigerated or within 3 months if kept frozen (−20 °C).

• Leave separation buffers at room temperature for a minimum of 30 minutes before preparing or setting 
them in place.

• If air bubbles form in the separation buffer due to agitation, remove them using a centrifuge or leave the 
separation buffer to stand until the bubbles disappear.

Procedure

1 Dilute the dye solution with TE buffer at a ratio of 1:99 (dilution factor of 100).

2 Cap the microtube and agitate the solution with the vortex mixer for at least 10 seconds.

3 Dispense the separation buffer and diluted dye solution included in the reagent kit into 
the buffer bottle at the corresponding volume ratio indicated in the table below.
Ensure that the volume of the mixed separation buffer solution exceeds the required volume displayed in 
the [Reagent Information] window.

^ Reference
"4.1.6 Reagent Information" P.77

• When using GelStar®

Mix the separation buffer and diluted dye solution at a ratio of 199:1.

Use your finger to warm the 
small aliquots of dye (stored 
frozen), then dilute by 100 
times using 1xTE.

Dye
(Stored Frozen) Leave at room 

temperature for a 
minimum of 30 minutes 
before placing in the 
reagent holder.

Separation Buffer

Diluted Dye Solution

Add the diluted dye solution so 
that the predetermined ratio is 
achieved with respect to the 
volume of separation buffer.

Cap the buffer bottle and agitate the solution 
with inversion mixing (at least 10 times) or a 
vortex mixer for at least 10 seconds.

Separation Buffer Solution Preparation

Guidelines for Required Volumes of Separation Buffer and Diluted Dye Solution (GelStar®)

Total Number of 
Analyses

8 Analyses or 
Less 9 to 29 Analyses 30 to 79 Analyses 80 to 120 

Analyses
Volume of Separation 

Buffer
497.5 μL 995 μL 1990 μL 2985 μL

Volume of Diluted 
Dye Solution

2.5 μL 5 μL 10 μL 15 μL
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• When using SYBR® Gold
Mix the separation buffer and diluted dye solution at a ratio of 99:1.

4 Cap the buffer bottle and agitate the solution with inversion mixing (at least 10 times) or 
a vortex mixer for at least 10 seconds.

5 Uncap the buffer bottle and place it in the reagent holder at the buffer bottle position 
(the position corresponding to the color displayed in the [Reagent Information] 
window).

Let the solution adhering to the inner surface of the buffer bottle settle, and use a micropipette to 
remove any residual bubbles before placing the tube in the reagent holder.

Move the bottle around to verify that the bottom of the buffer bottle is in the correct position at the 
bottom of the reagent holder.

Volume of Prepared 
Separation Buffer 

Solution

500 μL 1000 μL 2000 μL 3000 μL

Guidelines for Required Volumes of Separation Buffer and Diluted Dye Solution (SYBR® Gold)

Total Number of 
Analyses

8 Analyses or 
Less 9 to 29 Analyses 30 to 79 Analyses 80 to 120 

Analyses
Volume of Separation 

Buffer
495 μL 990 μL 1980 μL 2970 μL

Volume of Diluted 
Dye Solution

5 μL 10 μL 20 μL 30 μL

Volume of Prepared 
Separation Buffer 

Solution

500 μL 1000 μL 2000 μL 3000 μL

Guidelines for Required Volumes of Separation Buffer and Diluted Dye Solution (GelStar®)

Total Number of 
Analyses

8 Analyses or 
Less 9 to 29 Analyses 30 to 79 Analyses 80 to 120 

Analyses

! CAUTION

• Uncap the buffer bottle before placing it in the reagent holder.
The sample probe may be damaged.

DNA-500
DNA-1000

DNA-2500
DNA-12000
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3.5.2 Ladder, Sample, and Marker Preparation
Prepare the ladder solution used for size calibration curve creation.

For premix analysis, mix the sample/ladder solution with the marker solution.

If using an optional ladder, prepare the ladder solution by referring to "11.7 Using Optional Ladders" P.294.

Reagent and Apparatus Used

When the sample for measurement is expected to exceed the concentration range (0.5 ng/μL to 50 ng/μL) or 
the maximum salt concentration (KCI or NaCl concentration; maximum of 125 mM) for DNA samples, use 
the TE buffer (pH 8.0) to dilute it within specification prior to analysis.

Ladder

DNA-500 25 bp DNA ladder
pUC19Hpa II Digest*

DNA-1000 φX174 DNA/HaeIII Markers
100 bp DNA Ladder*

DNA-2500 pGEM® DNA Markers

DNA-12000 2-Log DNA Ladder (0.1-10.0 kb)

*Option ladder

Reagent and Apparatus to Prepare

• TE buffer
• Micropipette
• Vortex mixer
• Marker solution (P.18)
• Sample

• Microtube
(200 μL to 1.5 mL capacity)

• Container for MultiNA analysis

• Vial* • Aluminum seal

*Used in on-chip mixing mode

Sample tubes or sample plate
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Procedure

1 Use a micropipette to dispense TE buffer and DNA ladder into a microtube.

2 Agitate the solution with the vortex mixer for at least 10 seconds.

3 Transfer the ladder solution created in step 2 to the container for MultiNA analysis.

4 Dispense the sample solution into the container for MultiNA analysis.

The amount required for analysis differs for on-chip mixing and premix. Refer to the following table 
for the correct amount.

• For on-chip mix

• For premix

Dispensing Amount

Reagent Kit TE buffer Ladder

DNA-500 49 μL 25 bp DNA ladder 1 μL

49 μL pUC19Hpa II Digest* 1 μL

DNA-1000 99 μL φX174 DNA/HaeIII Markers 1 μL

45 μL 100 bp DNA Ladder* 5 μL

DNA-2500 99 μL pGEM® DNA Markers 1 μL

DNA-12000 99 μL 2-Log DNA Ladder (0.1-10.0 kb) 1 μL
*Option ladder

Item Sample Stand
(One Analysis per Well)

Extra Sample Stand
(Multiple Analyses per Well)

Total Number of 
Analyses

~12 13~ - -

Number of Analyses - - ~3 3 - 13

Container Sample tube Sample plate with 
seal

Sample tube

Volume of Ladder or 
Sample

9 μL 5 μL 9 μL 5 + 2 × (Number of 
analyses - 1) μL

Item Sample Stand
(One Analysis per Well)

Extra Sample Stand
(Multiple Analyses per Well)

Total Number of 
Analyses

~12 13~ - -

Number of Analyses - - ~4 5 - 9

Container Sample tube Sample plate with 
seal

Sample tube

Volume of Ladder or 
Sample

3 μL 2 μL 5 μL 1 × (Number of 
analyses + 1) μL

Volume of Marker 
Solution

6 μL 4 μL 10 μL 2 × (Number of 
analyses + 1) μL

Volume of Prepared 
Solution

9 μL 6 μL 15 μL 3 × (Number of 
analyses + 1) μL
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• For premix, add twice the amount of marker solution and mix.

• The amount dispensed to the sample tube should not exceed 30 μL otherwise it may interfere 
with the analysis sequence.

• For the 13th and subsequent analyses in the analysis schedule, attach an aluminum seal onto the 
sample plate in order to prevent evaporation.

• Avoid excessive agitation of the marker solution using vortex mixers, etc. The upper marker will 
degrade and this may prevent normal performance from being achieved.

5 For on-chip mixing, dispense the marker solution.
Use a micropipette to dispense marker solution in excess of the required volume shown in [Reagent 
Information] into a vial (PP 0.6 mL vial, no cap).

• Dispense an amount in excess of the volume displayed in [Reagent information].

• For premix, dispensing of marker solution is not required.

• Avoid excessive agitation of the marker solution using vortex mixers, etc. The upper marker will 
degrade and this may prevent normal performance from being achieved.

3.5.3 Ladder, Sample, and Marker Placement

1 Place the sample and ladder solution in the sample stand or extra sample stand at the 
position specified in the analysis schedule.

2 For on-chip mixing, place the marker solution vial in the reagent holder at the marker 
container position (the position corresponding to the color displayed in the [Reagent 
Information] window).

DNA-500
DNA-1000

DNA-2500
DNA-12000
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3.5.4 Sample Holder Installation
Install the sample holder over the sample tubes or sample plate and fasten it in place.

1 Install the sample holder.

1 Examine the orientation of the sample holder.
2 Insert the front side of the sample holder between the extra sample stand and the metal rod (behind 

the metal rod).
3 Insert the back side of the sample holder in front of the metal rod between the sample stand and 

reagent holder. At this point, align the holes with those of the sample stand and extra sample stand.
4 Apply downward pressure on the four corners of the sample holder, and verify that it is securely 

installed (not loose) over the sample stand and extra sample stand.

3.5.5 Chip Cleaning Solution Placement
Place the chip cleaning solution into the reagent holder when automatically performing chip cleaning upon 
the completion of analysis.

^ Reference
For details on how to configure the chip cleaning function, see "  [Analysis Schedule] Tab" P.109 in "4.5.2 
Options".

! CAUTION

• Use the sample holder correctly.
Starting the instrument when the sample holder is improperly installed (elevated) may cause 
instrument damage.
An error will occur if analysis is started when the sample holder is not correctly installed.

• Be careful not to bump the sample tubes or plates when installing the sample holder.
Sample spatter caused by an impact may prevent samples from being suctioned properly.
If sample spatter occurs, use a centrifuge to force the liquid down to the bottom of the tube.

Front

2 3
Back

Metal 
rod

4

! WARNING

• Always read the instruction manual provided with the chip cleaning kit before handling the 
contents of the kit.
The instruction manual for the chip cleaning kit describes safety precautions that are important to 
ensure safe use.



 MultiNA Instruction Manual   51

3.5  Preparation for DNA Analysis

3

Reagent and Apparatus Used

1 Dispense chip cleaning solution into the buffer bottle.

The volume of chip cleaning solution required varies depending on conditions including the number 
of microchips in use and number of times to perform cleaning. Also, the time required for analysis will 
increase according to the number of times chip cleaning is performed. Refer to the table below for 
the required volume of chip cleaning solution and the increase in time required for analysis.

• Required volume of chip cleaning solution and the increase in time required for analysis

2 Securely tighten the open-hole screw cap onto the buffer bottle.

3 Insert the buffer bottle at the chip cleaning solution position (indicated in the figure 
below) in the reagent holder.

Move the bottle around to verify that the bottom of the buffer bottle is in the correct position at the 
bottom of the reagent holder.

Reagent and Apparatus to Prepare
• Chip cleaning solution
• Micropipette

• Buffer bottle • Open-hole screw cap

Number of 
Cleanings Using 1 Microchip Using 

2 Microchips
Using 

3 Microchips
Using 

4 Microchips
1 time 1.2 mL / 20 min 1.4 mL / 25 min 1.6 mL / 32 min 1.8 mL / 40 min

2 times 1.4 mL / 35 min 1.8 mL / 45 min 2.2 mL / 57 min 2.6 mL / 70 min
3 times 1.6 mL / 50 min 2.2 mL / 65 min 2.8 mL / 82 min 3.4 mL / 100 min
4 times 1.8 mL / 65 min 2.6 mL / 85 min 3.4 mL / 107 min 4.2 mL / 130 min
5 times 2.0 mL / 80 min 3.0 mL / 105 min 4.0 mL / 132 min 5.0 mL / 160 min

Chip cleaning solution position

Reagent Holder

Rinse port
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3.6 Preparation for RNA Analysis
^ Reference

For details on reagents and apparatus required for analysis, see "  RNA Analysis" P.283

• Leave reagent at room temperature for a minimum of 30 minutes before use.

• Do NOT mix and use reagents of different lot numbers.
The lot number is displayed on the buffer bottle or aluminum pack of the marker solution.

• Use a micropipette that can dispense fluid accurately.
Inaccurate dispensing and mixing ratios will cause incorrect analysis results. 

3.6.1 Diluted Dye Solution and Separation Buffer Preparation
Mix the separation buffer and the diluted dye solution.

Store formamide below -20 °C.
Dispense about 1 mL of formamide into microtubes prior to frozen storage to prevent decomposition due to 
repeated freezing and thawing.

Reagent and Apparatus Used

! WARNING

• Always wear protective equipment (protective clothing, gloves, eyewear, and mask) when 
handling reagents.
Reagents contain irritating and harmful chemical substances. If any type of reagent makes contact 
with the eyes or skin, immediately rinse the affected area with large amounts of water and seek 
medical attention from a doctor and follow their advice.
If a reagent is ingested or inhaled by accident, immediately seek medical attention from a doctor and 
follow their advice.

• Always read the MSDS before handling reagents.
The MSDS contains important safety information regarding the handling, storage, and disposal of 
reagents.

! CAUTION

• Use the recommended reagents and apparatus correctly. 
Failure to do so may result in instrument damage or the inability to obtain the prescribed analysis 
performance.

Reagent and Apparatus to Prepare

• SYBR®Green II
• TE buffer
• Micropipette
• Vortex mixer
• RNA separation buffer (P.19)
• Formamide

• Microtube
(200 μL to 1.5 mL capacity)

• Buffer bottle
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• Divide the SYBR® Green II into microtubes in small aliquots (about 10 μL) and keep them shielded from 
light in frozen storage.

SYBR® Green II deteriorates when repeatedly frozen and thawed or when exposed to light.

• The separation buffer mixed with diluted dye solution should be used on the day it is prepared.

Procedure

1 Dilute the dye solution with TE buffer at a ratio of 1:99 (dilution factor of 100).

2 Cap the microtube and agitate the solution with the vortex mixer for at least 10 seconds.

3 Dispense the separation buffer included in the RNA kit, diluted dye solution, and 
formamide into the buffer bottle.
Ensure that the volume of the mixed separation buffer solution exceeds the required volume displayed in 
the [Reagent Information] window.

1 Refer to the table above, and dispense the separation buffer into the buffer bottle in the required 
volumes based on the total number of analyses (ladder, sample, and blanks).

2 Add the diluted dye solution until it reaches a volume ratio of 1/80 to the separation buffer.
3 Add formamide until it reaches a volume ratio of 4:1 with the mixture of separation buffer and diluted 

dye solution.

When formamide is added, the volume of the mixed solution decreases by about 10 %.

4 Cap the bottle and agitate the solution with the vortex mixer for at least 10 seconds.

5 Uncap and place the bottle in the peach reagent holder position (color code for RNA kit).

Let the solution adhering to the inner surface of the buffer bottle settle, and use a micropipette to 
remove any residual bubbles before placing the tube in the reagent holder.

Guidelines for Required Volumes of Separation Buffer and Diluted Dye Solution

Number of Analyses (Total 
Ladders, Samples, and Blank 

Analyses)
~6 7 - 15 16 - 22

Volume of Separation Buffer 395 μL 632 μL 790 μL

Volume of Diluted Dye Solution 5 μL 8 μL 10 μL

Volume of Formamide 100 μL 160 μL 200 μL
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Move the bottle around to verify that the bottom of the buffer bottle is in the correct position at the 
bottom of the reagent holder.

3.6.2 Ladder, Sample, and Marker Preparation
• Prepare the ladder solution used for size calibration curve creation.
• Mix the blank, ladder solution, and sample with an equal volume of marker solution.
• Attach the cap to the sample tube and the aluminum seal to the sample plate and perform thermal 

denaturation.

Requirements

When the prepared sample is expected to exceed the concentration range (Total RNA of 25 ng/μL to 500 ng/
μL, mRNA of 25 ng/μL to 250 ng/μL) or the maximum salt concentration (Tris concentration 10 mM and 
EDTA concentration 1 mM or less) for RNA samples, use THE RNA Storage Solution to dilute it prior to 
analysis.

! CAUTION

• Uncap the buffer bottle before placing it in the reagent holder.
The sample probe may be damaged.

RNA

Reagent and Apparatus to Prepare

• RNA 6000 ladder
• THE RNA Storage Solution
• Micropipette
• Vortex mixer
• Marker solution (P.19)
• Sample

• Microtube
(200 μL to 1.5 mL capacity)

• Container for MultiNA analysis

• Aluminum seal • Cap

Sample tubes or sample plate
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Procedure

1 Dispense 5 μL of THE RNA Storage Solution and 1 μL of RNA 6000 ladder to a 
microtube.

2 Use a micropipette to agitate the solution by sucking and expelling it 5 times.

3 Dispense the ladder solution, mixed in steps 1 to 2, and an equal volume of marker 
solution into a sample tube (or sample plate) and mix the solution thoroughly by 
pipetting.

The amount dispensed to the sample tube should not exceed 30 μL otherwise it may interfere with 
the analysis sequence.

4 Dispense THE RNA Storage Solution for blank analysis and an equal volume of marker 
solution into the sample plate (or sample tube) and mix the solution thoroughly by 
pipetting.

5 Dispense the sample and an equal volume of marker solution into the sample plate (or 
sample tube) and mix the solution thoroughly by pipetting.

6 Attach the cap to the sample tube and the aluminum seal to the sample plate and use 
the oil-free thermal cycler to perform thermal denaturation.

65 °C for 5 minutes

↓

 4 °C for 5 minutes

After performing thermal denaturation at 65 °C for 5 minutes, allow for cooling inside the thermal 
cycler at 4 °C for 5 minutes.

(Do NOT freeze the solution immediately after thermal denaturation at 65 °C.)

Item Sample Stand
(One Analysis per Well)

Extra Sample Stand
(Multiple Analyses per Well)

Total Number of 
Analyses

~12 13~ - -

Number of 
Analyses

- - ~4 5 - 9

Container Sample tube Sample plate with 
seal

Sample tube

Volume of Ladder, 
Sample, or Blank

4.5 μL 3 μL 7.5 μL 1.5 × (Number of 
analyses + 1) μL

Volume of Marker 
Solution

4.5 μL 3 μL 7.5 μL 1.5 × (Number of 
analyses + 1) μL

Volume of Prepared 
Solution

9 μL 6 μL 15 μL 3 × (Number of 
analyses + 1) μL
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3.6.3 Ladder and Sample Placement

1 Place the sample plate (or sample tube) in the sample stand or extra sample stand at the 
position specified in the analysis schedule.

For RNA analysis, only the premix mode is used for mixing the marker solution. Nothing has to be 
placed in the marker solution position.

3.6.4 Sample Holder Installation
^ Reference

For details on sample holder installation, see "3.5.4 Sample Holder Installation" P.50 for DNA analysis

! CAUTION

• Remove the cap used for thermal denaturation before placing the sample tubes into 
the sample stand (or extra sample stand).
Analysis with the cap attached may result in damage to the sample probe, or in other 
instrument problems.
It is not necessary to remove the aluminum seal before placing the sample plate on the sample 
stand.
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3.7 Analysis
This section describes the operations for starting analysis.

3.7.1 Pre-Analyses Checks

1 Check the following and then close the top cover.
• Chip cover is closed.
• Ladder solution or sample, separation buffer, and marker solution (for on-chip mix) are all set at their 

prescribed positions.
• Chip cleaning solution is set at the prescribed position (when performing chip cleaning after analysis).
• Sample holder is installed.
• Rinse water is replenished.
• Waste container is properly installed.

2 If more than 2 hours have elapsed since the last use, select [Wash] and then [Probe 
Rinse] on the [Instrument] menu.
Probe rinsing starts and the rinse water line fills with rinse water.

If bubbles are visible in the rinse intake line or tubing at the top of the autosampler, rinse the probe 
again.

3 When starting the instrument for the first time of the day, select [Wash] and then [All 
Chip Washing] on the [Instrument] menu.
Chip washing starts.

When analysis was not performed on the previous day, it is recommended that you run all chip 
cleaning in stead of all chip washing. Select [Chip Cleaning] and then [All Chips] on the [Instrument] 
menu.

BubblesBubbles
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^ Reference
For details, see "4.5.8 Wash" P.119

3.7.2 Starting Analysis

1 Click  [Start] on the toolbar in the MultiNA window.

The analysis is started.
The current progress of analysis can be checked in the MultiNA window.
The state of analysis is displayed on the well display at the left of the window and the schedule list at the 
right of the window.
The status bar at the bottom of the window shows the content of the latest instrument action, and the 
expected time remaining until the end of the analysis.

• Clicking [Start] automatically performs an instrument status check. If a problem is detected, 
analysis does not start and an error message is displayed.

• Chip cover is closed.

• Top cover is closed.

• Sample holder is properly installed.

• Microchip is installed in the specified chip position.

• A sufficient volume of separation buffer and marker solution are correctly positioned in the 
reagent holder.

• The chip stage is at the set temperature.

• Do NOT step away from the instrument while pre-analysis checks are in progress since an error 
message may be displayed.

Either select [Chip Status] on the [View] menu, or press the [F8] key to switch between the [Reagent 
Information] window (next page, top figure) and [Chip Status] window (next page, bottom figure).

The window will automatically switch to the [Chip Status] window when starting to fill the first sample.

^ Reference
"4.1.8 Chip Status Window" P.78
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The expected time remaining includes the automatic rinsing time after completion of analysis (see 
"3.7.3 Ending Analysis" P.60).

Well Status
Display

Status Display in 
Analysis Schedule List State

Green Waiting State before pretreatment process on microchip (such as 
filling the separation buffer)

Light blue Filling Currently filling separation buffer into microchip
Blue (blinking) Loading Currently loading the sample
Blue (blinking) Analyzing Currently analyzing the sample (separation analysis)

Blue Normal analysis end Analysis has ended normally
Red Abnormal end An error occurred, or analysis was interrupted
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Interrupting Analysis

To interrupt the analysis, either select [Stop] on the [Analysis] menu or click the  (Stop) button on the 
toolbar in the MultiNA window.

^ Reference
"4.6.2 Stop" P.122

3.7.3 Ending Analysis
The instrument automatically performs microchip rinsing and other posttreatment functions at the 
completion of the analysis sequence. Then the instrument stops.

Treatment after Analysis End

Removing the current containers
Remove the buffer bottle, marker solution vial (on-chip mix), and ladders or samples from the instrument.

Discarding waste fluid

• Use the cartridge below for dye absorption in the waste container.
bond EX Starter Kit: Nippon Genetics (Catalog No. 740701)

Rinsing the microchips
• If analysis ends normally, the microchips are automatically rinsed and can remain installed in the instrument 

after analysis.
• If analysis does not end normally, an error message is displayed. In this case, manually rinse the microchips 

as instructed in section "6.2.6 Inspecting and Washing Microchip Reservoirs" P.204.

^ Reference
For details on error messages, see "8.2 Error Messages" P.244

When RNA analysis ends or is interrupted, it is recommended that [RNase removal washing] also be 
performed on the sample probe as per "4.5.8 Wash" P.119 after automatic rinsing is completed.

! CAUTION

• During removal, avoid spilling any residual solution.
Lift the buffer bottle from the reagent holder.

! CAUTION

• Discard waste fluid on a regular basis to prevent the waste container from overflowing.

• Treat the waste fluid appropriately in accordance with prescriptions or guidelines from the 
applicable management department.
In addition to rinse water, waste fluid includes the separation buffer, marker solution, and dye. It will 
also contain formamide from RNA analysis.

^ Reference
"3.3.2 Checking the Waste Container" P.28



 MultiNA Instruction Manual   61

3.7  Analysis

3

Preparation for Long Idle Periods
If the instrument is not to be used for a long period (two weeks or more), see "7.1 Before Transport and 
Storage" P.237 and "7.3 Storage" P.239 and clean the rinse water tubing and the microchips, and properly 
store the microchips.

Data
The analysis results measured by the MultiNA are saved automatically. The data files automatically 
created are as follows.

Guidelines for data file size are as follows.
• MLT file: 96 sample data, about 6 MB
• MLA file: 96 sample data, about 3 MB
• LDR file: 1 Ladder data, about 100 KB
• LOG file: 1 kit, 4 microchip data, about 3 KB

Folder structure
Each type of data is saved to the data folder specified during installation (default: C:\MultiNA). The data 
folder structure is as follows.

• In the MultiNA - Project folder, a folder is created for each created project, within which acquired data 
(extension MLT, MLA), etc., is saved.

• In the MultiNA - Ladder folder, ladder data that is automatically created when data was analyzed is saved 
(extracted to one file for each ladder). Folders are created as follows, based on the conditions where the 
ladder is acquired, and the ladders are categorized and saved in these folders.

Type Extension File Name Folder Saved
Raw data MLT Specified at time of sample 

sheet creation
Analysis results are saved for each sample sheet.
This data is used for display.Analyzed data MLA

Ladder data LDR Data and time of the start of 
analysis (set automatically)

Calibration curve information is saved automatically for 
each ladder analysis.
This data is used in reanalysis.

Analytical 
performance 
check results

LOG Same as raw data Analytical performance check results are saved.

MultiNA

Project 1

Chip ID (e.g.: ND058-2)

Kind of reagent kit (DNA-500/DNA-1000/DNA-2500/DNA-12000/RNA)

Ladder type ID (Normally, Standard only)

Method of mixing the marker (Premix/On-chip)

Chip position (ChipPosition1/ChipPosition2/
ChipPosition3/ChipPosition4)

Project 

Project 2

Ladder
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3.8 Data Analysis
This section describes the method for using the MultiNA Viewer software to display and reanalyze data 
after sample analysis.

Raw data and analyzed data
MultiNA data consists of two types: raw data and analyzed data.

• Raw data: Primary data obtained during analysis (change in fluorescent intensity over time)
• Analyzed data: Reanalyzed raw data for which the fragment size estimation value and concentration are 

calculated

^ Reference
"5.4.5 Analyzed Data/Raw Data" P.167

Normally, when a data file is loaded, [Analyzed Data] is displayed. Display raw data by selecting [Raw 
Data] on the [View] menu in the Viewer window.

3.8.1 Displaying Data

1 Click  (View Data File) on the toolbar in the MultiNA window.

The MultiNA Viewer software starts and automatically displays the data file in the analysis schedule.

• Clicking  (MultiNA Viewer) on the desktop starts the MultiNA Viewer program but does not 

automatically load any data files.
Click [Open] on the [File] menu in the Viewer window and specify the data to load. (For details, 
see "5.2.1 Open" P.138)

• The MultiNA Viewer program can also be started by pressing the [F12] key.
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2 Click the well position on the well display, the sample name in the sample name tree, or 
the data in the gel image.

Focus changes to the data (which is enclosed in a red frame) and the corresponding electropherogram 
(single) and peak table are displayed.

• In the well display, the analysis status determines the display colors, as shown below.

• Sample analyzed normally: Blue

• Sample with Warning: Yellow

• Sample with Error (or Fatal): Red

• When Warning, and Error or Fatal, appear simultaneously, the status color is red.

• If multiple analyses were performed on the extra sample stand (X1 to X12), the yellow or red 
display color will appear if even one Warning, Error or Fatal, is generated.

^ Reference
• For information about Warning or Error, see "8 Troubleshooting" P.241

• For details on data focus, see "5.1.3 Focused Data and Selected Data" P.128
• For details on changing items displayed in the peak table, see "5.4.13 Options" P.175

Data in the gel 
image

Electropherogram 
(single)

Peak table

Well position/sample name in the sample name tree (change the tab)
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3.8.2 Data Examination and Reanalysis
Inspect the electropherograms of all of the ladders and samples included in the data file.

The peak detection level in automatic analysis is classified into four categories, [Fine], [Standard], [Coarse], 
and [Custom], according to the peak height and width at the lower detection limit. Automatic analysis is 
performed immediately after analysis is complete according to the data analysis conditions of the project 
used.

Select [Fine] to detect smaller peaks or [Coarse] to only detect larger peaks, and then perform reanalysis.

^ Reference
"5.7.1 Automatic" P.182

1 Check the ladder data.

Accurate ladder analysis is necessary for obtaining highly precise results for size estimation and 
concentration quantitation. Check all the acquired ladder data.

1 Click the ladder data for checking.
The target electropherogram is displayed.
Lower markers are displayed as LM, while upper markers are displayed as UM.

2 Verify that analysis has been performed correctly for the ladder.
• Each fragment peak in the ladder must be separated as in the data examples.
• Each marker peak must be correctly detected.
• The size number must be displayed correctly for each fragment peak in the ladder.

1

2

Electropherogram (single)
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DNA-500 kit

Standard ladder

Option ladder

No. Explanation

1 Lower marker (Magenta arrow displayed on upper part)

2 Upper marker (Blue arrow displayed on upper part)

3 25 bp to 500 bp peaks included in ladder
25 bp, 50 bp, 75 bp, 100 bp, 125 bp, 150 bp, 175 bp, 200 bp, 225 bp, 250 bp, 275 bp, 300 bp, 325 bp, 
350 bp, 375 bp, 400 bp, 425 bp, 450 bp and 500 bp; 19 peaks in total

4 125 bp peak is divided into 2 at front edge. While this is derived from the 25 bp DNA ladder 
components, it is recognized as one peak in the data analysis.

5 2652 bp peak detected after upper marker. This does not affect the analysis.

No. Explanation

1 Lower marker (Magenta arrow displayed on upper part)

2 Upper marker (Blue arrow displayed on upper part)

3 34 bp to 495 bp peaks included in ladder
34 bp, 67 bp, 110 bp (110/111 bp), 147 bp, 190 bp, 242 bp, 331 bp, 404 bp, and 495 bp (489/501 bp); 
9 peaks in total

52341

231
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DNA-1000 kit

Standard ladder

Option ladder

No. Explanation

1 Lower marker (Magenta arrow displayed on upper part)

2 Upper marker (Blue arrow displayed on upper part)

3 72 bp to 1353 bp peaks included in ladder
72 bp, 118 bp, 194 bp, 234 bp, 271 bp, 281 bp, 310 bp, 603 bp, 872 bp, 1078 bp, 1353 bp; 11 peaks in 
total

No. Explanation

1 Lower marker (Magenta arrow displayed on upper part)

2 Upper marker (Blue arrow displayed on upper part)

3 100 bp to 1500 bp peaks included in ladder
100 bp, 200 bp, 300 bp, 400 bp, 500 bp, 600 bp, 700 bp, 800 bp, 900 bp, 1000 bp, and 1500 bp; 11 
peaks in total

21 3

231
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DNA-2500 kit

Standard ladder

• While peaks of less than 65 bp are detected, these are not used for preparation of size 
calibration curves.

• When using GelStar® dye, 75 bp peak is not used in the preparation of size calibration 
curves.

DNA-12000 kit

Standard ladder

No. Explanation

1 Lower marker (Magenta arrow displayed on upper part)

2 Upper marker (Blue arrow displayed on upper part)

3 65 bp to 2645 bp peaks included in ladder
65 bp, 75 bp, 126 bp, 179 bp, 222 bp, 350 bp, 396 bp, 460 bp, 517 bp, 676 bp, 1198 bp, 1605 bp, and 
2645 bp; 13 peaks in total

1 3 2

No. Explanation

1 Lower marker (Magenta arrow displayed on upper part)

2 Upper marker (Blue arrow displayed on upper part)

3 100 bp to 10000 bp peaks included in ladder
100 bp, 200 bp, 300 bp, 400 bp, 509 bp (500/517 bp), 600 bp, 700 bp, 800 bp, 900 bp, 1000 bp, 
1200 bp, 1517 bp, 2017 bp, 3001 bp, 4001 bp, 5001 bp, 6001 bp, 8001 bp, and 10002 bp; 19 peaks 
in total

3 21
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RNA kit

Standard ladder

2 Reanalyze the data if the ladder has not been analyzed correctly.

• To add or delete peaks, or change markers (when lower or upper markers are not detected 
correctly), use the [Manual Edit Mode] in the [Reanalysis] menu to configure these items 
manually.

^ Reference
"5.7.2 Manual Edit Mode" P.185

• If the ladder used in analysis is not suitable or ladder data does not exist in the data file, load 
ladder data from another file and perform reanalysis.

^ Reference
"5.7.3 Change Ladder and Analyze" P.189

No. Explanation

1 Lower marker (Magenta arrow displayed on upper part)
(Note: The RNA marker solution does not include an upper marker)

2 200 nt to 6000 nt peaks included in ladder
200 nt, 500 nt, 1000 nt, 2000 nt, 4000 nt and 6000 nt; 6 peaks in total

1 2
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3 Check the sample data.

1 Click the sample data for checking.
The target electropherogram is displayed.

2 Check the marker and fragment peaks.

To change the peak detection state of the data, reanalyze the sample data.

^ Reference
"5.7.2 Manual Edit Mode" P.185

3 Check the peak table.

Peak table

1

2
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Items displayed in the peak table can be selected via [Options] on the [View] menu.

^ Reference
"5.4.13 Options" P.175

4 For RNA analysis, check the RNA report.
In RNA analysis, the peak table and the RNA report tab are displayed.
The RNA report displays the [Total Area] and [Total Concentration]. In addition, the total RNA 
analysis displays the [Ratio of 28S/18S rRNA].

Notes regarding samples and ladders
An example is used to explain an analysis using four microchips where 2 ladder analyses, 1 sample 
analysis, 1 ladder analysis and 1 sample analysis are performed.

• (1) X1-1 to (4) X-4: Not used in analysis.
• (5) X1-5 to (8) X1-8: Used in the analysis of (9) A1 to (13) A4 (corresponding to the latest ladder data).

(13) X2-1 to (16) X2-4: Used in the analysis of (17) B1 to (20) B4 (corresponding to the latest ladder data).

Sample Ladder Used in Analysis Chip Position

(9) A1 (5) X1-5 1

(10) A2 (6) X1-6 2

(11) A3 (7) X1-7 3

(12) A4 (8) X1-8 4

(17) B1 (13) X2-1 1

(18) B2 (14) X2-2 2

(19) B3 (15) X2-3 3

(20) B4 (16) X2-4 4
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3.9 Printing Data
Print the electropherogram, gel image, and analysis results.

1 Select the checkboxes of data to print in the gel image.

If printing all of the data, selecting checkboxes is not necessary.

2 Click  on the toolbar in the Viewer window.
The [Print] dialog box is displayed.

3 Configure the print conditions.

1 Add checkmarks to the layouts for printing.
2 Click [All] or [Selected] on the [Range] menu.

[Selected] indicates data that has been selected on the gel image or the electropherogram 
(multi).

3 Click [Print].
Printing starts.

^ Reference
For details about printing, see "5.2.8 Print" P.148.

2

3

1
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4MultiNA Control 
Software Functions

4.1 MultiNA Window

No. Name Reference

1 Menu Bar "4.1.1 Menu Bar" P.74

2 Toolbar "4.1.2 Toolbar" P.75

3 Well Status Display "4.1.3 Well Status Display" P.75

4 Analysis Schedule List "4.1.4 Analysis Schedule List" P.76

5 Detect Remaining Reagent Amount Button "4.1.5 Detect Remaining Reagent Amount Button" P.76

6 Reagent Information "4.1.6 Reagent Information" P.77

7 Status Bar "4.1.7 Status Bar" P.77

1 3 2

7 6 5 4
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4.1.1 Menu Bar

Menu Item Functional Overview Shortcut 
Key

Reference 
Page

Sample 
Entry

New Create a new sample sheet to be analyzed. F5 P.79

Add Add another sample sheet to an open analysis 
schedule.

F6 P.92

Exit Close the MultiNA Control Software. P.93

Edit Project Settings Create and edit a project. F7 P.94

Edit Sample Sheet Edit a sample sheet that is included in the open 
analysis schedule.

P.100

Delete Sample Sheet Delete a sample sheet from an open analysis 
schedule.

P.101

Copy Copy range selected from analysis schedule to 
clipboard.

Ctrl + C P.102

View Chip Status Display the electropherogram and current voltage 
for each microchip.

F8 P.78, P.103

Data File Open the MultiNA Viewer software and displays the 
selected data file.

F12 P.104

Log Display event log. P.105

Instru-
ment

Connect Connect to or disconnects from instrument. P.107

Options Set up optional settings for instrument and displays. P.108

Chip Management Open the [Chip Management] window where, 
microchips can be selected, deselected or changed.

P.110

Detect Remaining 
Reagent Amount

Check residual amounts of separation buffer and 
marker.

P.113

Move All Axes to 
Home Position

Move all of the drive axes to their home position. P.114

Check Analysis 
Performance

Close the current analysis schedule and opens an 
inspection schedule.

P.114

Parts Maintenance Control replacement parts and execute check 
program after replacement.

P.118

Wash Wash (rinse) microchips and probes.
Execute RNase removal and rinsing.

P.119

Chip Cleaning Microchip cleaning using chip cleaning solution P.120

Periodic Maintenance Peristaltic pump maintenance when the instrument 
is out of use for an extended period.

P.120

Analysis Start Start the analysis schedule. F9 P.121

Stop Stop the analysis schedule. F10 P.122

Help Quick Manual Display the Quick Manual. F1 P.123

MultiNA Instruction 
Manual

Display the Instrument Manual (system, control 
software, and data analysis software).

Check Integrity Perform an integrity check on the MultiNA program 
files.

P.123

About MultiNA Display the version information of the program. P.124
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4.1.2 Toolbar

4.1.3 Well Status Display
The well status is displayed as follows, depending on the status of the corresponding sample. 

• White:  Sample not registered
• Green:  Sample registered, not yet analyzed
• Light blue:  Separation buffer now filling
• Light blue/Blue blinking:  Sample loading/Analyzing
• Blue:  Analysis has ended normally
• Red:  Analysis has ended abnormally

When multiple analyses are performed on a sample in the extra sample stand, the status of the sample is 
displayed. The display becomes red if any one of the multiple analyses ends abnormally.

No. Explanation

1 Instrument name: Instrument name entered in option setting ([Instrument] - [Options] - [General]). The text 
color expresses the state, as follows.
• Light blue: Connected to instrument
• Pale orange: Disconnected from instrument
• Light blue: Analyzing
• Red: Error occurred

2 [New] ([Sample Entry] - [New])

3 [Add] ([Sample Entry] - [Add])

4 [Start] ([Analysis] - [Start])

5 [Stop] ([Analysis] - [Stop])

6 [View Data File] ([View] - [Data File]): Start MultiNA Viewer

1 2 3 4 5 6
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4.1.4 Analysis Schedule List
Displays the sample information entered in the analysis schedule and the sample status.

The column display can be changed by selecting [Options] on the [Instrument] menu and then selecting the 
[Column Selection] tab.

4.1.5 Detect Remaining Reagent Amount Button

Click this button before starting an analysis schedule to determine the residual amount of separation buffer 
or marker solution in the reagent holder. 

This function can also be accessed by selecting [Detect Remaining Reagent Amount] from the [Instrument] 
menu.

Column Explanation

Well name Displays the information of sample registration. For details, see "4.2 Sample Entry Menu" P.79

Project name

Sample name

Comment

Type

Sep. Buffer

Mode

Chip Displays the chip No. to be used (or used) for the respective samples. 

Status The status is displayed as follows, depending on the sample analysis state.

Waiting Pre-analysis state before pretreatment of microchip. 

Filling Pretreatment of microchip in progress (separation buffer filling, etc.).

Loading Loading sample onto microchip in progress.

Analyzing Analysis of sample in progress (separation in progress). 

Normal End Analysis has ended normally.

Abnormal End An error occurred, or analysis was interrupted.

Skipped Because failure occurs to the microchip during analysis performance 
inspection, analysis was skipped.

Detect remaining 
reagent amount button
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4.1.6 Reagent Information
This window displays the volumes of separation buffer, marker solution (for on-chip mix only), and chip 
cleaning solution required for analysis of the unanalyzed samples in the analysis schedule, and the 
remaining volumes of each reagent (after detection of the residual reagent volumes).

Required amount of separation buffer displayed in [Reagent Information] includes the following excess 
volumes. 

• Minimum amount detectable by the liquid level sensor used to check the volume of remaining reagent

• Amount consumed in the conditioning process

• Amount required when the fill check results in NG and a refill is performed

4.1.7 Status Bar

No. Explanation

1 DNA-500 kit

2 DNA-1000 kit

3 DNA-2500 kit

4 RNA/DNA-12000 kit

5 Displayed color indicates state of residual separation buffer amount.
• Gray: Residual amount unconfirmed
• Same color as background: Residual amount acceptable
• Red: Residual amount insufficient

6 Displayed color indicates state of residual marker solution amount. 
• Gray: Residual amount unconfirmed
• Same color as background: Residual amount acceptable
• Red: Residual amount insufficient

7 Chip cleaning solution

8 Displays volumes of separation buffer, marker solution, and chip cleaning solution required for use (calculated 
from the sample sheet), and their residual volumes.

5

6

8

21 3 4

7

No. Explanation No. Explanation

1 Displays of the latest instrument action 3 Data file name

2 The remaining time in the entire analysis 
schedule

4 Data file comment

1 2 3 4
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4.1.8 Chip Status Window
Selecting [Chip Status] from the [View] menu switches between the [Reagent Information] window and 
[Chip Status] window (figure below).

The [Chip Status] window displays the electropherogram and current/voltage graphs for each microchip.  
The window will automatically switch to the [Chip Status] window when starting the analysis (when starting 
to fill the first sample). To change the graph scale, point to [Project Settings] and select [Display] (see 
"4.3.1 Project Settings" P.94).

No. Explanation

1 Chip position 1

2 Chip position 2

3 Chip position 3

4 Chip position 4

5 Voltage status: Displays, in real-time, the voltage monitor value in each of microchip ports 1 to 4. 

6 Current status: Displays, in real-time, the current monitor value in each of microchip ports 1 to 4. 
(A negative value is indicated in red.)

7 Electropherogram: Displays, in real-time, the photometry data detected for each microchip. 

1

2

3

4

5 6 7

Port 1 2 3 4  1 2 3 4
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4.2 Sample Entry Menu

4.2.1 New
A new sample sheet is created and entered into the analysis schedule.

(Click  [New Entry] on the toolbar to obtain the same result.)

The following message is displayed if the analysis schedule already contains a sample sheet.

Click [Yes] to proceed with the new entry. The content of the existing sample sheet is discarded 
when the new sample sheet is entered.

1 Select [New] on the [Sample Entry] menu. 
The [Sample Entry - New] window is displayed. 

2 In the [Sample Entry - New] window, select one project and click [OK], or double-click 
the line. 

No. Explanation

1 List of projects already created 

2 Click this button to open a window for selecting the existing sample sheet file. Select the file name and 
click [Open] to display the sample sheet in the [Sample Sheet] window (for details, see "Sample Sheet 
File" P.84).

21
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If no project exists that corresponds to the sample for analysis or dye to be used, cancel the window 
and create a new project.

(see "4.3.1 Project Settings" P.94)

The [New Entry] window is displayed. 

No. Explanation

1 Specifies the well position where the ladder solution or sample is located. Either click on the well, or 
drag the mouse over it to select it. 

2 Displays the number of the samples included in the sample sheet. If it is "0", you can create a sample 
sheet by entering the total number of samples. The well positions are entered automatically based on 
the [Analysis Order] selected in the [Project Settings] window. 
In [Add Entry] ("4.2.2 Add" P.92), this number includes the samples in the current analysis schedule 
and the samples in the current sample sheet.

3 When [Auto ladder entry] is selected on the [Edit] - [Project Settings] menu, the ladders are 
automatically entered at the top of the sample sheet according to the number of microchips being 
used ("3.4.1 Project Settings" P.35). 

4 The data file name is automatically entered according to the [Default data file name] selected on the 
[Edit] - [Project Settings] menu. For example, for %Y%M%D-%Q, the file name is automatically the 
year-month-day and sequential number (e.g.: 20070130-001, first data file for January 30, 2007).
The file name shown below the column indicates the file name created. (Clicking [Enter] confirms the 
file name.)

5 The required amounts of separation buffer and marker solution (on-chip mix only) are calculated and 
displayed in the [Reagent Information] window. 

6 Use the [Import] window ("Import" P.86) to extract sample information from an existing Excel or CSV 
file.

7 This area displays information including the project name, separation buffer, and dye.

2 3 4

56

1 4 7
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3 After selecting the sample well position, click  .
The sample information is entered into the appropriate columns. The content is automatically entered 
according to the [Project Settings].

^ Reference
"4.3.1 Project Settings" P.94

4 Click [Enter]. 

The set sample sheet is added to the analysis schedule. 

In the following cases, [Enter] is not displayed and sample sheets cannot be added to the analysis 
schedule. 

• When the instrument is performing analysis or rinsing

No. Explanation

1 Enter a [Sample Name] and [Comment]. Select ladder or sample for the [Type]. 

2 Click [Save] to save the sample sheet content as a sample sheet file. Use [Sample sheet file] in either 
the [Sample Entry - New] window or [Sample Entry - Add] window to open the saved file ("Opening the 
Saved Sample Sheet" P.85).

3 Clicking [Enter] or [Save] with this check box selected saves the content of the current [Sample Entry] 
window as the default sample sheet (file name: default.ssh). If [Load default sample sheet while 
starting up] is selected in the [Project Settings] window, this default sample sheet is displayed when 
the [Sample Entry] window is opened ("3.4.1 Project Settings" P.35).

23

1

Well positions
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• When the MultiNA instrument and PC are not connected (see "3.2 Startup and Shutdown" P.22)

• When the selected microchip is not installed or registered (see "3.3.4 Microchip Registration" 
P.30).

The following message is displayed when the sample sheet does not contain a ladder analysis.

Usually, click [No], and edit the sample sheet to add the ladder analysis.

• Although the analysis schedule can be executed without a registered ladder, a ladder must be 
imported in order to obtain analysis results including size estimation and quantitation (see "5.7.3 
Change Ladder and Analyze" P.189 regarding the [Reanalysis] menu).

The maximum number of analyses (both ladders and samples) that can be entered into an analysis 
schedule is 120. The maximum number of analyses that can be entered into a sample sheet is also 
120.

Well Image Right-Click Menu

Menu Explanation

Clear Selection Clears all well selections (black). 

Apply Selected Wells Enters sample information for the selected wells into the sample sheet.

Delete Selected Sample Information Deletes information about the selected wells from the sample sheet. 
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Sample Sheet Right-Click Menu

Menu Explanation

Undo Restores operation to the content before change. 

Redo Re-performs the just-canceled operation. 

Auto Fill Fills in the content of the selected cells. Enters the sample name, comment, 
and type, as follows.
Sample name and comment columns:
Enter a name or comment in the top cell. Select the range to be filled and 
select [Auto Fill]. The cells are filled with the sample name or comment and a 
sequential numeric value is added at the end of the sample name or 
comment. If the last character is a number the sequence initiates from that 
number. (Example: 002 is entered in the top cell, the sequence becomes 
002,003,004...)
Type column:
Select the type in the top cell. Select the range to be set and select [Auto Fill], 
to copy the entered content from the top cell.

Cut Copies the content of the selected cell to the clipboard, and then deletes it. 

Copy Copies the content of the selected cell to the clipboard. 

Paste Pastes the content in the clipboard to the selected range. 

Copy Sample Sheet Copies all information in the sample sheet to the clipboard.

Insert Line Inserts a line.

Delete Line Deletes sample information in the selected line. 

Hide/Show Columns (It is displayed if 
right-clicking on the top title line.)

Displays the window used for selecting items to be displayed in the column 
(see "4.5.2 Options" P.108).
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Sample Sheet File
To perform repeated analyses with the same sample composition and save sample entry time, save the 
content entered in the [Sample Entry] window to a file, then open that file for the subsequent sample sheet 
entries.

Saving the Sample Sheet

1 After creating the sample sheet, click [Save]. 

2 In the [File name] column, enter the name of the file and click [Save]. 
A sample sheet file with extension .ssh is saved in the project folder. 



 MultiNA Instruction Manual   85

4.2  Sample Entry Menu

4

Opening the Saved Sample Sheet

1 Select [New] on the [Sample Entry] menu or click [New Entry] on the toolbar. 
The [Sample Entry - New] window is displayed.

2 Select the project, and then click [Sample sheet file]. 

A window for opening the file in the corresponding project folder is displayed. 

3 Select the sample sheet file, and then click [Open]. 
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The selected sample sheet file is opened, and the [Sample Entry] window is displayed. 

Import
[Import] is a function for converting and inputting sample information from an existing Excel or CSV file to a 
MultiNA sample sheet.

[Import from]: import source

[Import to]: import destination
• [Data file name], [Data file comment], [Well name], [Sample name], [Comment] and [Type] information can all 

be imported.

1 In the [Sample entry] window, click [Import]. 
The [Import] window is displayed.
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2 Click [Browse].

The [Open] dialog box is displayed. 

3 Select an Excel file or CSV file, and click [Open]. 
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If the Excel or CSV file is currently open in another program (Excel, etc.), the following message will 
be displayed. Close the file in other software, and then reopen the file in the MultiNA Control 
Software.

The Excel or CSV file is displayed in the [Import from] section of the [Import] window.
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4 Create a rule for converting the [Import from] information to [Import to]. 

1 Drag the mouse to select the import source cell, and align the mouse cursor with the selected range. 
The mouse pointer changes to an arrow.

2 Drop the cells into the blue box above the column corresponding to the import destination (moving 
the mouse pointer over the box changes its color to pink).
The selected import source information (cell range) is entered in the blue boxes above the import 
destination column. The import source information is copied under these boxes. 

The same operation can be performed by entering the desired import source cell information for 
conversion directly into the blue box above the import destination and then clicking the [Apply 
rule] button in the center of the window.

1

[Apply rule]

2

Example in which cells A4 to A9 are selected and 
then dropped into the box above the well name
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5 Create a rule for the information to be imported using the same operation as step 4.
The imported information is copied (sample name, comment, type, data file name, and data file 
comment).

6 Click [Import].
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The content of the import destination is imported into the sample sheet.

If you attempt to import a well position included in a previously created sample sheet, the import 
operation is not performed and the following message is displayed.

Saving the Import Rule
If saving the rule, you can easily convert the import source information to the import destination when 
importing the file with the same format next time. 

1 Click [Save rule]. 

The [Save as] window is displayed.
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2 Enter a file name and click [Save]. 

Cell information converted from the import source to import destination is saved as a rule file 
(extension: .rle). 

• When the next analysis schedule is created, click [Load Rule] in the [Import] window to open the 
saved rule file.

• Click [Browse] to open the import source file, and the information is automatically input at the 
import destination.

4.2.2 Add
Sample sheets can be added to the registered analysis schedule.

If a sample sheet is added to an analysis schedule using a project name that is already entered in the 
analysis schedule, all of the data will be stored in the same data file.

Typically, data from separate sample sheets is stored in separate data files. A separate data file is created 
even when a sequence-number format has been applied to the data file name. 

1 Select [Add] on the [Sample Entry] menu. 
The [Sample Entry - Add] window is displayed. 

 (Add Entry) is enabled on the analysis schedule toolbar after the first (new) sample sheet is entered 
in the analysis schedule.
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2 Select a project and click [OK].
Alternatively, click [Sample sheet file] to open an existing sample sheet.

The [Add Entry] window is displayed.
Wells already registered in the analysis schedule are grayed out. 

If a well in the existing sample sheet is already being used by the samples in the analysis schedule, 
the sample sheet file fails to load and the following error message is displayed. 

3 Select any open well, and use the same procedure as new entries to insert the sample.
The additional entry is inserted next to the existing analysis schedule.

4.2.3 Exit
The MultiNA Control Software is closed.

The application cannot be exited when the instrument is performing analysis or rinsing.
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4.3 Edit Menu

4.3.1 Project Settings
Create new projects or edit existing projects in the [Project List] window.

• [New]:  Create a new project. (P.94)
• [Copy]:  Copy and edit an existing project. (P.99)
• [Edit]:  Edit an existing project. (P.99)
• [Delete]:  Delete an existing project. (P.100)

New
Create a new project.

1 Enter the displayed items in [General] tab.
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Item Maximum Number 
of Characters Explanation

Project name 30 Enter the project name (required).
/\<>:"|?* and space cannot be used.

Operator 
name

20 Enter the operator name (required).
/\<>:"|?* and space cannot be used.

Comment 50 Enter a comment about the project.

Default data 
file name

258 (Including path) When the [Sample Entry] window is opened, specify the data file 
name to be automatically set. /\<>:"|?* and space cannot be used.
In addition to normal characters, the following format characters can 
be used. 
 %I: Instrument name (The name set in [Instrument] - [Option])
 %J: Project name
 %O: Operator name
 %B: Separation buffer
 %Y: Year, %M: Month, %D: Day, %h: Hour, %m: Minute, %s: Sec.
 %Q: Sequential number (Reset in 3 digits at midnight)
Click  to select and enter a format.

Ex. In %Y%M%D-%Q, for analyses performed on January 30, 2007, 
the first data file name is 20070130-001 and the next one is 
20070130-002.

Default 
sample name

30 In the sample entry window, select the sample name to be 
automatically entered.
In addition to normal characters, the following format characters can 
be used.
  %W: Well name (A1, B1,...)
  %N: Well No. (1 to 108)
  %Y: Year, %M: Month, %D: Day
Click  to select and enter a format.
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2 Select the displayed items in the [Sample] tab.

Item Explanation

Sample 
(Separation Buffer)

Select the separation buffer to be used in the project.

Total RNA/mRNA Select RNA (RNA separation buffer) for RNA analysis. (The content of data 
analysis differs between Total RNA and mRNA. When calculating the ratio 
between 28S rRNA and 18S rRNA, select Total RNA.)

Marker mixing mode Select on-chip or premix. For details about each mode, see "2.3 Mixing the 
Marker Solution" P.20.

Load default sample sheet 
while starting up

If this is selected, the default sample sheet (file name: default.ssh) is 
automatically read when the [Sample Entry] window is opened ("4.2.1 New" 
P.79).

Auto ladder entry / 
Well name

If the ladder is selected, the ladder is automatically registered when the [Sample 
Entry] window is opened. A well position (one from X1 to X12) for setting the 
ladder is specified at the same time.

Ladder type Select the standard ladder [Standard (STD)] normally. The optional ladder 
[Ladder1 (LD1)] may also be selected.

Analysis order Select the analysis order (A1-B1-C1…, or A1-A2-A3…) for a sample sheet 
created from the wells selected in the [Sample Entry] window.

Dye Select the dye to use when performing DNA analysis (see "3.5.1 Diluted Dye 
Solution and Separation Buffer Preparation" P.44).
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3 Select the required items on the [Data Analysis] tab.

The data analysis conditions to use when analysis completes can be configured. The method of 
configuration is the same as that for reanalysis settings in the MultiNA Viewer (see "5.7.1 Automatic" 
P.182).

4 Select the required items on the [Auto-export] tab.

An export file for each selected item is automatically output upon completion of analysis. The method of 
configuration is the same as that for "5.2.7 Export" P.145 in the MultiNA Viewer. [Auto-export file name] 
indicates the name of the exported file.
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5 Select the displayed items in the [Display] tab.

6 Click [OK].

Item Explanation

Graph scale Configure the graph scales described in "4.1.8 Chip Status Window" P.78. The possible 
manual selection ranges are as follows.
Voltage: 1 to 1500 (V)
Current: 1 to 300 (µA)
Electropherogram: 0 to 2500 (mV)
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Copy
Copy and edit an existing project.

1 Select an existing project in the [Project List] window (P.94), and click [Copy].
The [Project Settings] window is displayed.

A window is displayed with a blank project name and all of the other items copied from the existing 
project. 

2 Enter a new project name. 

3 After completing entry and selection for the necessary items on each tab, click [OK]. 
The project is saved. 

Edit
Edit the content of an existing project. 

The project name cannot be changed. To change the project name, [Copy] the project and save it with a 
different name. 

1 Select an existing project in the [Project List] window (P.94), and click [Edit].

2 Change the necessary items in the [Project Settings] window.

3 Click [OK].
The following confirmation message is displayed.

4 Click [Yes].

The changes are saved.

The following message is displayed when an attempt is made to edit a project that is currently 
associated with samples entered on the MultiNA window. Select [Yes] to open the [Edit] window. 
Some items such as, type of separation buffer, will be disabled and cannot be changed.
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Delete
Delete an existing project. 

1 Select an existing project in the [Project List] window (P.94), and click [Delete].
The following confirmation message is displayed.

2 Verify the project name, and click [Yes].
The project is deleted.

A project cannot be deleted if it is associated with a sample entered on the MultiNA window. The 
following message is displayed. 

4.3.2 Edit Sample Sheet
Use this menu to edit a sample sheet that is entered in the analysis schedule.

1 Click any cell in the sample sheet to be edited in the MultiNA window.
If only one sample sheet has been added to the analysis schedule, this procedure is not required.

2 Select [Edit Sample Sheet] on the [Edit] menu. 
You can also right-click on the sample sheet to bring up a menu, then select [Edit Sample Sheet].
The [Sample Entry] window is displayed. 
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3 Edit the sample sheet in the [Sample Entry] window.

4 After editing the sample sheet file, click [Enter].
The sample sheet is re-entered into the analysis schedule.

4.3.3 Delete Sample Sheet
Use this menu to delete a sample sheet from the analysis schedule.

1 Click any cell in the sample sheet to be deleted in the MultiNA window.
If only one sample sheet has been added to the analysis schedule, this procedure is not required.

2 Select [Delete Sample Sheet] on the [Edit] menu.
Alternatively, right-click on the sample sheet and select [Delete Sample Sheet].
The following confirmation message is displayed.
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3 Check the project name and data file name, and click [Yes]. 
The sample sheet is deleted, and the analysis schedule in the MultiNA window is changed. 

4.3.4 Copy

1 Use this menu to copy the content (text) selected in the analysis schedule to the 
clipboard. 

1 Drag the mouse over the range to be copied in the analysis schedule to select it.
2 Select [Copy] on the [Edit] menu. 

The selected content is copied to the clipboard. (The selected range is copied to the clipboard with 
partition tabs.)

The content can be pasted into other applications for editing.

2

1
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4.4 View Menu

4.4.1 Chip Status
Select [Chip Status] from the [View] menu.

The [Reagent Information] window and [Chip Status] window display changes.

The [Chip Status] window displays the electropherogram and current/voltage graphs for each microchip. 

^ Reference
"4.1.8 Chip Status Window" P.78

The window will automatically switch to the [Chip Status] window when starting the analysis (when starting to 
fill the first sample).

[Chip Status] window



4  MultiNA Control Software Functions

104   MultiNA Instruction Manual

4.4.2 Data File
Select [Data File] from the [View] menu.

Alternatively, click  (View Data File) on the right end of the toolbar.

Start the MultiNA Viewer to display the analyzed data. 

If the analysis schedule contains more than one sample sheet, only the data file for the selected sample 
sheet is displayed when the MultiNA Viewer is opened. 

Viewer window
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4.4.3 Log
Follow the procedures below to display the instrument events recorded in the log. 

1 Select [Log] on the [View] menu.
The [Search Criteria] window is displayed. 

2 Specify any search conditions and then click [OK].

An [Event Log] window is displayed.

Search Criteria Explanation

Max. number Indicates the number of cases to be displayed. A maximum of 5000 cases can be 
entered. 

Date (From/To) Specifies the event generation date range. 

Level Specifies the event level (Info, Warning, Error, Fatal). 

Source Specifies the event source. 

Code Specifies the event code. 

1 2 3
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The levels in the log are described below.

• To rearrange the list displayed in the [Event Log] window, click the header of [Date] or [Level].

• Right-click in the [Event Log] window and select [Select All] from the displayed menu to select all 
entries in the event log.

• Select the range, then right-click and select [Copy] to copy the selected range to the clipboard.

[Event Log] Window Button

Level Explanation

Info Event (information) generated in the instrument (Analysis start or end, etc.). 

Warning Event that will not impede the continuous analysis but could have an effect on data. 
See "  Warning" P.256.

Error Event that disables continuation of automatic analysis. See "  Error" P.248.

Fatal Event that requires an instrument status check and could lead to a situation where 
continuation of operations in this condition is either impossible or dangerous. See "  Fatal" 
P.246. 

No Button Explanation

1 Save as Use this button to save the displayed content to a CSV file. Enter a name in the file 
save dialog box.

2 Delete Use this button to delete the selected event log line. Select [Yes] in the displayed 
confirmation dialog box to delete the content. (The content is deleted not only from 
the display, but also from the file where the event log is saved.)

3 Search 
criteria

The event log search window is re-displayed.
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4.5 Instrument Menu

4.5.1 Connect
Communication between the MultiNA instrument and the PC is connected or disconnected with this menu.

• When connected, the check box of this menu is selected.
• During analysis, the [Connect] menu is disabled and cannot be selected.

• The characters in the [Instrument name] display ("MultiNA" in the figure above) on the left end of the toolbar 
are light blue when connected and pale orange when disconnected. 

Select the [Connect at start up] check box to automatically establish communication between the PC and the 
instrument when the MultiNA software is opened. Refer to "4.5.2 Options" P.108.

Automatic connection is not performed in the following cases. Verify that the instrument power is ON and 
that the LAN cable is properly connected, then establish communication.

• Instrument was not turned ON when the software was started up 

• [Connect at start up] check box is cleared

• LAN cable is not correctly connected

• Communication was disconnected from the instrument due to a communication error
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4.5.2 Options
The instrument options and display items common to all projects are set with this menu.

[General] Tab

Do NOT change the IP address from the address set during the instrument installation. If any change is 
necessary, contact your Shimadzu service representative. 

Item Explanation

Instrument name Instrument name displayed on left end of toolbar. (Up to 16 characters.)

IP address Instrument IP address (entered during installation)

Port number Port number used for socket communication (cannot be changed)

Connect at start up Determines whether automatic connection to the instrument is established when the software 
is opened.

Enable sleep mode Determines whether the instrument enters the sleep mode after completion of the analysis 
schedule.
If selected:
• The instrument enters into the sleep mode when all instrument operations (analysis, 

washing, and all other operations) are complete, and there are no PC mouse or keyboard 
operations for a period of at least one hour.

• In sleep mode, all motor power, chip stage temperature adjustment, and fan operation 
stop, to reduce power consumption.

• Operating the PC mouse or keyboard cancels the sleep mode.
• It takes up to 5 minutes for the chip stage to reach the designated temperature after the 

sleep mode is canceled. (If analysis is started during this warm-up period, the analysis will 
not begin until the chip stage reaches the designated temperature.)
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[Column Selection] Tab

[Analysis Schedule] Tab

Configure the operations to be performed before and after execution of the analysis schedule.

Item Explanation

MultiNA window
(analysis schedule)

Determines the columns to be displayed in the analysis schedule.

Sample entry window
(sample sheet)

Determines the columns to be displayed in the sample sheet.
(The well names and types are essential for sample entry and cannot be changed.)

Item Explanation
Show message to 
check rinse water

Displays a rinse water confirmation message before the start of every analysis.

No. of times of water 
washing

Sets the number of times to perform rinsing after analysis is complete.

Run chip cleaning Automatically executes chip cleaning (see "3.5.5 Chip Cleaning Solution Placement" P.50) 
after analysis is complete. Also sets the number of times to perform cleaning.
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4.5.3 Chip Management
Follow the procedures below to control information for microchips installed in the instrument.

• The chip No. at [Chip in use] shows the chip position in the instrument. (Chip 1 is farthest back, followed in 
order by chip 2 and chip 3, with chip 4 in front.)

• Removing the [Chip in use] check box prevents use of that microchip for analysis.

Changing the chip to be used after a sample has been entered causes the following warning message to be 
displayed.

• Select [Yes] to delete the analysis schedule and enter a new sample.
The analysis schedule is deleted.

• Select [No] to use the same analysis schedule and then save the sample sheet once before changing the 
chip to be used.

^ Reference
"Saving the Sample Sheet" P.84

 

[Clear unavailable flags]
Click [Clear unavailable flags] in the [Chip Management] window to make a microchip judged unavailable 
during analysis usable again.

• The unavailable status is cleared.

A microchip judged during analysis to be unavailable cannot be used any further. Manually clean the 
microchip, to eliminate clogging or other problems. 
Refer to "6.2.6 Inspecting and Washing Microchip Reservoirs" P.204.
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[History]
• Click [History] to check the history of the microchip being used.

The history of used microchip (chip ID, No. of runs,  start / last date and time, and chip position) is displayed 
in the [Chip History] window.

• Click [Delete] at the bottom left of the [Chip History] window to delete the microchip history. Note that the 
history of microchips currently in use cannot be deleted.

Exchanging the Microchip
Use the [Chip Management] window to control microchip exchange or removal. 

To exchange the microchip

1 Click  (Change) next to the microchip to be exchanged.
The [Chip x Change] window is displayed. 

2 Enter the microchip serial number (chip ID) in the [Chip x Change] window, and click 
[Change].
If the microchip was previously used, the history of its usage is displayed.
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To remove the microchip
The following describes the procedure for removing a microchip, using chip position 1 for the example. 

1 Click  (Change) next to chip 1, in the [Chip Management] window.

The [Chip 1 Change] window is displayed.

2 Click [Remove] in the [Chip 1 Change] window.

Chip 1 is grayed out, and the check box is cleared.

3 Click [Close]. 
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4.5.4 Detect Remaining Reagent Amount
Follow the procedures below to check the residual amount of separation buffer or marker solution.

• The residual reagent amount is calculated by inserting a sample probe into the reagent bottle to detect the 
reagent liquid level.

• The residual reagent amount is automatically checked when an analysis sequence is started. This function 
can also be used to check the residual reagent amount without starting the analysis sequence.

1 Place the reagents and samples in the appropriate positions and close the top cover.

2 Verify that the analysis schedule has been entered.

3 Select [Detect Remaining Reagent Amount] from the [Instrument] menu or click the 
button on the upper right corner of the [Reagent Information] window. 

4 If the following message is displayed, click [Yes].
The residual reagent amount check starts.
Once the check is finished, the residual amount of reagent is displayed in the [Reagent Information] 
window.
If the amount of reagent is insufficient, the position of the separation buffer or marker solution is displayed 
in red.
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4.5.5 Move All Axes to Home Position
If drives are stopped at a position other than the home position due to an error or other reasons, use this 
menu to return the instrument drives (autosampler, pneumatic unit, and syringe pump) to the home 
position.

1 Select [Move All Axes to Home Position] from the [Instrument] menu.
The green LED indicator blinks during the operation. A blue status bar is displayed at the bottom left of the 
window.
When the operation is complete, the blue status bar is no longer displayed and the green indicator LED is 
steady lit.

2 Open the top cover.
Verify that the drive axes have returned to the home position as shown in the figure below.

This function will not operate if the chip cover or the top cover are open. Close the chip cover and instrument 
cover before starting this operation. 

4.5.6 Check Analysis Performance
The state of the instrument, microchips, and reagent kit can be checked by periodically executing analysis 
performance checks.

Registering a Schedule and Starting Analysis Performance Checks
Select the kit and microchip to be used.

1 Click [Check Analysis Performance] on the [Instrument] menu.
The [Check Analysis Performance] window is displayed.
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2 Enter a schedule for checking the analysis performance.

1 Select the kit, dye, and microchip to be used.
2 Click [Enter].

The schedule for checking the analysis performance is registered.

• The marker mixing modes are, DNA kit: on-chip mixing, RNA kit: premix.

• When checking multiple kits or repeating checks for the same kit, [Check Analysis Performance] 
can be selected again to perform another registration after registering the schedule for checking.

• Normal analysis cannot be additionally registered to a schedule for checking.

• Although [Delete Sample Sheet] can be performed in schedules for checking, [Edit Sample Sheet] 
cannot be performed.

3 Prepare the separation buffer, marker solution, and sample required for analysis 
performance checking according to normal analysis procedures and place them in the 
instrument.

^ Reference
"3.3 Pre-Analysis Preparation" P.27
"3.5 Preparation for DNA Analysis" P.44
"3.6 Preparation for RNA Analysis" P.52

• Refer to the table below for the samples to use and the corresponding placement positions.

Always place samples in the specified wells because the sample positions listed above cannot be 
changed.

1

2

Reagent Kit Sample Well Position

DNA-500 TE buffer X1

DNA-1000 TE buffer X2

DNA-2500 TE buffer X3

DNA-12000 TE buffer X4

RNA THE RNA Storage Solution X4
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4 Start the analysis.
The following files are created when the analysis performance check is executed.

• If the check results raw data file (MLT file) is opened in MultiNA Viewer, the check results log file 
(LOG file) is also automatically opened. ("5.4.9 Analysis Performance Check Result" P.173)

• Since the LOG file is text data, it can also be opened with Notepad program or editor program.

Checking the Analysis Performance Results

Either select [Data File] on the [View] menu, or click  [View Data File] on the toolbar. The check results 
are automatically displayed.

Type File Name (Base Name) Extension Save Folder

Raw data A name that reflects the year, month, day, 
and time that the check was executed
(E.g.: File name for a check executed on 
13th September 2006 at 14:50:20 is 
"20060913_145020.MLT")

MLT [Reagent kit name] folder in the Project 
folder located inside the data folder 
(normally, C:\MultiNA\).

Analyzed data Same as raw data MLA Same folder as raw data

Analysis 
performance 
check results 
log

Same as raw data LOG Same folder as raw data

Check Item Explanation

No. of Errors Number of "Errors" that occurred during sample analysis

No. of Warnings Number of "Warnings" that occurred during sample analysis

LM Time (sec.) Peak detection time for the lower marker

UM Time (sec.)* Peak detection time for the upper marker

LM Height (mV) Peak height for the lower marker

UM Height (mV)* Peak height for the upper marker

L1 to L4 Curr. (µA) Current value for sample injection in microchip reservoirs No.1 to No.4

S1 to S4 Curr. (µA) Current value for sample separation in microchip reservoirs No.1 to No.4
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• Items marked with asterisk (*) are not displayed for RNA checks (RNA uses lower marker only).
• "Passed" or "Failed" is displayed for each check item. The value in parentheses to the right of the pass 

or fail is the pass reference value (which varies depending on the reagent kit and dye used).
• If any one of the check items has a "Failed" result, the general result (<Result No. #>) is also "Failed".

If the check result is "Failed", the following causes can be considered.

Baseline (mV) Baseline height in [Raw Data]

UM No. of TP* Theoretical plate number for the upper marker peak

Noise Ampl. Noise amplitude in electropherogram

Check Item Symptom Possible Cause

No. of Error/
Warning 

An error or warning 
occurred during analysis.

"Error" or "Warning" occurred in the instrument during sample 
analysis.
Display the log ("4.4.3 Log" P.105) and check the content. For 
details about error messages, see "8.2.1 MultiNA Control 
Software" P.244.

LM Time Value under standard range 
(detection is too fast)

Low separation buffer concentration
Kit type used differs from the recorded kit. 

Value over standard range 
(detection is too slow)

Incorrect current running
High separation buffer concentration
Kit type used differs from the recorded kit. 

UM Time Value under standard range 
(detection is too fast)

Low dye concentration in separation buffer
Kit type used differs from the recorded kit. 

Value over standard range 
(detection is too slow)

Incorrect current running
High dye concentration in separation buffer
Kit type used differs from the recorded kit. 

LM Height Value under standard range 
(peak is too low)

Lower marker has deteriorated.
Microchip surface is contaminated.
Microchip not installed correctly on chip stage
(For RNA analysis) Formamide has deteriorated.

UM Height Value under standard range 
(peak is too low)

Dye has deteriorated.
Separation performance degraded due to microchip 
deterioration
Separation performance degraded due to separation buffer 
deterioration
Insufficient marker solution dispensed to microchip (degraded 
instrument dispensing precision)
Microchip surface is contaminated.
Microchip not installed correctly on chip stage
(For RNA analysis) Formamide has deteriorated. 

L1 to L4 
Curr.

Value under standard range 
(value is too low.)

Microchip flow channel is clogged, or partially clogged.
Bubbles generated in microchip flow channel
Insufficient amount of separation buffer in microchip reservoir
Insufficient amount of sample dispensed to microchip
Kit type used differs from the recorded kit. 

Value over standard range 
(value is too high.)

Separation buffer concentration increase
Foreign material (salt) intruded into separation buffer
High salt concentration in sample
Kit type used differs from the recorded kit. 

Check Item Explanation
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• Corresponding to the presumed cause, clean the microchip surface, or replace the reagent kit, dye, 
microchip, and formamide (RNA analysis only), and repeat the analysis performance check again.

• If this does not solve the problem, contact your Shimadzu service representative. 

4.5.7 Parts Maintenance
This window displays usage status information including the previous number of analyses, operation times, 
and previous replacement dates and times.

[Reset]:

Resets the number of analyses and operation time and changes the replacement time to the current time. 
Click this button after replacing parts or performing checks.

[Check]:

Starts the inspection program after replacing parts. Click this button after replacement and check 
preparation are complete.

[Movie]:

Plays video that explains part replacement procedures.

S1 to S4 
Curr.

Value under standard range 
(value is too low.)

Microchip flow channel is clogged, or partially clogged.
Bubbles generated in microchip flow channel
Insufficient amount of sample dispensed to microchip
Kit type used differs from the recorded kit. 

Value over standard range 
(value is too high.)

Separation buffer concentration increase
Foreign material (salt) intruded into separation buffer
High salt concentration in sample
Kit type used differs from the recorded kit. 

Baseline Small value (baseline is too 
low.)

Low dye concentration in separation buffer

Large value (baseline is too 
high.)

High dye concentration in separation buffer
Microchip has deteriorated.
Microchip surface is contaminated.

UM No. of 
TP

Small value (theoretical 
plate number is too small)

Microchip has deteriorated.
Reagent kit has deteriorated, and salt concentration changing 
(increase).

Noise Ampl. Large value (noise is large) Microchip surface is contaminated.

Check Item Symptom Possible Cause
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^ Reference

For details on replacement parts, see "10 Parts Specifications" P.279
For details on how to replace parts, see "6.3 Parts Maintenance and Replacement" P.211

4.5.8 Wash

Select the following items from the [Wash] menu, and perform each rinsing operation. 

Menu Item Explanation

Chip 1 to Chip 4 Washing Rinse each microchip with water. The number of rinses can be set between 1 and 
5 times. Although 1 time is normally sufficient, adjust this value as necessary.

All Chip Washing Rinse all the microchips installed with water. The number of rinses can be set 
between 1 and 5 times. Although 1 time is normally sufficient, adjust this value as 
necessary.
Even chips that are not selected in the [Chip Management] window are washed.

Probe Rinse Rinse the sample probe with water.

RNase Removal Rinse the sample probe with probe rinsing solution and water.
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• Before rinsing, verify that the glass rinse water bottle for rising contains at least 100 mL of Milli-Q 
ultrapure water or distilled water.

• Before RNase removal, insert 1 mL of probe rinsing solution (RNaseZAP® Applied Biosystems (formerly 
Ambion)) into the buffer bottle, and place it in front of the rinse port in the reagent holder.

• Avoid a mix up with the chip cleaning solution by discarding the probe rinsing solution set in the reagent 
holder after RNase removal is complete.

4.5.9 Chip Cleaning
Select any of the following items from the [Chip Cleaning] submenu to perform microchip cleaning using 
chip cleaning solution.

• Perform chip cleaning according to the procedure described in "6.2.9 Chip Cleaning" P.209.

• To perform chip cleaning upon completion of an analysis schedule, see "  [Analysis Schedule] Tab" 
P.109 in "4.5.2 Options".

• Cleaning of all chips is recommended after the last analysis of the day is complete.

4.5.10Periodic Maintenance
Operate the peristaltic pump, so that the operation prevents the pump from performance decrement when 
the instrument is out of use for an extended period (for 1 month or more). See "7.3.3 Peristaltic Pump 
Storage" P.239.

Probe rinsing solution

Reagent Holder

Rinse port

Menu Item Explanation
Chip 1 - Chip 4 Rinse each microchip with chip cleaning solution.
All Chips Rinse all microchips with chip cleaning solution.
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4.6 Analysis Menu

4.6.1 Start
Start a registered analysis schedule.

1 Either select [Start] on the [Analysis] menu or click the  (Start) button on the toolbar.
The [Start Analysis Schedule] window is displayed.

2 Start the analysis schedule.

1 Check the settings of operations to be performed after execution of the analysis schedule.
The setting details are the same as the "  [Analysis Schedule] Tab" in "4.5.2 Options" P.108.

2 Check the displayed message.
3 Select the [Confirmed] checkbox.
4 Click the [Start] button.

• The following items are checked automatically when analysis starts. If an error occurs during the 
automatic checks, perform appropriate measures according to the displayed error message. See "8.2.1 
MultiNA Control Software" P.244 for more details.

• Do NOT leave the instrument unattended until the check is complete and the analysis starts.

Check Item Explanation

Control power 
supply unit

Check the voltage.

Top cover/chip 
cover open/close

An error message is displayed if the top cover or chip cover are open. Close the top 
cover or chip cover and restart the analysis.

1

2

3

4
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4.6.2 Stop
Selecting [Stop] from the [Analysis] menu or clicking [Stop] on the toolbar stops the instrument 
automatically after post-treatment is complete, such as chip washing.

Use this menu to stop analysis.

Depending on the instrument status, one of the two messages below is displayed. 

1 Before starting sample analysis
The following message is displayed. Click [Yes] to stop analysis after completing the processes in 
progress. 

2 During sample analysis
The following message is displayed. Select either [Stop after finishing analysis of current samples] or 
[Stop immediately], and click [OK]. 

• [Stop after finishing analysis of current samples]
Selecting this check box continues analysis of sample currently being analyzed or currently 
being loaded. After the analysis is completed, rinsing of the microchip and sample probe is 
automatically executed, and the operation is ended. 

• [Stop immediately]
Selecting this check box immediately stops analysis even if a sample is currently being 
analyzed. Rinsing of the microchip and sample probe is then automatically executed, and 
operation ends. 

Samples currently in loading or analysis have a data file prepared for partway through the 
analysis. 

Sample holder 
conditions

Checked using the contact detection function of the sample probe.
An error message is displayed if the sample holder is not correctly installed. Install the 
sample holder correctly and restart the analysis.

Microchip in position Checked using the contact detection function of the sample probe.
An error message is displayed if a microchip is not installed at the specified chip 
position or if a microchip is not attached correctly. Correctly install the microchip in the 
specified position and restart the analysis.

Amount of 
remaining reagent

Checked using the liquid level detection function of the sample probe.
An error message is displayed if the residual reagent amount is insufficient.
Prepare the required amount of reagent and then restart the analysis.

Chip temperature The temperature of the chip stage is checked.
If the temperature is outside the set temperature range, analysis starts automatically 
after the temperature comes within the set temperature range.

Check Item Explanation
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4.7 Help Menu

4.7.1 Manual
Select the menu below to display the PDF files for the corresponding instruction manuals. 

Adobe® Reader® distributed by Adobe Systems Co. or other PDF file viewing software (provided free) is 
required to view the PDF file. Adobe® Reader® (Ver. 4 or later) can be downloaded from the following 
website:

http://www.adobe.com/products/acrobat/readstep2.html

4.7.2 Check Integrity 
This function checks whether the MultiNA program has been improperly altered. Select [Check Integrity] in 
the [Help] menu to display the [Check the Program Files] dialog box. Click [Execute].

<<Integrity Check Passed>> is displayed if no problems are encountered with the program files.

If <<Integrity Check Failed>> is displayed, as shown in the screenshot, the MultiNA program has been 
improperly altered. In this case, reinstall the MultiNA software (see "9.5 Software Installation" P.270).

Click the [Browse] button to display the details of the integrity check.

• [MultiNA Instrument Manual]: Display the Instrument Manual (Instrument, Control Software, and Data Analysis 
Software)

• [Quick Manual]: Display the Quick Manual
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4.7.3 About MultiNA
Display the version information of the MultiNA Control Software, instrument ROM, and method files.
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5MultiNA Viewer Functions

5.1 MultiNA Viewer Window 

No. Name Reference

1 Menu Bar "5.1.1 Menu Bar" P.126

2 Toolbar "5.1.2 Toolbar" P.128

3 Sample Name Tree "5.1.5 Sample Name Tree" P.129

4 Well Display "5.1.4 Well Display" P.129

5 Gel Image "5.1.6 Gel Image" P.129

6 Status Bar "5.4.3 Status Bar" P.166

7 Electropherogram (Multi) "5.1.10 Electropherogram (Multi)" P.137

8 Electropherogram (Single) "5.1.9 Electropherogram (Single)" P.135

9 Peak Table "5.1.7 Peak Table" P.133

1 2 3 4 5

7 689
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5.1.1 Menu Bar

Menu Item Outline of Function Shortcut 
Key

Reference 
Page

File Open Open a data file. Ctrl + O P.138

Close Close a data file being viewed. P.140

Save Rewrite and save a data file. Ctrl + S P.140

Save As Save a data file with a different name. P.141

Save Selected 
Data

Save only the selected data in a separate file. P.142

Search Search data files. P.144

Export Export data in CSV format. P.145

Print Print out data. Ctrl + P P.147

Print Setup Set up a printer. P.156

Data File 
Properties

Display conditions where a data file is acquired. P.156

Sample 
Properties

Display conditions where each sample data item in a data 
file is acquired. 

Alt + 
Enter

P.157

Ladder Monitor Enable or disable the ladder monitor function. P.159

Analyze As 
Ladder

Analyze the selected data as ladder. P.159

Ladder List Display and edit registered ladder information. P.161

(File Name) Reopen a file that has already been opened. 

Exit Quit the data analysis software MultiNA Viewer. P.162

Edit Copy Copy information displayed on [Gel Image], [Electropherogram], 
[Peak Table], or [RNA Report] to the clipboard. 

P.163

Save Image As Save what is displayed on [Gel image] and [Electropherogram] 
as an image file.

P.164

View Refresh Reopen a data file. F5 P.165

Marker Switch between hide and display marker peak sign. P.166

Status Bar Switch between hide and display the status bar. P.166

Title Tool tip displayed in the upper right area of 
[Electropherogram (Single)] and at the top of [Gel Image].

P.167

Analyzed Data / 
Raw Data

Switch between analyzed data and raw data. P.167

Normal Sensitivity 
Data / Low 
Sensitivity Data

Switch between normal sensitivity data and low sensitivity 
data. 

P.168

Comparison Display multiple data files for comparison. P.169

Size Calibration 
Curve

Display the size calibration curve used for data analysis. P.173

Analysis 
Performance 
Check Result

Display the results of analysis performance check. P.173

Ladder Monitor 
Result

Display the ladder monitor results. P.173
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View Select Ladder 
Used for Analysis

Select and display the ladder used to analyze the focused 
sample. 

P.174

Select All Samples 
Analyzed Using 
This Ladder

Select and display the samples analyzed using the focused 
ladder.

P.174

Options Set options for items to be displayed or scale. P.175

Gel 
Image

Invert Black and 
White

Switch black and white highlighting. P.177

Vertical Axis Select the image to be displayed on the vertical axis from 
among [Distance Image], [Size Image], or [Time Image].

P.177

Gel Image List Display the [Gel Image List] window. P.178

Undo Zoom Undo the last zooming operation on [Gel Image]. Ctrl + Z P.179

Undo Zoom All Undo all zooming operations on [Gel Image]. Ctrl + R P.179

Electro-
phero-
gram

Peak Top Select the item displayed at the top of the peak. P.180

Font Size Select size of text displayed at the top of the peak. P.180

Show Baseline Switch between show and hide baseline. P.180

Horizontal Axis Switch the item to be displayed on the vertical axis from 
among [Migration Index], [Size], or [Migration Time].

P.181

Overlay Switch between [Ascending Order] and [Descending Order] 
for displaying overlays. 

P.181

Undo Zoom Undo the last zooming, enlargement, and pan operations on 
[Electropherogram].

P.181

Undo Zoom All Undo all zooming, enlargement, and pan operations on 
[Electropherogram].

P.181

Reanal-
ysis

Automatic Reanalyze all data by automatic operation. P.182

Manual Edit Mode Switch to the mode where addition or deletion of peaks or 
attribution of peaks are manually edited. 

P.185

Change Ladder 
and Analyze

Reanalyze with a different ladder data. P.189

Help Quick Manual Display the analysis operation flow. F1 P.195

MultiNA 
Instruction 
Manual

Display the Instrument Manual (system, control software, 
and data analysis software).

About MultiNA 
Viewer

Display the version information of the program. P.195

Menu Item Outline of Function Shortcut 
Key

Reference 
Page
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5.1.2 Toolbar

5.1.3 Focused Data and Selected Data

• "To focus" refers to the operation of clicking the well display, sample name tree, gel image, or data displayed 
on the multi electropherogram. Focused data (or data in focus) is enclosed in a red frame.

• "To select" refers to the operation of clicking check boxes displayed in the gel image or on the multi 
electropherogram. Check marks are displayed for selected data. Multiple data entries can be selected.

No. Explanation

1 [Open existing data file] ([File] menu - [Open]):
Open an existing data file (*.MLT). 

2 [Print active data file] ([File] menu - [Print]):
Display the [Print] dialog box and start printing.

3 [View Gel Image List]:
Display the gel image list. There are three types of layouts available to display the gel image list, 12-well unit, 
8-well unit, or sort by chip position. The list is displayed in a layout previously displayed by selecting the [Gel 
Image List] on the [Gel Image] menu.

4 [Data file name] list box:
Display the name of the data file currently open. When multiple files are loaded, click the downward arrow on 
the right to select a data file to be displayed.

5 [Open active data file] ([File] menu - [Close]):
Close the currently displayed data file.

6 Clicking the [Add to Comparison] button changes the mouse pointer display over the gel image. Data can be 
continuously added to the [Comparison] view ("5.4.7 Comparison" P.169) by clicking on the gel image with 
this mouse pointer. Click the [Add to Comparison] button again to return the mouse pointer to its original state.

1 2 3 4
5

6

6

Focused data

Selected data
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5.1.4 Well Display

• Samples analyses that completed normally are displayed in blue. If a 
"Warning" occurred during the analysis, the sample is displayed in 
yellow. If an "Error" or "Fatal" error occurred during the analysis, the 
sample is displayed in red.

• Click a colored well to focus on that sample. The data on the [Gel Image] 
and [Electropherogram (Multi)] is outlined in red. The applicable data is 
displayed for [Electropherogram (Single)].

5.1.5 Sample Name Tree

• Click the [Sample Name] tab to display the [Sample Name Tree].
• The original file name (one used to save the sample sheet) is displayed 

at the top of the tree. The name remains the same even if the file is 
saved with a different name.

• Analysis order (number), well, and sample name are displayed under 
the original file name. The (number) indicates the order that analysis 
was performed in the sample sheet.

• The well and sample name were entered on the sample sheet.
• Click a sample name to focus on that sample. The data on the [Gel 

Image] and [Electropherogram (Multi)] is outlined in red. The applicable 
data is displayed for [Electropherogram (Single)].

5.1.6 Gel Image

• Click a desired piece of [Gel Image] to focus on that sample. The corresponding [Electropherogram] is 
displayed. 

• The upper tab of the [Gel Image] is gray for sample data and pale green for ladder data.
• For DNA analysis, [Gel Image] ([Analyzed Data]) is displayed so that the position of the lower marker (LM) 

and upper marker (UM) align. For RNA analysis, it is displayed so that the position of the lower marker (LM) 
and the end of electrophoretic data align.
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No. Explanation

1 Click the check box. The respective data becomes "selected data." 

2 Indicates a well name. More than one analysis can be performed from the extra sample stand and analysis 
order is displayed below the well name. 

3 The "#" mark and chip position (1 to 4) is displayed above the check box of the ladder data used for 
analysis.

4 Size axis. (It is based on the position of fragment peaks in the ladder data.)

5 Click the red cursor button to display the knob (6) and a red horizontal line on the gel image. When [Size 
Image] is selected for the gel image vertical axis, an estimated size value for the position of the red line is also 
displayed under the button.

6 Drag the knob up or down to move the red line.

7 Drag the knob up or down to adjust color contrast of [Gel Image]. While dragging the knob, the color contrast 
adjustment is applied only to the focused data. After adjustment, the color contrast is applied to all of the data 
displayed. 

5

4

6

3

7

1
2
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An example of selected check boxes on the [Gel Image] is displayed below.

• If the check mark is cleared from a selected data when [Show Selected] is selected, the respective data 
disappears from [Gel Image] because the data is no longer selected.

• If the check mark is cleared from all of the displayed data and [Show Selected] is selected, the display 
state automatically changes to [Show All].

No. Explanation

1 [Show All] is selected in the initial display. All data (with and without a check mark) is displayed. 

2 Select [Show Selected] to display only the data that is selected with a check mark. This button is enabled 
when at least one data item is selected with a check mark.

3 Click [Select All] to select all of the data in a data file with check marks. 

4 Click [Reverse] to switch between the selected and non-selected data.

5 Click [Clear All] to remove the check marks from all of the samples.

6 A small color bar is displayed at the top of the gel image for the selected data. The color of the bar 
corresponds to the color in the [Electropherogram] overlay (see "5.1.9 Electropherogram (Single)" P.135). 

6

1 2 3 4 5
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Zooming of [Gel Image]

• Select an area by dragging the mouse and then releasing it. While dragging the mouse up or down on [Gel 
Image], red lines are displayed at the starting and ending points of the area to be enlarged.

• To return to the original display, select [Undo Zoom]/[Undo Zoom All] on the [Gel Image] menu or use the 
right click pop-up menu.

• When the display range on [Gel Image] is changed, the display range of the horizontal axis of 
[Electropherogram (Single)] is scaled to the same. 

• To return to the original display in [Electropherogram (Single)], select [Undo Zoom]/[Undo Zoom All] on the 
[Electropherogram] menu or right click pop-up menu on [Electropherogram (Single)].

Example of [Gel Image] Zooming In
 (Left: Before Zooming In, Center: While Specifying the Range, Right: After Zooming In)

[Electropherogram] Zoomed In
 (Top: Before Zooming in, Bottom: After Zooming In)
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[Gel Image] Right-Click Pop-up Menu

5.1.7 Peak Table
 

• The peak table of the focused data is displayed.
• (LM) represents the lower marker peak and (UM) represents the upper 

marker peak.
• To customize Items displayed on the columns, select [Options] on the 

[View] menu. (see "5.4.13 Options" P.175)
• Double-click a cell in the [Peak Table] or a peak to apply a "*" mark next 

to the peak no. and cause the corresponding peak top information on 
[Electropherogram] to be displayed in red.

• Double-click the cell with the "*" mark next to the peak number again to 
remove the mark and return to it to its original display.

• The size value is displayed in red if the peak size of the user ladder (see 
"5.2.13 Analyze As Ladder" P.159, "11.8 User Ladders" P.295) is outside 
the specifications for separation.

Menu Explanation Reference 
Page

Undo Zoom Undo the last zooming operation on [Gel Image]. P.179

Undo Zoom All Undo all zooming operations on [Gel Image] to recover the initial display 
state.

P.179

Copy Copy the image data displayed on [Gel Image] to the clipboard. (Or select 
[Copy] on the [Edit] menu and select [Gel Image].)

P.163

Copy Gel Image Only Only copy the gel image to the clipboard. (This performs the same action 
as selecting [Copy] - [Gel Image Only] from the [Edit] menu.)

P.163

Save Image As Save the image data displayed on [Gel Image] to a file. (Or select [Save 
Image As] on the [Edit] menu and select [Gel Image].)

P.164

Save Gel Image Only As Only save the gel image to file. (This performs the same action as 
selecting [Save Image As] - [Gel Image Only] from the [Edit] menu.)

P.164

Add Focused Data to 
Comparison

Add focused data to the [Comparison] view. P.169

Add All Selected Data to 
Comparison

Add all selected data (ones with a check mark) to the [Comparison] view.

Delete Focused Data from 
Comparison

Delete focused data from the [Comparison] view.

Delete All Selected Data 
from Comparison

Delete all selected data (ones with a check mark) from the [Comparison] 
view.

Select Ladder Used for 
Analysis

Select and display ladder data used for analyzing the focused sample and 
the sample data.

P.174

Select All Samples 
Analyzed Using This 
Ladder

Select and display sample data analyzed using the focused ladder and 
the ladder.

P.174

Sample Properties Display properties for acquiring data of each sample. P.157
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[Peak Table] Right-Click Pop-up Menu

5.1.8 RNA Report

• For RNA analysis data, the [RNA Report] tab is displayed. The following 
items are displayed.

Total RNA: [Total Area], [Total Conc.], [Ratio of 28S/18S rRNA]

mRNA: [Total Area], [Total Conc.]

• Although peaks other than 18s rRNA and 28S rRNA are not displayed in 
the RNA electropherogram, the area and concentration of all RNA peaks 
are calculated.

[RNA Report] Right-Click Pop-up Menu

Menu Explanation Reference 
Page

Copy Selected Cells Copy the data selected in [Peak Table] to the clipboard. P.163

Set to Lower Marker Set the peak right-clicked in [Peak Table] as the lower marker when 
[Manual Edit Mode] is selected on the [Reanalysis] menu.

P.185

Set to Upper Marker Set the peak right-clicked in [Peak Table] as the upper marker when 
[Manual Edit Mode] is selected on the [Reanalysis] menu.

Set to 18S rRNA Set the peak right-clicked in [Peak Table] as 18S rRNA in the case of RNA 
sample (total RNA) when [Manual Edit Mode] is selected on the 
[Reanalysis] menu.

Set to 28S rRNA Set the peak right-clicked in [Peak Table] as 28S rRNA in the case of RNA 
sample (total RNA) when [Manual Edit Mode] is selected on the 
[Reanalysis] menu.

Delete Peak Delete the peak right-clicked in [Peak Table] when [Manual Edit Mode] is 
selected on the [Reanalysis] menu.

Menu Explanation Reference 
Page

Copy Selected Cells Copy the data selected in [Peak Table] to the clipboard. P.163
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5.1.9 Electropherogram (Single)

No. Explanation

1 [Rectangle Zoom] (default setting):
Click to start the [Rectangle Zoom] mode.
Drag the rectangular box in the graph to zoom in on the area surrounded by the box.
To return the display to its original state, select [Undo Zoom] or [Undo Zoom All] on the [Electropherogram] 
menu or right-click pop-up menu. 

2 [Horizontal/Vertical Zoom]:
Click to start the [Horizontal/Vertical Zoom] mode.
Drag the mouse vertically or horizontally. The selected area is zoomed in or out in the respective direction 
according to the dragged distance. 
To return the display to its original state, select [Undo Zoom] or [Undo Zoom All] on the [Electropherogram] 
menu or right-click pop-up menu. 

3 [Pan]:
Click to start the [Pan] mode.
Drag the mouse in a desired direction in the graph to move the displayed range in that direction.
To return the display to its original state, select [Undo Zoom] or [Undo Zoom All] on the [Electropherogram] 
menu or right-click pop-up menu. 

4 [Manual Edit Mode]:
Click to switch ON/OFF of manual editing of analysis results.
(This operation is also available by selecting [Manual Edit Mode] on the [Reanalysis] menu.) (See "5.7.2 
Manual Edit Mode" P.185.)

5 [Overlay]:
Click to start the [Overlay] mode, and selected data and focused data are overlaid.
[Ascending Order] / [Descending Order] display setting is specified by selecting the [Electropherogram] 
menu and pointing to [Overlay].

6
Next 
figure

[Slider]: (Displayed when data is overlaid.)
Drag the slider to adjust the width to display overlaid data that is off vertically. 
Focused data is displayed on the bottom.

1
2
3

4

5
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• The vertical axis of the analyzed data indicates signal strength (with background removed).
• Raw data can be displayed by selecting [Raw data] on the [View] menu. In this case, the horizontal axis 

indicates migration time and the vertical axis indicates signal strength.
• The information displayed at the top of the peak can be selected from [Peak Top] on the [Electropherogram] 

menu.
• Select [Show Baseline] from the [Electropherogram] menu to display the baseline and vertical peak parting 

line.
• Double-clicking near a peak changes the top of the peak to red and displays a "*" mark next to the 

corresponding peak number in the peak table.
• Double-click the peak with the "*" mark to remove the mark and recover the original display.

6
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[Electropherogram (Single)] Right-Click Pop-up Menu

5.1.10Electropherogram (Multi)

• Click the [Multi] tab to display multiple electropherograms.
• If the check box on the upper right of an electropherogram is selected, the data becomes "selected data." 

(Or select the check box on [Gel Image].) 

Menu Explanation Reference 
Page

Undo Zoom Undo the previous zooming or pan operation on [Electropherogram]. P.181

Undo Zoom All Undo all zooming or pan operations on [Electropherogram] to recover the 
initial display state.

P.181

Copy Copy image data of [Electropherogram] to the clipboard. (Alternatively, on 
the [Edit] menu, select [Copy] and point to [Electropherogram].)

P.163

Save Image As Saves the image data displayed on [Electropherogram] to a file. 
(Alternatively, select [Save Image As] on the [Edit] menu and select 
[Electropherogram].)

P.164

Set to Lower Marker When there is a peak near the cursor where the mouse is right-clicked in 
the Manual Edit mode, the peak is set as the lower marker. When there is 
no peak near the cursor, a peak for the lower marker is added.

P.185

Set to Upper Marker When there is a peak near the cursor where the mouse is right-clicked in 
the Manual Edit mode, the peak is set as the upper marker. When there is 
no peak near the cursor, a peak for the upper marker is added.

Set to 18S rRNA When there is a peak near the cursor where the mouse is right-clicked in 
the Manual Edit mode, the peak is set as 18S rRNA. When there is no 
peak near the cursor, a peak for 18S rRNA is added.

Set to 28S rRNA When there is a peak near the cursor where the mouse is right-clicked in 
the Manual Edit mode, the peak is set as 28S rRNA. When there is no 
peak near the cursor, a peak for 28S rRNA is added.

Add Peak In the Manual Edit mode, the peak closest to the cursor where the mouse 
is right-clicked is detected and added. 

Delete Peak In the Manual Edit mode, peaks near the cursor are deleted when the 
mouse is right-clicked.
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5.2 File Menu

5.2.1 Open

1 Select [Open] on the [File] menu or click  (Open existing data file) at the left end of 
the toolbar.
The [Open] dialog box is displayed.

2 Either select a data file and click [Open] or double-click on a file.

The data file is opened.
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• Data files are saved in a folder named with the project name used for analysis.
When a data file (extension: MLT) is selected, the content of the data file is displayed as preview 
(project name, separation buffer used, marker mix mode, data file comment, sample name tree, 
and gel image).

• A data folder contains two files: a raw data file (extension: .MLT) and analyzed data file 
(extension: .MLA). When [Open] is selected on the [File] menu, only a raw data file (extension: 
.MLT) is displayed. When this file is opened, the analyzed data file is also loaded and 
automatically displayed. 

• Two or more files can be loaded by repeatedly selecting [Open] on the [File] menu. Switch the file 
to be displayed on the File Name list box on the toolbar (see "5.1.2 Toolbar" P.128). 

• Data files can be opened by double-clicking them on "Windows Explorer" (single-clicking in some 
settings on Windows). They can also be opened by dragging and dropping to the [MultiNA 
Viewer] window from Explorer. 

If multiple iterations of the MultiNA Viewer are open, the following message is displayed when an 
attempt is made to open a data file that is already open in one of the other iterations.

• [OK]: Opens the file in read-only mode. 
Reanalysis (automatic, manual edit or ladder change) is disabled.

• [Cancel]: Stops the open file process.

If only raw data (no analyzed data) exists in the folder, the following message is displayed and only 
raw data is opened. This occurs when the analyzed data file has been deleted or moved to a 
different folder.

In this case, select [Automatic] from the [Reanalysis] menu to perform analysis again. The analyzed 
data is then created and displayed. (See "5.7.1 Automatic" P.182.)

The following message is displayed when there is no ladder data selected for analysis. 

In this case, select [Change Ladder and Analyze] on the [Reanalysis] menu and add ladder data 
(see "5.7.3 Change Ladder and Analyze" P.189).
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In the following cases, data files are opened in the read-only mode and "(Read only)" is displayed at 
the end of the file name on the window title and the file selection drop-down list box.

• When the specified file is currently being acquired in the MultiNA Control Software

• When [Comparison View] is displayed

The following message is displayed when a file, being analyzed by the instrument, is opened or 
updated by a PC with insufficient memory.

Click [OK] and close other applications or close the other files open in the MultiNA Viewer then 
repeat the operation.

If this memory error appears frequently, a PC memory upgrade is recommended.

5.2.2 Close
Select [Close] to close the file currently being displayed.

(Alternatively, click  (Close) under the toolbar.)

The following message is displayed when the results were not saved after editing using [Manual Edit Mode] 
on the [Reanalysis] menu or [Change Ladder and Analyze] on the [Reanalysis] menu.

 

• Click [Yes] to save and close the window.

• Click [No] to close the window without saving.

• Click [Cancel] to cancel the close operation.

5.2.3 Save
Select [Save] to overwrite an analyzed data file that has been changed.

Analyzed data can be changed and saved in the following cases.
• Manually edit the file using [Manual Edit Mode] on the [Reanalysis] menu.
• Reanalyze the file using [Change Ladder and Analyze] on the [Reanalysis] menu.
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5.2.4 Save As
Select [Save As] to save a data file with a new name.

Raw and analyzed data are saved with different names at the same time.

1 Select [Save As] on the [File] menu. 
The [Save As] dialog box is displayed.

2 Enter a new file name in the [File name] box and click [Save]. 

The data file (raw and analyzed data) is saved with the new name. 
(/\<>:"|?* cannot be used for a file name.)

Although the data file is saved with the new name, the data file name given when the sample sheet 
was created is kept in the data file as "Original data file name." "Original data file name" is displayed 
on the top 2 of [Sample Name Tree]. (1 is displayed by the new name.) 

2

1
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The following message is displayed if an attempt is made to save the file using a previously used file 
name.

• Click [Yes] to overwrite the existing file.

• Click [No] to return to the current window without saving.

When [Yes] is clicked and the applicable file is open on Viewer window, the following message is 
displayed. In this case, the file cannot be saved with the specified name. Click [OK] and enter a 
different file name to save.

5.2.5 Saving Selected Data
Save selected data to a separate file. 

1 Select data (sample) to be saved in a different file with a check mark on a gel image (or 
an electropherogram (multi)).
Ladders used for sample analysis are automatically saved. Therefore, they do not need to be selected 
with a check mark.

2 Select [Save Selected Data] on the [File] menu.
The [Save As] dialog box is displayed.
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3 Enter a new file name in the [File name] box and click [Save].

By default, the new file name has "~" and numbers at the end of the original data file name.

The saved file is automatically loaded and displayed.
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5.2.6 Search
Select [Search] to search data files in a specified folder with specific screening conditions such as data file 
names, keywords, or date analysis started.

1 Select [Search] on the [File] menu. 
The [Search] dialog box is displayed.

2 Enter or select search conditions.

• "AND" is applied to each condition entered in search fields. 
• Only one target keyword can be used for searching. Select at least one search field from [Original data 

file], [Data file comment], [Sample name], and [Comment]. 
• To search by specifying a project name, select a project name from the combo box below [Project 

Name] or enter a project name (or part of it). Select <Any> when not specifying any name. 
• To specify [Date Analysis Started], select the range of date analysis started from the list in the combo 

box ([Today], [Within the last week], [Within the last 30 days], [Within the last 90 days]) or select 
[Custom] and then specify the start and end of the time range. 

• To search by specifying a folder, select the folder from the combo box or enter the folder name. Click 
<Browse…> from the list in the combo box. The [Select Folder] dialog box is displayed and a folder 
can be selected.

[Date Analysis Started] represents date and time where analysis of each data saved in MLT files 
started (see "5.4.3 Status Bar" P.166). It may be different from the time when the file was updated. 

Item Explanation

[Data file name] Enter all or part of a data file name.

[A Word in the File] Enter a keyword for searching in selected search fields.

[Project Name] Select or enter a project name. 

[Date Analysis Started] Select the date when analysis started.

[Folder] Select or enter a target folder.
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3 Click [Search].

Searching starts.
Extracted data files are displayed on the list to the right with information such as data file name and date 
analysis started. 
Click a file name to display the preview of gel image and sample names. 

Click [Stop] to stop searching.

4 Select a file and click [Open].

The data is loaded.

• Data can also be loaded by double-clicking on the file name.

• Only one data file can be selected or loaded at a time.

5.2.7 Export
Select [Export] to export sample sheet or peak table as a CSV format file.

1 Select data to be exported by selecting the respective check box on [Gel Image] (or 
[Electropherogram (Multi)]). 
When exporting all data, data selection is unnecessary. 

2 Select [Export] on the [File] menu. 
The [Export] dialog box is displayed.
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3 Specify items, range, and delimiter to be exported.

4 Click the arrow facing downward on the right side of items.

A drop-down list is displayed.

Item Explanation

[Export Item]

[Sample Sheet] Well name, sample name, comment, chip ID, date analysis started, etc.

[Peak Table] Peak table of sample data (size, concentration, height, time, area, etc.)

[RNA Report] Total area, total concentration, and 28S rRNA/18S rRNA ratio for RNA sample 
(total RNA analysis only)

[Analyzed Data] Index, migration time index/size/time, and signal strength of the data in the 
analyzed data

[Raw Data] Time and signal strength at each data point in raw data

[Current] Time and current on four electrodes of a microchip at each data point 

[Voltage] Time and voltage on four electrodes of a microchip at each data point 

[Sample Range]

[All] All data in the data file

[Selected] Selected data with a check mark on [Gel Image] (or [Electropherogram (Multi)])

[Delimiter]

[Comma] Data items are separated by commas.

[Tab] Data items are separated by tabs and enclosed by double quotation marks.
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5 Select necessary detailed items with a check mark and click [Export].

The [Save As] dialog box is displayed.

When [Analyzed Data] is selected, the exported data depends on the horizontal axis selected for the 
electropherogram.

6 Enter a file name and click [Save].

7 Return to step 3 to continue exporting other information. Click [Close] in the [Export] 
dialog box if exporting is complete.
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5.2.8 Print
Select [Print] from the [File] menu to print data.

Printing Procedure

1 Select the data to be printed.

This process is unnecessary when printing all data.

2 Select [Print] on the [File] menu or click  [Print active data file] on the toolbar.
The [Print] dialog box is displayed.

3  Select a layout for printing.

1 Click a "+" mark displayed with printing layouts at the left. The items to be printed such as sample 
sheet and gel image are displayed under each printing layout category. 

2 Check the items to be printed. The image of the respective layout is displayed in the right field of the 
dialog box. 

3 Click [Page Setup] to set paper size, orientation, page margins, and other items.
A logo can be printed by specifying the file name of a bitmap for [Logo].

1, 2

3
Layout image
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4 Select the items and range for printing.

1 Select the items to be printed.
[Preview] and [Print] are enabled. 

2 Select [All] to print all of the data in the file or [Selected] to print only the selected data.
The range of the data for printing is set.

3 Click [Preview] to review the print image and determine the number of pages.

5 Click [Print] in the [Print] window or [Print Preview] window.

The data is printed.

The settings in displayed windows are reflected in printing for the following items. Check the settings 
in displayed windows before printing.

• For the data that fails in analysis, even if [Size Image] is selected for the gel image vertical axis, 
the distance image is printed.

• For the data that fails in analysis, even if [Size] is selected for the electropherogram horizontal 
axis, the electropherogram with migration index is printed.

3

2

1
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Matters Reflected in Printing Settings in Windows Displayed Reference 
Page

• Both Gel Image and Electropherogram

Selection between [Analyzed Data] / [Raw 
Data]

[View] menu - [Analyzed Data] / [Raw 
Data]

P.167

Scale [View] menu - [Options] - [Scale of 
Default View]

P.175

• Gel Image

Selection of inversion of black and white [Gel Image] menu - [Invert Black and 
White]

P.177

Brightness adjustment Slider at the right of [Gel Image] P.129

Selection of [Distance Image] / [Size Image] / 
[Time Image]

[Gel Image] menu - [Vertical Axis] - 
[Distance Image] / [Size Image] / [Time 
Image]

P.181

• Electropherogram (whole)

Show or hide baseline [Electropherogram] menu - [Show 
Baseline]

P.180

Selection of [Migration Index] / [Size] / 
[Migration Time]

[Electropherogram Menu] menu - 
[Horizontal Axis] - [Migration Index] / 
[Size] / [Migration Time]

P.181

• Electropherogram (single)

Show or hide marker signs [View] menu - [Marker] P.166

Peak top item [Electropherogram] menu - [Peak Top] P.180

Title items [View] menu - [Title] P.167

•  Analysis result (excluding 12 samples/page layout)

Selection of items on the peak table [View] menu - [Options] - [Peak Table] P.133

• Overlaying selected data

Width to make overlaid data vertically off Slider during overlaying on 
[Electropherogram (Single)]

P.135
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Print Layout
Available print layouts are shown in the table below. Layout diagrams are shown assuming that printing is 
carried out vertically. The layout is changed when printing horizontally.

Layout Category Printed Subjects Explanation

[All Samples/Page] Gel Image Gel images for all samples are printed on a single page. Data 
file properties are also printed.

[120 Samples/Page] Sample sheets A sample sheet containing up to 120 samples is printed on a 
page. Data file properties and chip and ladder information are 
also printed.

Gel Image Gel images for up to 120 samples are printed on a page. Data 
file properties and chip and ladder information are also 
printed.
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[24 Samples/Page] Sample sheet, gel image A sample sheet and gel images for up to 24 samples are 
printed on a page. Data file properties and chip and ladder 
information are also printed.

(Among the ladders displayed, the ladder used for the first 
analysis is printed.)

[12 Samples/Page] Electropherogram, gel 
image

Electropherograms and gel images for up to 12 samples are 
printed on a page. Data file properties, chip and ladder 
information, and sample sheets are also printed.
 

Analysis result, gel 
image

Analysis results for up to 12 samples are printed on a page. 
Data file properties, chip and ladder information, and sample 
sheets are also printed.
In the analysis results, the size of each peak is printed for 
DNA analysis, and the RNA report contents and concentration 
of each peak are printed for RNA analysis.
For one analysis, up to 60 lines of data can be printed.
 

Layout Category Printed Subjects Explanation
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• Imported ladder data is not printed except for "Chip and Ladder Information" (see "5.7.3 Change Ladder 
and Analyze" P.189).

• For printing [Comparison View], "1 sample/page" layout cannot be used. Some displayed contents are 
different from ones of ordinary data files (see "5.4.7 Comparison" P.169).

[1 Sample/Page] Electropherogram, 
analysis result 

An electropherogram and analysis result for one sample are 
printed on a single page. Data file properties, chip and ladder 
information, and sample sheets are also printed.
More than one page may be used if the analysis result display 
will not fit on a single page.
 

[Overlay Selected Data] Electropherogram Electropherograms of selected data and focused data are 
printed overlaid. Sample sheets are also printed.

[Others] All analysis results Analysis results for all data to be printed are printed.
 

Layout Category Printed Subjects Explanation



5  MultiNA Viewer Functions

154   MultiNA Instruction Manual

Contents Printed

Data File Properties

Properties such as data acquisition date and conditions set for the instrument are printed. 

If a large number of characteristics are selected for each item, all of the information may not be printed. 
(Printable range differs according to the printing conditions such as paper size and margin.)

Chip and Ladder Information

Microchip ID, number of uses (analysis schedule starting point), no., well, and electropherogram for the 
ladder used is printed for each chip position.

Sample Sheet

The sample sheet is printed (no., well, sample name, comment, type, and microchip position).

A "#" mark is added on the left of the chip position number to indicate the ladder used for analysis.

If a large number of characteristics are selected for each item, all of the information may not be printed. 
(Printable range differs according to the printing conditions such as paper size and margin.)
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Gel Image

There are four types of gel images; for analyzed data (distance image), for analyzed data (size image), for 
analyzed data (time image), and for raw data.

[Ladder] (the ladder used for the first analysis among ladder data displayed in Gel Image) is added to the 
left end of each gel image. A size scale can be marked according to the band of this ladder.

Contrast is adjusted by the slider on the right end in the [Gel Image] window (see "5.1.6 Gel Image" P.129). 

Electropherogram

There are four types of electropherograms; analyzed data (migration index), analyzed data (size), 
analyzed data (migration time), and raw data.

The (number), well, and sample name are printed at the top of each electropherogram. The 
electropherogram settings in [View] - [Options] are reflected on the vertical scale.

Results Table: DNA analysis

In the [12 samples/page] layout, (number), well, and predicted size of each peak are printed.

In the [1 sample/page and all results table] layout, (number), well, and items selected in [Options] on the 
[View] menu are printed.

Results Table: RNA analysis

In the [12 samples/page] layout, (number), well, concentration of each peak, and contents of RNA report 
(total area, total concentration, and the 28S rRNA/18S rRNA ratio for total RNA) are printed.

In the [1 sample/page and all results table] layout, (number), well, and items selected on [Options] on the 
[View] menu are printed. 

Overlay Selected Data

On sample sheet, data file names, (numbers), wells, sample names, comments, types, and chip positions 
of overlaid data.
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5.2.9 Print Setup
The [Print Setup] dialog box is displayed. Select a printer and set the printer properties such as paper size 
and orientation.

5.2.10Data File Properties
Select [Data File Properties] to display the instrument conditions when a data file was acquired.

• Click [Copy All] to copy all of the displayed contents to the clipboard.
• Select cells, lines, or columns and then right-click and select [Copy Selected Cells] to copy the selected cells 

to the clipboard.
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5.2.11Sample Properties
Select [Sample Properties] to display all of the information in the file such as the conditions when the data 
was acquired.

• Click [Copy All] to copy all of the displayed contents to the clipboard.
• Select cells, lines, or columns and then right-click and select [Copy Selected Cells] to copy the selected cells 

to the clipboard.

1 On the [File] menu, click [Sample Properties] or click [Sample Properties] on the right-
click pop-up menu displayed on the gel image. 
The [Sample Properties] window is displayed.

2 Double-click the sample name or comment box to be edited. 

A cursor appears and the contents can be edited.
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3 Edit the contents and then click [OK].

This confirms the edited contents and closes the window.
Clicking [Cancel] aborts any editing changes made. 

4 On the [File] menu, select [Save] or [Save As] to save the file. 

The message below is displayed when an attempt is made to close a data file without saving the 
changes. 

• Click [Yes] to save the changes in the initial data file.

• Click [No] to cancel the changes.

• Click [Cancel] to stop the closing process.
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5.2.12Ladder Monitor
The ladder monitor function monitors information including the current value and baseline of ladder data 
contained in a data file when the file is opened and automatically displays the results of any warnings that 
occurred.

• Enable this function by selecting [Ladder Monitor] from the [File] menu. A check mark appears in the menu 
when the function is enabled.

• Items with warnings are marked.

The ladder monitor only monitors standard ladders and a DNA-1000 option ladder. Other ladders cannot be 
used with the ladder monitor function.

Ladder data marked with a warning sign (*) may indicate low analysis accuracy. Use the 
electropherogram to check that peaks are being detected correctly.

• Warning signs do not always mean that a problem exists with microchips or the instrument.

• If warning signs appear frequently, perform the procedure described in "6.2 Daily Maintenance" 
P.199.

5.2.13Analyze As Ladder
Ladders that satisfy predetermined conditions can be used as user ladders in DNA analysis (see "11.8 
User Ladders" P.295).
User ladder registration is performed according to the procedure described below. Once registration is 
complete, user ladders can be selected during project registration.

Items with warnings 
are marked.
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RNA data cannot be targeted by user ladders. The [Analyze As Ladder] function cannot be used in the 
following situations.

• When displaying the [Comparison] view, [Manual Edit Mode], or [Low Sensitivity Data].

• When [Analyze As Ladder] or [Ladder List] are already executed in another instance of the data analysis 
software running on the same PC.

1 Migrate user ladders as samples in the first migration.

^ Reference
"11.8 User Ladders" P.295

2 Open the data file in the MultiNA Viewer. Click the check box of the sample to be defined 
as the user ladder on the gel image.

3 Select [Analyze As Ladder] from the [File] menu.
The [Analyze As Ladder] window is displayed.

The following message is displayed if all ladders contained in the data file are not selected.

• Click [OK] to set all ladders for analysis.

4 Enter the required ladder information on the [New Ladder] tab.

Select the target sample.

Item Explanation
Ladder name Enter a name for the ladder. Up to 30 characters can be entered.
Abbreviation Enter an abbreviation for the ladder. Up to 3 characters can be entered.
Size (bp) Enter a peak size. Only ladders with three or more peaks can be used.
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5 Click the [Analyze] button.

• If the new ladder does not satisfy any of the ladder conditions, reenter any of the above 
information according to the displayed message.

• If the input size is outside the specifications for separation, an analysis confirmation message is 
displayed. Click [Yes] to proceed with the analysis anyway.

6 Once analysis is complete, check that peaks of the corresponding size were correctly 
detected on the electropherogram and that the size calibration curve is acceptable. (See 
"5.4.8 Size Calibration Curve" P.173.)

The [Point To Point] setting is applied to the size calibration curve of user ladders.

7 Click [Register] if the ladder is acceptable for use.
A confirmation message for ladder registration is displayed. Click [Yes] to register the user ladder and 
perform reanalysis.

5.2.14Ladder List
The ladder list is used for checking registered ladders and editing information.

This function can only be used in DNA analysis.

The [Ladder List] function cannot be used in the following situations.

• When [Analyze As Ladder] or [Ladder List] are already executed in another instance of the data analysis 
software running on the same PC.

• Ladder information used during analysis with the MultiNA cannot be edited or deleted.

1 Select [Ladder List] from the [File] menu.
The [Ladder List] window is displayed. Ladders are registered for each separation buffer.

2 Select the tab corresponding to the target separation buffer.
A list is displayed that contains the factory default ladders.
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Editing

1 Select the registered ladder for editing or referencing and click [Edit].
The [Ladder Settings] window is displayed.

2 Edit the required information and click [OK] to save the changes.

^ Reference
"5.2.13 Analyze As Ladder" P.159

Deleting
Select the ladder to delete and click [Delete].

Importing and Exporting
These functions are used to share user ladder information between multiple MultiNA instruments.
Click [Export] to output ladder information to an appropriate folder.
To load ladder information, click [Import] and select the output file shown on screen to register the user 
ladder.

The import function can only import files output using the export function.

5.2.15Exit
Click [Exit] to quit MultiNA Viewer.

The following message is displayed when the results were not saved after editing using [Manual Edit Mode] 
on the [Reanalysis] menu or [Change Ladder and Analyze] on the [Reanalysis] menu.

• Click [Yes] to save and exit.

• Click [No] to exit without saving.

• Click [Cancel] to cancel the exit operation.
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5.3 Edit Menu

5.3.1 Copy
Selecting [Gel Image], [Gel Image Only], [Electropherogram], [Peak Table], [RNA Report], (RNA analysis 
only) via the [Copy] submenu on the [Edit] menu copies the corresponding display data to the clipboard.

• [Gel Image] / [Gel Image Only] / [Electropherogram]
Image data (except for the red focus outline) is copied. 

The same result can be achieved by selecting [Copy] on the right-click pop-up menu on [Gel Image] or 
[Electropherogram]. 

If [Gel Image] is selected, each data number, well, sample name, and comment can be copied to the 
top of the gel image. Select the items to copy by clicking [View] and pointing to [Title] on the menu.

Selecting [Gel Image Only] only copies the gel image and all other information is omitted.

• [Peak table], [RNA report]
When [Copy] is selected on the [Edit] menu:

All cells including item names and line numbers are copied. 

When "Copy Selected Cells" is selected on the right-click pop-up menu:

Only selected cells are copied. Item names and line numbers are not copied. 

The [Copy] - [Electropherogram] function copies the information currently displayed on screen. Note that if a 
different window is displayed over the MultiNA Viewer window immediately after selecting the menu (within 
approx. one second), the content of the different window is copied. 
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5.3.2 Saving Images to File
On the [Edit] menu, clicking [Save Image As] and selecting [Gel Image], [Gel Image Only] or 
[Electropherogram] saves the gel image or electropherogram currently displayed as an image file. 

The same result can be achieved by selecting [Save Image As] on the right-click pop-up menu on [Gel 
Image] or [Electropherogram].

If [Gel Image] is selected, items selected by clicking [Title] on the [View] menu (number, well, sample 
name, and comments) are inserted at the top of the gel image. 

The [Save Image As] - [Electropherogram] function saves the image currently displayed on screen. Note that 
if a different window is displayed over the MultiNA Viewer window immediately after selecting the menu 
(within approx. one second), the content of the different window is saved.

1 Select [Save Image As] from the [Edit] menu and then select [Gel Image], [Gel Image 
Only], or [Electropherogram].
Alternatively, click [Save Image As] on the right click pop-up menu displayed on [Gel Image] or 
[Electropherogram].
The [Save As] window is displayed.

2 Enter a file name for [File name] and folder location for [Save in] and select a file type 
from [TIFF], [Bitmap], or [JPEG].

3 Click [Save]. 
File extensions are automatically added to file names. 
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5.4 View Menu

5.4.1 Refresh
Select [Refresh] to reload a data file and update it. Use this function to update data being analyzed.

The following message is displayed when a file, being analyzed by the instrument, is opened or updated by 
a PC with insufficient memory.

Click [OK] and close other applications or close the other files open in the MultiNA Viewer then repeat the 
operation.

If this memory error appears frequently, a PC memory upgrade is recommended.
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5.4.2 Marker
Select [Marker] to switch between display/hide the marker on [Gel Image] or [Electropherogram (Single)]. 
When the [Marker] menu is selected with a check mark (default), the lower marker (magenta line and 
triangle 1) and the upper marker (blue line and triangle 2) are displayed as shown in the figure below. 

5.4.3 Status Bar
Select [Status Bar] on the [View] menu to display or hide the status bar at the bottom of the window. The 
information displayed on the status bar pertains to the focused data and is described below.

2

1

1 2

No. Explanation

1 Project name

2 Separation buffer type (Total RNA or mRNA distinction for RNA analysis)

3 (Analysis No.) Well name:

4 Sample name: Comment

5 Date and time analysis started

6 Chip position

7 Chip ID

8 Chip use count

1 2 3 4 5 6 7 8 9
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5.4.4 Title

Items selected with checkmarks will be reflected in the following displayed or printed information. 
• Title displayed in upper right area on [Electropherogram (Single)]
• Tool tip displayed when the cursor rolls over the top (light green or gray) area of gel images 
• Information displayed in lower right area of respective overlaid electropherograms 
• Information inserted at top of gel images when they are copied or saved by clicking [Copy] or [Save Image 

As] 
• Title printed in upper right area of electropherograms by clicking [Sample] or [Page Print] 
• Information printed in lower right area of each image overlaid when printing overlays of selected data 

5.4.5 Analyzed Data/Raw Data
Analyzed data is displayed when a data file is opened. To display raw data, select [Raw Data] on the [View] 
menu.

To display analyzed data again, select [Analyzed Data] on the [View] menu.

9 Information from MultiNA Viewer (cursor position); values on vertical and horizontal axes on 
[Electropherogram (Single)] 

No. Explanation
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The migration index is a relative value of the electropherogram time axis based on the marker detection 
time. In DNA analysis, the lower marker and upper marker detection times are set to 0 % and 100 %, 
respectively. In RNA analysis, the lower marker and electropherogram end point are set to 0 % and 100 %, 
respectively. If the lower marker was not detected, the electropherogram start point is set to 0 %. In addition, 
in DNA analysis, if the upper marker was not detected, the electropherogram end point is 100 %.

5.4.6 Normal Sensitivity Data/Low Sensitivity Data
Select [Low Sensitivity Data] from the [View] menu to display low sensitivity raw data.

Item Analyzed Data Raw Data

Contents Data processed with respect to raw data 
and for which the fragment size estimation 
value and concentration are calculated

Primary data obtained during analysis 
(change in fluorescent intensity over time)

Peak table Display items: Configurable in [View] menu 
- [Options]
Area unit: mV•μm

Time (sec), height (mV) and area (mV•sec) 
(display items cannot be changed.)

Electropherogram 
horizontal axis

Migration index (%), size (bp)/(nt), migration 
time (sec)

Migration time (sec)

Electropherogram 
vertical axis

Signal intensity after baseline subtraction 
(mV)

Signal intensity before baseline subtraction 
(mV)

Gel image vertical axis Distance image, size image, time image Time

Reanalysis All items on the [Reanalysis] menu can be 
executed

[Reanalysis] - [Automatic] can be executed
[Change Ladder and Analyze] and [Manual 
Edit Mode] on the [Reanalysis] menu 
cannot be executed
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• Signal intensity of low sensitivity data is approximately half compared to normal sensitivity data.
• If signal saturation occurs on normal sensitivity data due to high sample concentration (over 50 ng/μL in DNA 

concentration), the sample may need to be diluted. Refer to the peak height obtained in low sensitivity data 
to decide how much the sample should be diluted.

• Reanalysis, print, or export is not available with low sensitivity data.
• To return the display to analyzed data, select [Normal Sensitivity Data] on the [View] menu, and select 

[Analyzed Data] on the [View] menu.

5.4.7 Comparison

Select [Comparison] to display data in different data files in one window.
• Well numbers and sample names of the samples that have been added to the [Comparison] view are 

displayed under the original data file names in the comparison sample name tree. A sequential number 
(displayed in parentheses) is added to each sample name on the view.

• Data displayed in the [Comparison] view is "read only." The [Save], [Save As], and [Reanalysis] functions are 
not enabled.

• The ladder used in analysis is not displayed in the [Comparison] view.

• A warning message is displayed when attempting to add data that contains a different dye, ladder type, or 
calibration curve type into the [Comparison] view. Click [Yes] if you wish to compare data with different 
migration and analysis conditions.

• Up to 120 data entries can be added to the [Comparison] view. The following message is displayed if an 
attempt is made to add more than 120 data entries to the [Comparison] view.
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Add Data to Comparison
This section describes the addition of focused or selected data to the [Comparison] view.

Add Focused Data to Comparison

1 Focus (Click) the data to be added to the [Comparison] view on the gel image.

2 On the [View] menu, select [Comparison] and [Add Focused Data to Comparison] or 
select [Add Focused Data to Comparison] on the right-click pop-up menu on the gel 
image.
The data is added to the [Comparison] view.

Add All Selected Data to Comparison

1 Select the check box of the data to be added to the [Comparison] view on the gel image.

2 On the [View] menu, select [Comparison] and [Add All Selected Data to Comparison] or 
select [Add All Selected Data to Comparison] on the right-click pop-up menu on the gel 
image.
The data is added to the [Comparison] view.

When the first data is added to the [Comparison] view, the window automatically changes to [Comparison]. 
However, the [Comparison] window is not automatically displayed when the next or following data is added. 

Add all data to be compared then select [Comparison] in the file name list box on the toolbar. 
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Delete Data From Comparison
This section describes procedures to delete focused or selected data from the [Comparison] view.

Delete Focused Data from Comparison

1 Focus the data to be deleted on the gel image at the [Comparison] view. 

2 On the [View] menu, select [Comparison] and [Delete Focused Data from Comparison] 
or select [Delete Focused Data from Comparison] on the right-click pop-up menu on the 
gel image.
The focused data is deleted from the [Comparison] view and the view is updated.

Delete All Selected Data from Comparison

1 Select the check box of the data to be deleted on the gel image at the [Comparison] 
view.

2 On the [View] menu, select [Comparison] and [Delete All Selected Data from 
Comparison] or select [Delete All Selected Data from Comparison] on the right-click 
pop-up menu on the gel image.
The selected data is deleted from the [Comparison] view and the view is updated.



5  MultiNA Viewer Functions

172   MultiNA Instruction Manual

Print
Data displayed on the [Comparison] view can be printed by selecting [Print] on the [File] menu. (P.148) 
Some differences from printing ordinary data files are described below.

• The [1 Sample/Page] layout is not available.
• <Data file numbers> and the original data file names are printed in the [Data File Information] section.
• (Sequential data numbers), wells in the original data file, and <data file numbers> are printed in the [Sample 

Sheet] section. Sample names, comments, types, and positions of the chip used are also printed to the right.

• The (sequential data number), well, and <data file number> are printed in the [Electropherogram] and [Gel 
Image] sections. The left end ladder on the gel image is the first ladder displayed on the [Comparison] view. 
The ladder is automatically added to the gel image.

• The (sequential data number), well, <data file number>, and sample name of each sample are printed in the 
left cell of the [Results Table]. 
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5.4.8 Size Calibration Curve
Select [Size Calibration Curve] to display a graph of the size calibration curve used in analysis of focused 
data (sample and ladder). 

• Size calibration curve is created for each chip position based on the ladder that was analyzed on that chip. 
For the ladder used for analysis, see "3.8.2 Data Examination and Reanalysis" P.64.

• When raw data is displayed, size calibration curve is not displayed.
• The type of size calibration curve is displayed on the title bar of the window. For details on the types of size 

calibration curves, see step 2 (P.183) in "  Specifying the Detection Criteria and Performing Automatic 
Analysis".

5.4.9 Analysis Performance Check Result
Select [Analysis Performance Check Result] to display the result of analysis performance check. 

•  Normally, when an analysis performance check data file is loaded, the result is automatically displayed as 
well. Select this menu to display the result window again after closing it.

• The result (LOG file) is saved in a [reagent kit name] folder in the project folder as plain text and can be 
opened on "Notepad" or an editor program. (The data is easier to view when it is displayed in single spaced 
font.) 

^ Reference
"4.5.6 Check Analysis Performance" P.114

5.4.10Ladder Monitor Result
Select [Ladder Monitor Result] to display the ladder monitor results that indicate the migration state of the 
standard ladder.

^ Reference
"5.2.12 Ladder Monitor" P.159
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5.4.11Select Ladder Used for Analysis
Select the [Select Ladder Used for Analysis] menu item from the [View] menu to display the ladder data 
used to analyze the focused data. 

1 Focus (click) the sample data on the gel image.
 The upper area of the gel image is gray for sample data. 

2 Select [Select Ladder Used for Analysis] on the [View] menu or select [Select Ladder 
Used for Analysis] on the [Gel Image] right-click pop-up menu.
The gel image changes to the [Show Selected] state and the check boxes are selected for the focus data 
and ladder data used in focus data analysis.
To return to the original display, select [Show All].

The following message is displayed if there is no ladder data associated with the focused sample 
data. 

5.4.12Select All Samples Analyzed Using This Ladder
Select [Select All Samples Analyzed Using This Ladder] from the [View] menu to display all of the sample 
data that was analyzed using the focused ladder.

1 Focus (click) the ladder data on the gel image.
For ladders used for analysis, numbers #1 to #4 (numbers indicate chip positions) are displayed above 
the check box.
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2 Select [Select All Samples Analyzed Using This Ladder] on the [View] menu or select 
[Select All Samples Analyzed Using This Ladder] on the [Gel Image] right-click pop-up 
menu.
The gel image changes to the [Show Selected] state. In addition, check boxes are selected for the 
focused ladder data and all sample data that was analyzed using the focused ladder data.
To return to the original display, select [Show All].

5.4.13Options
Select [Options] from the [View] menu to change the following items. 

[Peak Table] Tab

Select the items to be displayed on the peak table. 

Item Explanation

DNA 
(Display 
items for 
DNA data)

Size (bp) Specified size for ladder data. Size calculated using the size calibration curve for 
sample data

Concentration 
(ng/μL)

Concentration calculated using the fragment and marker peak areas.

Migration Index (%) Migration index based on marker detection time (Lower marker: 0%, Upper 
marker: 100%).

Height (mV) Peak height measured from baseline

Area (mV•μm) Peak area calculated by converting the migration time into the migration distance

Molarity (nmol/L) Molar concentration calculated from the concentration assuming that the average 
molecular weight is 333 per mer 

RNA 
(Display 
items for 
RNA data)

Attribute Specified size for lower marker (LM), rRNA (18S, 28S), and ladder data
Size for samples (reference value)

Concentration 
(ng/μL)

Concentration calculated using the fragment and marker peak area

Migration Index (%) Migration index based on marker detection time (Lower marker: 0%, End point of 
data: 100%)

Height (mV) Peak height measured from baseline

Area (mV•μm) Peak area calculated by converting the migration time into the migration distance

Peak start index (%) Migration index at the peak start point

Peak end index (%) Migration index at the peak end point
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For [Raw data], only time (sec), height (mV), and area (mV•sec) are displayed and these settings cannot be 
changed.

[Scale of Default View] Tab

Gel Image Brightness Adjustment

An upper and lower limit to the brightness of gel images can be set. These limits can be set when an 
option other than [Fixed scale] is selected as the default display scale.

• Scale changes are not immediately reflected when the [Electropherogram] is zoomed in. [Scale of Default 
View] changes are applied when the default display is recovered by selecting [Undo Zoom All]. 

• The graph may be displayed over the display range even after [Undo Zoom All] has been selected if 
[Fixed scale] has been selected.

Item Explanation

Scale to each sample The maximum concentration displayed on the gel image and the maximum 
vertical axis value on the electropherogram are displayed according to the 
maximum value of each data entry. 

Scale to all samples The maximum concentration displayed on the gel image and the maximum 
vertical axis value on the electropherogram are displayed according to the 
maximum value of all data (except for import ladder) included in the data file. 

Fixed scale The maximum and minimum values both for contrast displayed on the gel image 
and the vertical axis on the electropherogram are displayed according to the 
entered values. 
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5.5 Gel Image Menu

5.5.1 Invert Black and White
Select [Invert Black and White] from the [Gel Image] menu to change the background of the gel image 
display from white to black and back again.

• Select [Invert Black and White] on the [Gel Image] menu to invert black and white on the gel image. 
• Brightness can be adjusted by dragging the slider at the right end up or down.
• To revert the black and white display, select [Invert Black and White] again. 

5.5.2 Vertical Axis 
Select the display on the vertical axis of the analyzed data from among [Distance Image], [Size Image], or 
[Time Image]. 

• [Distance Image]: The value calculated by converting the migration time into the migration distance is 
displayed on the vertical axis. This gel image is similar to one obtained by agarose gel electrophoresis.

• [Size Image]: Corrects the distance image based on the size of the reference ladder (ladder used in the first 
analysis). Peaks with the same size are displayed at the same position band.

• [Time Image]: The vertical axis is displayed as migration index for analyzed data and migration time for raw data.

The vertical axis displays the image for [Distance Image] because size estimation of detected peaks for the 
following data cannot be performed even if [Size Image] is selected.

• Sample data without usable ladder for analysis

• Data that failed to be analyzed
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• For raw data, [Time Image] is always displayed and this menu is not selectable (see "5.4.5 Analyzed Data/
Raw Data" P.167).

5.5.3 Gel Image List
From the [Gel Image] menu, select [Gel Image List], and select [12-well Unit], [8-well Unit], or [Sort by Chip 
Position]. The selected [Gel Image List] layout is displayed.

• Alternatively, click  (View Gel Image List) on the toolbar to display the gel image list. When the [Gel Image 
List] is open from the toolbar icon, it is displayed the last selected layout ([12-well Unit], [8-well Unit], and 
[Sort by Chip Position]).

• The other gel image display (black and white inversion, selection between distance image and time image) 
are applied as they were last set.

• Double-clicking on the gel image list closes the list window and focuses on the corresponding data.

• Click  (Close) in the upper right corner to close the [Gel Image List] window.
• To copy an image data to the clipboard, select [Copy] on the [Gel Image List] right-click pop-up menu. 
• To print an image data, select [Print] on the [Gel Image List] right-click pop-up menu. (The paper margins 

previously specified in the [Page Setup] window are applied.)

[Copy] and [Print] are functions for the currently displayed window. If a different window is displayed over 
that window immediately (approx. one second) after selecting [Copy] or [Print], the content of the new 
window is copied or printed. 

12-well Unit

• Gel image list is displayed by a horizontal line on the sample stand (12 wells). The list is displayed in two 
separated portions; the left side (A to D) and the right side (E to H). 

• "L" displays the ladder used for the first analysis in the data file.
• The number above each data represents (sample number) (see "5.1.5 Sample Name Tree" P.129). 

Distance Image (Left) and Size Image (Right)

Analyzed Data (Left) and Raw Data (Right) of Time Image



 MultiNA Instruction Manual   179

5.5  Gel Image Menu

5

8-well Unit

• Gel image list is displayed by a vertical column on the sample stand (8 wells). The list is displayed in two 
separate portions; the left side (1 to 6) and the right side (7 to 12). 

• "L" displays the ladder used for the first analysis in the data file.
• The number above each data represents (sample number) (see "5.1.5 Sample Name Tree" P.129). 

Sort by Chip Position

• Gel image list is displayed in sideways (1 to 4) for each chip position.
• The numbers above each data display (sample number) (see "5.1.5 Sample Name Tree" P.129) and well 

name. 

5.5.4 Undo Zoom
Select [Undo Zoom] to cancel the previous zooming operation on the gel image. The same operation is 
available using the [Gel Image] right-click pop-up menu.

When the display range in the gel image is changed, the display range of the horizontal axis of the 
electropherogram (single) is rescaled to match.

5.5.5 Undo Zoom All
Select [Undo Zoom All] to cancel all previous zooming operations on the gel image. The same operation is 
available on the [Gel Image] right-click pop-up menu.

When the display range in the gel image is changed, the display range of the horizontal axis of the 
electropherogram (single) is rescaled to match. To return to the original display in the electropherogram 
(single), select [Undo Zoom]/[Undo Zoom All] on the [Electropherogram] menu or the [Electropherogram 
(Single)] right-click pop-up menu.

12-well Unit 8-well Unit Sort By Chip Position
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5.6  Electropherogram Menu

5.6.1 Peak Top
Select [Peak Top] to choose the information that is displayed at the top of the electropherogram (single) 
peak.

5.6.2 Font Size 
Select [Large], [Medium], or [Small] as the font size for peak-top text and the title (displayed on the upper 
right) on the electropherogram (single). 

5.6.3 Show Baseline
Selecting [Show Baseline] in the [Electropherogram] menu and adding a check mark displays the baseline 
for the electropherogram (single) and auxiliary lines when vertically partitioned (right figure).

Select the menu again and eliminate the check mark and hide baseline and auxiliary line (left graph). 

Item Explanation

Peak No. Peak number on the peak table

Migration Index / Migration Time Value on the horizontal axis of the electropherogram

Size (DNA analysis only) Predicted size, LM (lower marker), UM (upper marker)
When size estimation is not completed, (---) is displayed.

Attribute (RNA analysis only) Peak attribute of LM (lower marker), 18S rRNA, or 28S rRNA
Reference values for size

Height Peak top height

Area Peak area

None None

Baseline
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5.6.4 Horizontal Axis 
Select the display on the horizontal axis of the analyzed data from among [Migration Index], [Size], or 
[Migration Time]. 

• [Migration Index]: Displays a relative index value resulting from normalization of marker detection time.
DNA Analysis: Detection time for the lower marker and upper marker are set to 0% and 100%, 

respectively. 

RNA Analysis: Detection time for the lower marker and end point for the electropherogram are set to 
0% and 100%, respectively. 

• [Size]: Corrects and displays the migration index based on the size value of the reference ladder (ladder 
used in the first analysis).

• When [Manual Edit Mode] is selected on the [Reanalysis] menu, the horizontal axis is automatically set to 
[Migration Time]. 

• When displaying raw data, the horizontal axis only shows the migration time and the [Horizontal Axis] menu 
cannot be selected. (For details, see "5.4.5 Analyzed Data/Raw Data" P.167)

The horizontal axis displays the migration index because size estimation of detected peaks for the following 
data cannot be performed even if [Size] is selected.

• Sample data without usable ladder for analysis

• Data that failed to be analyzed

5.6.5 Overlaying Images
When displaying overlaid data, select either [Ascending Order] or [Descending Order]. 

^ Reference
"5.1.9 Electropherogram (Single)" P.135

5.6.6 Undo Zoom
Select [Undo Zoom] to cancel the previous zoom or pan operation on the electropherogram. 

The same operation is available on the electropherogram right-click pop-up menu.

Display range on the gel image does not change in conjunction with the electropherogram display range. 

5.6.7 Undo Zoom All
Select [Undo Zoom All] to cancel all of the previous zoom or pan operations on the electropherogram. 

The same operation is available on the electropherogram right-click pop-up menu.)

Display range on the gel image does not change in conjunction with the electropherogram display range. 
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5.7 Reanalysis Menu

Reanalysis cannot be performed when "read-only mode" is enabled in the following situations.

• When the instrument is loading data during analysis

• [Comparison] View (see "5.4.7 Comparison" P.169) is displayed on MultiNA Viewer.

Import ladders (see "5.7.3 Change Ladder and Analyze" P.189) cannot be manually edited.

5.7.1 Automatic
This function automatically analyzes all the data contained in a file. Select [Automatic] from the 
[Reanalysis] menu. The [Reanalysis] window is displayed.

The custom settings function cannot be used for RNA data.
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Specifying the Detection Criteria and Performing Automatic Analysis

1 Select [Fine], [Standard], or [Coarse] from the [Peak detection] selection buttons.
The differences in detection peaks are shown in the figure below.
• [Standard]: Normal detection criteria
• [Fine]: Select when the required peaks cannot be detected as this setting detects smaller peaks 

than [Standard]
• [Coarse]: Select when too many peaks are detected as this setting detects larger peaks than 

[Standard]

2 Select the calibration curve type from [Size calibration curve].
The types of calibration curves are shown below.
• Polynomial Approximation: Creates a polynomial that calculates size from all calibration points.
• Point To Point: Creates a calibration curve by connecting the individual calibration points 

on a straight line with size represented on a logarithmic axis.

The size value may vary depending on the type of calibration curve used.

3 Click [Reanalysis].
Reanalysis is executed.

[Coarse] [Standard] [Fine]

[Point To Point][Polynomial Approximation]
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Analysis using Custom Settings

1 Select [Custom] from the [Peak detection] selection buttons.

2 Enter the threshold values for peak detection in the fields under [Peak detection 
sensitivity parameters].
• [Peak height S/N lower limit]: Lower values allow detection of peaks with smaller signal intensities 

(default: 1.5)
• [Peak conc. lower limit]: Lower values allow detection of peaks with smaller areas (default: 0.1)

Deselecting the check boxes of the sensitivity parameters disregards the threshold values and 
causes all recognizable peaks to be detected.

3 Select [Baseline variation correction] as necessary (default: selected).

4 Selecting [Specify peak size range] enables the specification of the size range for 
detecting peaks.

• A maximum of 25 detection ranges can be specified.

• Detection is performed in the [± (bp)] range on each side of the [Size (bp)] value.

• All peaks are detected when a single range contains several peaks.

5 Select the calibration curve type from [Size calibration curve].

6 Click [Reanalysis].
Reanalysis is executed.

• If peak detection threshold values and ranges are specified as custom settings, a warning message is 
displayed if the set values are invalid.

• Selecting [Automatic] from the [Reanalysis] menu after editing peaks as described in "5.7.2 Manual Edit 
Mode" P.185 displays the following message. Clicking [Yes] deletes all the results of editing.
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5.7.2 Manual Edit Mode
The following revisions can be made for analysis data in the manual edit mode.

• Add or delete peaks
• Set or change markers
• Change peak detection points

Manually editing peaks may change the area and peak detection points of automatically detected peaks.

To return the peaks to their original state, select [Automatic] on the [Reanalysis] menu to perform reanalysis.

1 Select [Manual Edit Mode] on the [Reanalysis] menu or click  (Manual Edit Mode) on 
the upper right side of the electropherogram (single).

The peak detection points are displayed. 

2 Edit peaks manually.
Enlarge a target peak by zooming or panning on the electropherogram.

Peak start (light blue triangle)

Peak top (yellow green rectangle)

Peak end (blue triangle)

Manual edit mode
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[Set to Lower Marker] / [Set to Upper Marker]

Select [Set to Lower Marker] or [Set to Upper Marker] to set the target peak to the lower maker or upper 
marker. 

1 Move the mouse pointer near the position of the marker to set on the electropherogram.
(Also possible for locations that are not detected as peaks.)

2 Select [Set to Lower Marker] or [Set to Upper Marker] on the right-click pop-up menu.
The marker is set to the new peak and the peak table is automatically updated. 

[Set to 18S rRNA] / [Set to 28S rRNA]

Select [Set to 18S rRNA] or [Set to 28S rRNA] to change the 18S rRNA or 28S rRNA peaks in total RNA 
analyzed data. 

1 Move the mouse pointer near the position of the rRNA peak to set on the electropherogram.
(Also possible for locations that are not detected as peaks.)

2 Select [Set to 18S rRNA] or [Set to 28S rRNA] on the right-click pop-up menu.
18S rRNA or 28S rRNA is set to the new peak position and recalculation is automatically performed. 
As a result, the peak table and RNA report are updated as well.

1 2

2

1
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[Add Peak]

Select [Add Peak] to add a peak that has not been detected.

1 Place the cursor near the peak to be added on the electropherogram. 
2 Select [Add Peak] on the right-click pop-up menu.

The peak is added and the peak table is automatically updated.

[Delete Peak]

Select [Delete Peak] to delete an unnecessary peak.

1 Place the cursor near the peak to be deleted on the electropherogram. 
2 Select [Delete Peak] on the right click pop-up menu.

The peak is deleted and the peak table is automatically updated.

21

A peak is added

2

1
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Changing the Peak Detection Position

The position of the peak start, top, and end can be changed.

1 Place the cursor at the peak mark (peak start, top, or end). The cursor becomes a "+."
2 Drag the cursor to a desired peak position. 

Release the mouse button. The peak detection point is changed and recalculation is automatically 
performed and the peak table is updated.

In vertical partitioning, the end mark of a peak goes over the start mark of the next peak. The start 
mark and end mark can be separated or overlapped again by dragging the peak detection point 
mark. 

3 Select [Manual Edit Mode] on the [Reanalysis] menu again. 

(Alternatively, click  [Manual Edit Mode] on the right side of the electropherogram (single).)
The following message is displayed. Click [Yes] to end manual edit mode and register the changes. 

• Click [Yes] to register the changes.
• Click [No] to cancel the changes.
• Click [Cancel] to return to the [Manual Edit Mode].

• Even after clicking [Yes] and registering the changes, they are not saved in the data file yet. 
Perform the procedure described in step 4 below to save the changes. 

• The message shown above is displayed again as other data in the same data file is focused upon 
and edited in the [Manual Edit Mode]. 

• If an error is encountered in the edited content, a warning message is displayed and the changes 
cannot be confirmed.

1 2
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• Click [Cancel] to resolve the error.
Continue editing according to the displayed error message and resolution method.

• Click [OK] to discard the changes.

The message shown below is displayed after editing ladder data. 

• Click [Yes] to reanalyze all of the samples analyzed using this ladder.

• Click [No] to discard the changes and make no changes to the sample data.

• Click [Cancel] to return to the [Manual Edit Mode].

4 Select [Save] or [Save As] from the [File] menu.
Save the changes in the data file to the initial data file or to one with another name.

The message below is displayed when an attempt is made to close a data file without saving the 
changes. 

• Click [Yes] to save the changes in the initial data file.

• Click [No] to cancel the changes.

• Click [Cancel] to stop the closing process.

5.7.3 Change Ladder and Analyze
Select [Change Ladder and Analyze] to reanalyze sample data using a different ladder.

When a ladder is inappropriate or does not exist in the data file, ladder data from a different file can be 
loaded and the samples reanalyzed. 

• The new ladder data is called an "imported ladder."
• To display a ladder and samples analyzed using the ladder, see "5.4.11 Select Ladder Used for Analysis" 

P.174 or "5.4.12 Select All Samples Analyzed Using This Ladder" P.174. 

• The accuracy of the results may not meet the specification when analysis is performed with an imported 
ladder.

• Loadable ladder data is restricted to data that uses the same separation buffer and dye and obtained 
using the microchip of the same ID.
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• When [Change Ladder and Analyze] is selected for saved or registered data that has been changed 
through manual editing, the manual editing changes are deleted. The message below is displayed when 
[Change Ladder and Analyze] is selected for manually edited data. 

• Click [OK] to delete the changes.

• Click [Cancel] to stop the ladder change process.

Changing the Ladder Used in Analysis
When the ladder is inappropriate in automatically analyzed data (ex., the ladder's electropherogram does 
not show fragment peak), change the ladder as described below and perform reanalysis.

1 Focus (click) the target ladder on the gel image.

2 Select [Change Ladder and Analyze] on the [Reanalysis] menu. 
The message below is displayed. The ladder and samples analyzed using the ladder are selected with a 
check mark. 

3 Review the selected gel image and click [OK]. 
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The folder that contains ladder data that was obtained with the same conditions (the five matching 
conditions of "Chip ID," "Separation buffer," "Ladder type ID", "Marker mixing mode," and "Chip 
position") is opened.

The following folders are created for each condition acquired for the ladder.

[Data folder]

  -[Ladder]

     -[Chip ID] (ex., ND058-2)

        -[Separation buffer] (DNA-500/DNA-1000/DNA-2500/DNA-12000/RNA)

           -[Ladder type ID] (regularly, "Standard")

              -[Marker mixing mode] (Premix/On-chip)

                 -[Chip position] (ChipPosition1/ChipPosition2/ChipPosition3/ChipPosition4)

 

When a user ladder is selected as the data 
file, the size value in the peak table is 
displayed in red if the registered peak size 
is outside the specifications for separation.

Selectable folders
The folder that is open 
automatically at first
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Ladder data names reflect the time the ladder data analysis was started. This includes year, date, 
hour, minute and second and end with ".ldr". For example, ladder data that started analysis at 
18:53:00 on June 7, 2006 is named "20060607_185300.ldr".

Example)
C:\MultiNA\Ladder\ND058-2\DNA-2500\Standard\Premix\ChipPosition4\20060607_185300.ldr 

• The lower windows of the ladder data folder displays a preview of the electropherogram and peak table 
of the selected ladder data.

• When no appropriate ladder exists in the open folder, select ladder data from a ladder data folder 
where the "Chip ID" and "Separation buffer" match. Ladder data can be selected even if the "Marker 
mixing mode" and "Chip position" differ from ladder data being replaced. 

An error message is displayed if ladder data that uses a different separation buffer, dye, or chip ID is 
selected. If this occurs, select ladder data that has consistent data and conditions for analysis.

4 Select an appropriate ladder data file and click [Open].
Data is reanalyzed and the results are displayed.
"Imported ladder" is displayed on the right end of the gel image. An asterisk mark (*) is put above the 
check box of the imported ladder. The asterisk mark is followed by # and the "chip position." 
The well name of the ladder initially used for analysis is displayed under the check box. All of the 
indications for the imported ladder are in italics.

Clicking [Show All] displays all of the data in the data folder. The ladder used for analysis before ladder 
change ("X1-4" in this example) does not have the "#" mark, showing that it was not used for analysis. 

5 Go back to step 1 to change other ladder data.
To change the imported ladder to a different ladder data, focus (click) on the imported ladder.



 MultiNA Instruction Manual   193

5.7  Reanalysis Menu

5

6 Save the analysis results in the data file.
Select [Save] on the [File] menu to overwrite the data file, and select [Save As] to save the results in a 
data file with a different name. 

When No Ladder Data Exists in the Data File
When no ladder data exists in the data file because no ladder was analyzed or for other reasons, perform 
reanalysis using the procedures described below.

1 Focus (click) the gel image of the sample to be analyzed.

2 Select [Change Ladder and Analyze] on the [Reanalysis] menu. 
The message in the figure below is displayed and the data analyzed by the same microchip as the 
focused sample is selected (with a check mark) and displayed.

3 Review the selected gel image and click [OK]. 

The [Select Ladder Data] window is displayed. (Procedures to select ladder data are the same as the 
procedures described in "Changing the Ladder Used in Analysis" P.190.)



5  MultiNA Viewer Functions

194   MultiNA Instruction Manual

4 Select an appropriate ladder data and click [Open].
Data is reanalyzed and the results are displayed.
"Imported ladder" is displayed on the right end of the gel image. An asterisk mark (*) is put above the 
check box of the imported ladder. The asterisk mark is followed by # and "chip position".
The area below the check box is blank. All of the indications for the imported ladder are in italics.

5 Go back to step 1 to analyze another sample.
Focus (click) the imported ladder to change the imported ladder to different ladder data.

6 Save the analysis results in the data file.
Select [Save] on the [File] menu to overwrite the data file and select [Save As] to save the results in a data 
file with a different name. 
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5.8 Help Menu

5.8.1 Manual
Select a menu listed below to display a PDF file for the respective manual. 

Adobe® Reader® distributed by Adobe Systems Co. or other PDF file viewing software (provided free) is 
required to view the PDF file. Adobe® Reader® (Ver. 4 or later) can be downloaded from the following 
website: 

http://www.adobe.com/products/acrobat/readstep2.html

5.8.2 About MultiNA Viewer
Select [About MultiNA Viewer] to display the version of the MultiNA Viewer data analysis software. 

• [MultiNA Instrument Manual]: Display the Instrument Manual (system, control software, and data analysis 
software)

• [Quick Manual]: Display the Quick Manual
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6 Inspection and 
Maintenance

6.1 Before Inspection and Maintenance
It may be necessary to shutdown or restart the instrument and PC when performing inspection and 
maintenance work on the instrument.

! WARNING

• Do NOT touch any parts other than those specified for analysis operation and inspection 
and maintenance stipulated in this manual.

! WARNING

• Turn the instrument OFF before performing inspection or maintenance work.
Shocks or accidents due to short circuits may result.

• If the instrument requires servicing, contact your Shimadzu service representative.

• Do NOT perform any disassembly or modification procedures that are not described in 
these manuals.
Injury or accident may occur.

! CAUTION

• Use only the parts described in "10 Parts Specifications" P.279.
Normal operation is not ensured if other parts are used.

• Do NOT leave the instrument wet.
This may result in rust or discoloration. To clean the instrument, wipe it with a soft cloth moistened 
slightly with water. Then remove any moisture with a soft dry cloth.

• Do NOT wipe it with alcohol, paint thinner or other organic solvents.
These solvents may damage the paint on the instrument cover.
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6.1.1 Moving All Axes to Home Position
When performing inspection and maintenance work, turn ON power to both the instrument and the PC, 
verify that a connection has been established, and then move all the drive axes to their home position.

1 Start the MultiNA Control Software. Verify that the instrument and PC are connected.

2 Close the top cover.

3 Select [Move All Axes to Home Position] from the [Instrument] menu in the MultiNA 
window.

The operation starts and the green indicator LED blinks during execution. A blue status bar is displayed at 
the bottom left of the window.

4 Verify that the operation is complete.
The blue status bar is no longer displayed, and the green indicator LED is steady lit.

5 Open the top cover.
Verify that the drive axes have returned to the home position as in the figure below.
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6.2 Daily Maintenance
Daily maintenance prior to starting analysis is recommended to ensure the quality of the results.

^ Reference
For details on each part of the instrument, see "  Internal Parts" P.10

6.2.1 Piercing Needle

Purpose
To remove any substances adhered to the tip of the piercing needle.
Adhered substances may prevent the needle from piercing the aluminum seal on the sample plate, or 
cause contamination of the sample.

Guidelines for Procedure
When adhered substances are present on the tip of the piercing needle.

Requirements
• Tweezers
• Wipes

Cleaning Procedure

1 Perform the procedure in "6.1.1 Moving All Axes to Home Position" P.198.

2 Open the top cover.

3 Using the tweezers, peel off any adhered substances on the tip of the piercing needle in 
a downwards direction.

4 Use the wipes to remove any adhered substances from the tweezers.

Tip of the Piercing Needle with Adhered Substance (Left) and After Cleaning (Right)
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6.2.2 Sample Probe and Aspirator

Purpose
To remove any substances adhered to the tips of the sample probe and aspirator.
Adhered substances may cause the sample probe and aspirator to become partially obstructed, reducing 
dispensing precision.

Guidelines for Procedure
When adhered substances are present on the tip of the sample probe or aspirator.

Requirements
• Milli-Q ultrapure water, 100 mL

Cleaning Procedure

1 Perform the procedure in "6.1.1 Moving All Axes to Home Position" P.198.

2 Ensure that the glass rinse water bottle contains at least 100 mL of Milli-Q ultrapure 
water.

3 On the [Instrument] menu, select [Wash] - [Probe Rinse].

The rinsing operation starts. The aspirator is also rinsed during the sample probe rinsing.
The green indicator LED blinks during the operation. A blue status bar is displayed at the bottom left of the 
window.

! CAUTION

• Do NOT touch the tips of the sample probe and aspirator.
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4 Verify that the rinse operation is complete.
The blue status bar is no longer displayed, and the green indicator LED is steady lit.

Any adhered substances on the tip of the sample probe are removed.

6.2.3 Air Cylinder Seal

Purpose
To remove any substances adhered to the air cylinder seal.
Salt or other substances adhered to the air cylinder seal will reduce the efficiency of the separation buffer 
transfer process.

Guidelines for Procedure
• When adhered substances are present on the air cylinder seal.
• When a seal mark is evident on a microchip surface after analysis is complete.

Requirements
• Wipes
• Milli-Q ultrapure water

Cleaning Procedure

1 Perform the procedure in "6.1.1 Moving All Axes to Home Position" P.198.

2 Wipe the tip of the air cylinder seal with a wipe soaked in water.

! CAUTION

• Do NOT scratch the air cylinder seal.

• Do NOT apply unnecessary force to the tip of the aspirator.
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3 Then remove any residual water with a dry wipe.

6.2.4 Chip Cover

Purpose
To remove any precipitate adhering to the electrode pins on the chip cover and verify that the electrode 
pins are not bent and the chip pressing cushion is not deformed or peeling.

Contact your Shimadzu service representative if the electrode pins are bent, or if the chip pressing cushion 
is deformed or peeling.

Guidelines for Procedure
• When adhered substances are present on the chip cover surface.
• When adhered substances are present on the electrode pins.

Requirements
• Wipes
• Milli-Q ultrapure water

Cleaning Procedure

1 Perform the procedure in "6.1.1 Moving All Axes to Home Position" P.198.

2 If there is precipitate on the chip cover surface, wipe it away with a wipe soaked in Milli-
Q ultrapure water. Then remove residual water with a dry wipe.

3 Loosen the knurled screws (2) then open the chip cover and set it upright.

Knurled screws
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4 If there are adhered substances on the electrode pins on the inside surface of the chip 
cover, wipe it away with a wipe soaked in Milli-Q ultrapure water. Then remove residual 
water with a dry wipe.

5 Check for deformation or peeling of the chip pressing cushion on the back surface of 
the chip cover.

6 Set the chip cover, and tighten the knurled screws.

6.2.5 Sample (Extra Sample) Stand

Guidelines for Procedure
When adhered substances are present on the sample stand or extra sample stand.

Requirements
• Wipes
• Milli-Q ultrapure water

! CAUTION

• Do NOT deform the electrode pins when removing the adhered substances.
If the electrodes become deformed, contact with the microchip electrodes will not be sufficient 
to apply the proper voltage to the chip.

Electrode pins

Chip pressing cushions
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Cleaning Procedure

1 Perform the procedure in "6.1.1 Moving All Axes to Home Position" P.198.

2 Wipe off any adhered substances with a wipe soaked in Milli-Q ultrapure water.

3 Then remove any residual water with a dry wipe.

6.2.6 Inspecting and Washing Microchip Reservoirs

Purpose
To manually clean the microchip channels and surface and confirm that the channels are unobstructed.

Guidelines for Procedure
When any of the following three situations arise:

• The "Remove all chips and immediately wash them" message is displayed.
The microchips were not washed because analysis did not end properly. The microchip channels and 
reservoirs can become blocked due to dried separation buffer.

• The "Chip # has an error" message is displayed (# indicates the chip position).
Click [OK] in the dialog box. An "Error occurred. Chip # is now unavailable" message will be displayed when 
the analysis schedule is complete.

All microchips used in analysis are washed automatically (including microchips for which an error occurred). 
However, the channels and reservoirs of microchips for which an error occurred can become blocked.

 

^ Reference
"8.2 Error Messages" P.244

• If no message has been displayed, but adhered substances are present on or in the vicinity of the microchip 
reservoir.
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Requirements
• Milli-Q ultrapure water
• Micropipette (20 μL to 200 μL) and pipette tips (required quantity)
• Wipes (Recommended: BEMCOT LINTFREE PS-2)

Use the recommended brand of wipes.

Procedure

^ Reference
For details on microchip insertion and removal, see "3.3.5 Microchip Installation" P.32

1 Perform the procedure in "6.1.1 Moving All Axes to Home Position" P.198.

2 Open the chip cover, and remove the microchip from the instrument.

3 Remove the microchip from the chip frame, and place it on a flat surface.

4 If precipitate is evident around the reservoir, use a micropipette to drop about 20 μL of 
Milli-Q ultrapure water onto the precipitate.

5 Wait for 5 minutes.

6 Verify that the precipitate has dissolved, and then remove the water with a wipe.

! CAUTION

• Do NOT scrub the reservoir when removing the moisture from the surface of the microchip.
Lint from the wipe could clog the microchip channels.

• Do NOT touch the surfaces of the microchip with your bare hands.

• Do NOT scratch the microchip electrodes during handling.
If salt or other material has hardened on the electrodes, do NOT scrub the electrodes. Apply water to 
dissolve the salt and then gently wipe it away.

• Do NOT clean the microchip with an ultrasonic cleaner.
This will damage the microchip.
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7 Fill the standard accessory disposable syringe with 1 mL of Milli-Q ultrapure water. 
Assemble the filter, syringe adapter, and seal tip as shown in the figure below. Apply 
pressure to force water through one of the reservoirs.

8 Apply water through one of the reservoirs and verify that water pours out through the 
other three reservoirs.

If water does not pour out, return to step 4, drop Milli-Q ultrapure water onto the precipitate, and extend 
the waiting period to 30 minutes. If the chip still remains clogged, stop using it for analysis, and replace it 
with a new microchip.

9 Remove any water in the microchip reservoirs using the micropipette.

10 If the microchip surface is still dirty, wipe it gently with a wipe soaked in Milli-Q ultrapure 
water.

11 Place the microchip in the chip frame.

Disposable syringe 1mL
(S046-00045-01)

Filter,13A
(S670-12540-02)

Syringe adapter
(S228-40340)

Seal tip L
(S228-40339)

! CAUTION

• Be sure the microchip soak time is no more than 30 minutes.
There is a danger that soaking for longer periods can damage the channel coating, and lead to 
degraded performance.
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Place the microchip in the chip frame so that the electrode side on the top of the microchip (surface 
with reservoirs) is located toward the back side (area without plastic) of the chip frame top (surface 
with the Shimadzu logo).

12 Close the chip frame, securing the microchip.

13 Turn the microchip so that the front surface faces away from you.

14 Place the microchip back in its original position in the instrument.

6.2.7 Chip Stage and Objective Lens

Purpose
To clean the chip stage and objective lens.
If there is any adhered substance, it may reduce the detection sensitivity.

Guidelines for Procedure
Perform this procedure in either of the following situations:

• If adhered substances are found on the chip stage or objective lens when the microchip is removed.
• If detection sensitivity is reduced.

Requirements
• Wipes
• Cotton swabs
• Milli-Q ultrapure water

! CAUTION

• If analysis is not performed after that, perform [All Chip Washing] to prevent water 
residue in the microchip channels. (For details, see "4.5.8 Wash" P.119)
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Procedure

1 Perform the procedure in "6.1.1 Moving All Axes to Home Position" P.198.

2 Open the top cover.

3 If adhered substances are found on the chip stage, wipe it away with a wipe moistened 
in Milli-Q ultrapure water.

4 Remove any residual water with a dry wipe.

5 If the detector's objective lens is dirty, clean it using a cotton swab moistened with Milli-
Q ultrapure water.

6 Remove any residual water with a dry cotton swab.

6.2.8 Cleaning the Cover

Guidelines for Procedure
If the cover is conspicuously dirty.

Requirements
• Cloth (2 cloths)
• Neutral detergent
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Procedure

1 Turn the instrument OFF or verify that the instrument is OFF.

^ Reference
For details on how to turn off the instrument, see "3.2.2 Shutdown" P.24

2 Wipe the cover with a cloth moistened with a small amount of water.

If the cover is particularly dirty, use neutral detergent.

3 Remove any residual water with a dry cloth.

6.2.9 Chip Cleaning

Purpose
To remove components adhered in the microchip's channels using chip cleaning solution.

^ Reference
To perform chip cleaning automatically upon completion of analysis, see "3.5.5 Chip Cleaning Solution 
Placement" P.50.

Guidelines for Procedure
• When the UM theoretical plate number or UM time fail in the analysis performance inspection
• When the separation performance is determined to deteriorate as the upper marker (UM) peak widens

Requirements
• Chip cleaning kit
• Buffer bottle
• Open-hole screw cap
• Micropipette and pipette tip
• Milli-Q ultrapure water
• Wipes

! WARNING

• Do NOT turn the instrument ON if it is still wet.
Shocks or accidents due to short circuits may result.

! WARNING

• Always read the instruction manual provided with the chip cleaning kit before handling the 
contents of the kit.
The instruction manual for the chip cleaning kit describes safety precautions that are important to 
ensure safe use.
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Procedure

1 Dispense chip cleaning solution into the buffer bottle.

The required volume of chip cleaning solution varies depending on conditions such as the number of 
microchips in use and number of times cleaning is performed.

^ Reference
For details on the required volume of chip cleaning solution, see "3.5.5 Chip Cleaning Solution 
Placement" P.50.

2 Securely tighten the open-hole screw cap onto the buffer bottle.

3 Insert the buffer bottle at the chip cleaning solution position in the reagent holder.

Move the bottle around to verify that the bottom of the buffer bottle is in the correct position at the 
bottom of the reagent holder.

4 Select [Chip Cleaning] from the [Instrument] menu.
The chip cleaning window is displayed.

• Select a microchip from [Chip 1] to [Chip 4] to clean an individual microchip.

• Select [All Chips] to clean all the microchips installed in the instrument.

5 After specifying the number of times to perform cleaning, click the start button.
The chip cleaning process starts.

• Select a suitable number of times to perform cleaning according to the degree of deterioration in 
microchip performance.

• The amount of time required for cleaning increases according to the number of times cleaning is 
specified to be performed.

• If the instrument determines that the remaining volume of cleaning solution is insufficient, 
cleaning stops and a warning is displayed on screen. Also, chip washing with rinse water is 
performed automatically to help keep the microchips in good condition.

Chip cleaning solution position
Reagent Holder

Rinse port
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6 Once chip cleaning is complete, open the top cover and chip cover and check the 
condition of the microchip.

Contamination may be observed around reservoir 4 of microchips after performing chip cleaning. In 
this case, use a wipe moistened with Milli-Q ultrapure water to clean the area around reservoir 4.

Immersion Cleaning
If the procedure described above does not improve microchip performance, clean the affected microchip 
by immersing it in cleaning solution. For details on the procedure for cleaning through immersion, refer to 
the instruction manual included with the chip cleaning kit.

6.3 Parts Maintenance and Replacement
^ Reference

"10.5 Replacement Guidelines" P.286

6.3.1 Parts Maintenance
Confirm information, such as the number of runs, for the parts used in the instrument.

Microchips
 Select [Chip Management] from the [Instrument] menu in the MultiNA window.

The microchip usage status (number of runs, date and time of first usage) is displayed.
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Instrument
Select [Parts Maintenance] from the [Instrument] menu in the MultiNA window.

The instrument body usage status (number of analyses, operation time) is displayed.

• The replacement guidelines are not a guarantee of the operational period of parts. The period will vary 
depending on the usage conditions.

• The replacement intervals were calculated under the following conditions. 
160 analyses per day, divided into 10 schedules, with 20 operating days per month.

• Use only the parts described in "  Standard Accessories" P.279 or "  Periodic Replacement Parts" 
P.280.
Normal operation is not ensured if other parts are used.

6.3.2 Before Replacing Parts
Before replacing any parts, move all the drive axes to their home position and then turn OFF the 
instrument.

1 Perform the procedure in "6.1.1 Moving All Axes to Home Position" P.198.

2 Turn the instrument OFF as per "  Shutting Down the Instrument Only" P.25.
Leave the PC turned ON.
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6.3.3 Video
On the Windows [Start] menu, select [All Programs] - [MultiNA] and click on the [Procedure for Replacing a 
Plunger]/[Procedure for Replacing a Pump Cartridge]/[Procedure for Replacing a Syringe] items to display 
videos of the replacement procedures for the respective parts.

With the instrument ON and connected to the PC, videos can be also displayed by clicking the [Movie] icon 
in the MultiNA Control Software [Parts Maintenance] window.

• The pump cartridge replacement procedure is identical for all pump cartridges.

• The recorded video shows the replacement procedure for pump cartridge No. 3.

6.3.4 Plunger Replacement
The syringe consists of a plunger and syringe barrel (glass cylinder). A PTFE plunger seal is attached to 
the plunger tip to improve air tightness.

Purpose
If the instrument is used for an extended period of time, the air tightness of the plunger seal is reduced by 
wear. Replace the plunger to restore the air tightness.

It is not possible to replace only the plunger seal.

Syringe (Left), Syringe Barrel (Center) and Plunger (Right). The Tip of the PTFE Plunger Seal is Circled
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Replacement Guidelines
Perform this procedure in either of the following situations:

• When either the number of analyses or replacement date for the plunger, indicated in the [Parts 
Maintenance] window, exceeds the guidelines (standard interval) for replacement (see (P.286)).

• If leakage is discovered below the plunger seal.
(The syringe cover must be removed if the syringe is found to be leaking.)

Inspection Procedure
30 μL of rinse water is transferred to a sample tube placed in the extra sample stand. Measure this quantity 
using a micropipette and confirm that there is no water leakage.

Requirements

For replacement
• Plunger: Part No. S228-25237-14
• Wipes
• Beaker
• Milli-Q ultrapure water
• Phillips screwdriver

For inspection
• Sample tube
• Milli-Q ultrapure water
• Micropipette (100 μL to 200 μL)
• Phillips screwdriver

Syringe leak location
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Replacement Procedure
The following referenced step numbers indicate the step numbers shown in the video.

1 Perform the procedure in "6.3.2 Before Replacing Parts" P.212.

2 Open the top cover, and spread out a wipe below the sample probe.

^ Reference
Video Step 1

3 Remove the red screws (2) on the back of the instrument with a Phillips screwdriver and 
remove the syringe cover.

^ Reference
Video Step 2

Wipe

Sample probe

Red screw

Red screw



6  Inspection and Maintenance

216   MultiNA Instruction Manual

4 Turn the black knurled screw at the bottom of the syringe in the direction indicated by 
the arrow and remove it.

^ Reference
Video Step 3

5 Holding the syringe barrel, turn it in the direction indicated by the arrow, and remove the 
upper section of the syringe from the instrument.

^ Reference
Video Step 4

Once the syringe has been removed, rinse water left over in the tubing may leak from the sample 
probe. This rinse water is absorbed by the wipe spread out in step 2.

^ Reference
Video Step 5

6 Replace the plunger.

^ Reference
Video Step 6
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7 Submerge the syringe tip in a beaker of Milli-Q ultrapure water. Suction up 150 μL of 
Milli-Q ultrapure water. Then expel it. Repeat this process several times.

^ Reference
Video Step 7

8 Verify that there are no air bubbles in the syringe.
Small bubbles, like the ones shown to the right, are not a problem.

9 Aspirate about 50 μL Milli-Q water into the syringe.

^ Reference
Video Step 7

10 With the Milli-Q ultrapure water still in the syringe, attach the top of the syringe to the 
instrument.

^ Reference
Video Step 8

Large bubbles
(Layer of air about 
4 mm to 6 mm thick)

↓
Requires removal

Small 
bubbles

↓
OK

! CAUTION

• Hold the syringe vertically during attachment.
The syringe may be damaged if it is attached on an angle.

• Do NOT use a wrench or other tools.
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11 Push in the plunger.
Verify that no water leaks from the syringe attachment port.

^ Reference
Video Step 9

Inserting the plunger may cause rinse water left over in the tubing to leak from the sample probe. 
This rinse water is absorbed by the wipe spread out in step 2 (P.215).

^ Reference
Video Step 10

12 Attach the black knurled screw.

^ Reference
Video Step 11

13 While the syringe cover is still removed, perform an inspection according to the "  
Inspection Procedure" P.218 procedure below.

Inspection Procedure
Before performing an inspection, turn the instrument ON.

^ Reference
For details on how to start the instrument and software, see "3.2.1 Startup" P.22

1 Select [Connect] from the [Instrument] menu in the MultiNA window.

2 Perform the procedure in "6.1.1 Moving All Axes to Home Position" P.198.

3 Place an empty sample tube in well position X1 on the extra sample stand.

4 Install the sample holder.
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5 Ensure that the glass rinse water bottle contains at least 100 mL of Milli-Q ultrapure 
water.

6 Close the top cover.

7 Select [Parts Maintenance] from the [Instrument] menu in the MultiNA window.
The [Parts Maintenance] window is displayed.

8 Select the [Check] checkbox for [Plunger].

A message is displayed to confirm whether to perform the inspection operation.

9 Click [Yes].

The inspection operation starts and the green indicator LED blinks during execution. A blue status bar is 
displayed at the bottom left of the window.

10 Check the following after inspection is complete.

1 Check the syringe connector.
Check that there is no water leakage from the syringe connector.
If there is water leakage, repeat the procedures in "6.3.4 Plunger Replacement" P.213, attaching the 
syringe to avoid leakage from the connector. Then, repeat the inspection procedure from step 1.

2 Check the water volume in the sample tube.
Open the top cover and suction up the rinse water in the sample tube at X1 with a micropipette set to 
25 μL.
After suctioning up 25 μL, verify that rinse water remains in the sample tube at X1.
If there was no water remaining in the sample tube, check for leaks again, and then perform the 
inspection again.
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11 Click  (Reset) for [Plunger] in the [Parts Maintenance] window.

A message is displayed to confirm whether to perform a reset.

12 Click [Yes].
The number of analyses is set to 0.

13 Replace the syringe cover on the back of the instrument.

6.3.5 Syringe Replacement

Purpose
If the instrument is used for an extended period of time, air tightness is reduced by syringe barrel wear. If 
air tightness is not improved by replacing the plunger, then replace the syringe.

Replacement Guidelines
Perform this procedure in either of the following situations:

• When either the number of analyses or replacement date for the syringe, indicated in the [Parts 
Maintenance] window, exceeds the guidelines (standard interval) for replacement (see "10.5 Replacement 
Guidelines" P.286).

• If leakage is discovered below the plunger seal.
(The syringe cover must be removed according to the following procedures to check for syringe leaks.)

Inspection Procedure
The procedure is the same as that for plunger inspection ("  Inspection Procedure" P.214).

Requirements

For replacement
• Micro syringe: Part No. S228-25237-04
• Wipes
• Beaker
• Milli-Q ultrapure water
• Phillips screwdriver
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For inspection
• Sample tube
• Milli-Q ultrapure water
• Micropipette (100 μL to 200 μL)
• Phillips screwdriver

Replacement Procedure

1 Perform steps 1 through 5 in "6.3.4 Plunger Replacement" P.213.

2 Prepare a new syringe.

^ Reference
Video Step 7

3 Perform steps 7 through 12 in "6.3.4 Plunger Replacement" P.213.

Inspection Procedure

1 Perform steps 1 through 6 in "  Inspection Procedure" P.218.

2 Select [Parts Maintenance] from the [Instrument] menu in the MultiNA window and click 
the [Check] checkbox for [Syringe]. 

The following confirmation message is displayed.

3 Click [Yes].
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The inspection operation starts and the green indicator LED blinks during execution. A blue status bar is 
displayed at the bottom left of the window.

4 Check the following after inspection is complete.

1 Check the syringe connector.
Check that there is no water leakage from the syringe connector.
If there is water leakage, repeat the procedures in "6.3.4 Plunger Replacement" P.213, attaching the 
syringe to avoid leakage from the connector. Then, repeat the inspection procedure from step 1.

2 Check the water volume in the sample tube.
Open the top cover and suction up the rinse water in the sample tube at X1 with a micropipette set to 
25 μL.
After suctioning up 25 μL, verify that rinse water remains in the sample tube at X1.
If there was no water remaining in the sample tube, check for leaks again, and then perform the 
inspection again.

5 Select [Parts Maintenance] from the [Instrument] menu in the MultiNA window and click 
 (Reset) for [Syringe].

The following confirmation message is displayed.

6 Click [Yes].
The number of analyses is set to 0.

7 Replace the syringe cover on the back of the instrument.
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6.3.6 Pump Cartridge Replacement
^ Reference

"1.6 Instrument Description" P.8

Purpose
Extended use wears out the pump cartridge rotor and may cause a reduction in flow rate or tube failure. 
Replace the pump cartridges when the guidelines (standard interval) for replacement have been reached.

Replacement Guidelines
When the pump cartridge operation time displayed in the [Parts Maintenance] window exceeds the 
guidelines (standard interval) for replacement (see "10.5 Replacement Guidelines" P.286).

It is also necessary to replace the pump cartridge when there is at least one "fail" in the analysis 
performance inspection ("4.5.6 Check Analysis Performance" P.114).

Inspection Procedure
When the inspection program is run, rinse water is dropped into the microchip reservoir and then suctioned 
up. If the peristaltic pump is not operating properly, or if there is a problem with the connection between the 
pump cartridges and the tubes, the suction is insufficient, and rinse water remains in the reservoir. This is 
detected by the sample probe, and an error message (water level detection error) is displayed.

Requirements

For replacement
• Pump cartridge*

• Phillips screwdriver
• Wipes

* Pump cartridges are not compatible between different pumps. Check the type of pump cartridge installed 
on the instrument and replace it with an identical one.

Pump Cartridge RoHS Compliant Pump Cartridge

Part No. S042-00405-13 S292-96682

Name CASSETTE HEAD CASSETTE HEAD

Applicable 
instrument

292-28000-2X/3X 292-28000-4X/5X
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For inspection
• Microchip (1)
• Milli-Q ultrapure water
• Micropipette (10 μL to 200 μL)
• Phillips screwdriver

Replacement Procedure
The following referenced step numbers indicate the step number shown in the video.

Replacement of cartridge No. 3 is used as the example in the videos for pump cartridges Nos. 1 through 4, 
and cartridge R.

1 Perform the procedure in "6.3.2 Before Replacing Parts" P.212.

2 Using the Phillips screwdriver, remove the 2 screws fastening the front cover.

^Reference
Video Step 1

3 Drop the front cover forwards.
The five pump cartridges are arranged in a row. Nos. 1 to 4 from the left, and then R.

^ Reference
Video Step 2

! CAUTION

• The front cover must be opened to replace the pump cartridges. Ensure at least a 10 cm 
space in front of the instrument.

! CAUTION

• After the front cover screws have been removed, drop the front cover forwards, 
holding the cover by hand.

• Do NOT remove the cables connecting the front cover to the instrument.
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4 Pull the 2 yellow pump cartridge tubes out of the semi-transparent joint.

^Reference
Video Step 3

Remove the part shown by the arrow in figure. Removal is easier if you grip the joint and yellow 
tubes and then pull.

For 292-28000-2X/3X For 292-28000-4X/5X

Pump Cartridge (Enlarged View)
(From the Left, 1 to 4 and R)

Tube

! CAUTION

• The narrow white tube is attached to the joint on the other side of the yellow tube. Do 
NOT remove the white tube.
The tubes may fall into the instrument and become irretrievable.

• When removing pump cartridge R, the rinse water in the tubing will leak from the joint.
Clean up this water with a wipe.

Removing Tubes From the 
Pump Cartridges
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5 Gripping the 2 levers on the pump cartridge, pull the pump cartridge forwards, removing 
it from the motor shaft.

^Reference
Video Step 4

When using a RoHS compliant pump cartridge, turn the pump cartridge in the counterclockwise 
direction and pull it off the motor shaft toward you at the position where it stops rotating.

Pump Cartridge (Enlarged View)

LeverLever
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6 Attach the new pump cartridge to the motor shaft.
Push the opening at the center of the pump cartridge onto the motor shaft.

^Reference
Video Step 5

When using a RoHS compliant pump cartridge, insert the pump cartridge by aligning the protrusions 
on the cartridge periphery with the gaps on the motor and fix the pump cartridge into position by 
turning it in the clockwise direction until it clicks.

! CAUTION

• Install the pump cartridge in the correct direction.

Protrusion on cartridge Gap on motor
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7 Install the 2 yellow tubes on the pump cartridge onto the joints.
Push the yellow tube until its tip touches the base at the center of the joint.
^Reference

Video Step 6

While the front cover is still removed, perform an inspection according to the following procedures.

See "6.3.7 Pump Cartridges (1 to 4) Inspection" P.229 to inspect pump cartridges Nos. 1 through 4, 
and "6.3.8 Pump Cartridge R Inspection" P.231 to inspect pump cartridge R.

! CAUTION

• Do NOT pull on the yellow tube when pushing it onto the joint.

• Ensure that the pump cartridge's yellow tubes are connected to the proper joints.

• After insertion, verify that the yellow tube is not crimped.
If it is crimped, it will not provide normal suction.
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6.3.7 Pump Cartridges (1 to 4) Inspection

Inspection Procedure
When the inspection program is run, rinse water is dropped into the microchip reservoir and then suctioned 
up. If the peristaltic pump is not operating properly, or if there is a problem with the connection between the 
pump cartridges and the tubes, the suction is insufficient, and rinse water remains in the reservoir. This is 
detected by the sample probe, and an error message (water level detection error) is displayed.

Requirements
• Microchip (1)
• Milli-Q ultrapure water
• Micropipette (10 μL to 200 μL)
• Phillips screwdriver

Procedure

1 Turn ON the power switch on the MultiNA instrument and then select [Connect] from the 
[Instrument] menu in the MultiNA window.

2 Perform the procedure in "6.1.1 Moving All Axes to Home Position" P.198.

3 Open the top cover and insert a microchip in chip position 4.
If the microchip is not installed in chip position 4, install one according to "3.3.5 Microchip Installation" 
P.32.

4 Close the top cover.

5 Select [Parts Maintenance] from the [Instrument] menu in the MultiNA window and click 
the [Check] checkbox that corresponds to the replaced pump cartridge.

The following confirmation message is displayed.
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6 Click [Yes].

The inspection operation starts and the green indicator LED blinks during execution. A blue status bar is 
displayed at the bottom left of the window.

7 Verify that the inspection process has finished.
• If it has finished properly, the blue status bar disappears without an error message (water level 

detection error) being displayed. Proceed to step 8.

• If a water level detection error occurred, the following message is displayed.

Check the following items and then repeat the procedure from step 5.

• Open the top cover and the chip cover. Check that rinse water remains in the microchip reservoir.
If rinse water remains, suck it out with a micropipette.

• Verify that the replaced pump cartridge and tubes are connected properly.

If the error message is displayed again, contact your Shimadzu service representative.

8 Select [Parts Maintenance] from the [Instrument] menu in the MultiNA window and click 
 (Reset) that corresponds to the replaced pump cartridge.

The following confirmation message is displayed.
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9 Click [Yes].
The operation time is set to [0].

10 Replace the front cover.

6.3.8 Pump Cartridge R Inspection

Inspection Procedure
Rinse water is supplied to the rinse pool. Confirm this visually.

Requirements
• Milli-Q ultrapure water
• Phillips screwdriver

Procedure

1 Turn ON the power switch on the MultiNA instrument and then select [Connect] from the 
[Instrument] menu in the MultiNA window.

2 Perform the procedure in "6.1.1 Moving All Axes to Home Position" P.198.

3 Ensure that the glass rinse water bottle contains at least 100 mL of Milli-Q ultrapure 
water.

4 Select [Parts Maintenance] from the [Instrument] menu in the MultiNA window and click 
the [Check] checkbox for [Pump Cartridge R].

The following confirmation message is displayed.
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5 Click [Yes].

The inspection operation starts and the green indicator LED blinks during execution. A blue status bar is 
displayed at the bottom left of the window.

6 After the inspection process has finished, open the top cover and confirm the following 
items.
• Confirmation 1: Check that no rinse water has leaked from the connection between the pump cartridge 

R and the tubes.
If there is any leakage, reconnect the tubes and repeat the procedure from step 3.

• Confirmation 2: Check the water level of the rinse pool. Verify that the water level in the rinse pool is 
more than half of the pool's depth.

If the rinse pool does not fill adequately after the procedure is repeated, contact your Shimadzu 
service representative.

7 Select [Parts Maintenance] from the [Instrument] menu in the MultiNA window and click 
 (Reset) for [Pump Cartridge R].

The following confirmation message is displayed.

The water level in the rinse pool is more than half of the rinse pool's depth
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8 Click [Yes].
The operation time is set to [0].

9 Replace the front cover.

6.3.9 Suction Filter Inspection and Maintenance

Guidelines for Procedure
When a significant number of bubbles are present in the rinse water suction line.

When the suction filter appears to be dirty.

Requirements
• Ultrasonic cleaner
• 2-propanol
• Beaker
• ELEMENT, SUS FILTER: Part No. S228-45707-91 (if replacement is required)

Procedure

1 Remove the suction filter from the glass rinse water bottle, and pull the suction filter off 
of the suction tubing.

2 Place the suction filter in a beaker filled with 2-propanol, and clean it for 5 minutes using 
an ultrasonic cleaner.

! WARNING

• Refer to the MSDS of the reagent used.

! CAUTION

• Do NOT touch the suction filter with bare hands.
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3 Replace the suction filter on the suction tube, and return it to the glass rinse water 
bottle.

4 Select [Wash] on the [Instrument] menu in the MultiNA window and click [Probe Rinse].
A probe rinse is executed.

^ Reference
"6.2.2 Sample Probe and Aspirator" P.200

5 Verify that no bubbles accumulate in the suction tubing.
If bubbles are still accumulating in the suction tubing, replace the suction filter with a new one (ELEMENT, 
SUS FILTER).

6.3.10Fuse Replacement

Requirements
• Fuse: Part No. S072-02004-22 (2 are required)
• Flathead screwdriver

! CAUTION

• Insert the suction filter into the suction tube marked with an "F".

Suction tubing

Suction filter

! WARNING

• Before replacing the fuses, turn the instrument OFF, and unplug the power cord from the 
outlet.

• Only use the specified fuses (Part No. S072-02004-22).
Fires, electric shocks, or accidents may otherwise result.
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Procedure

1 Perform the procedure in "6.3.2 Before Replacing Parts" P.212.

2 Remove the power cable from the AC adapter with fuse box.

3 Use the flathead screwdriver to pull the cover of the fuse box towards you.

4 Pull the fuse box out towards you.

5 Remove the fuse from the fuse box and replace it with a new one.

6 Push the fuse box into the instrument until you hear a click sound.
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7 Instrument Storage and 
Relocation

7.1 Before Transport and Storage

7.1.1 Rinse Water Removal
Follow the procedures below to remove rinse water in the rinse water suction line prior to moving or storing 
the instrument.

1 Remove all of the installed microchips from the instrument.
Store all microchips according to "7.3.2 Microchip Storage" P.239.

2 Remove both of the rinse water tubes from the glass rinse water bottle, and place them 
on a clean surface.

Do NOT touch the suction filter with bare hands.

3 Discard the rinse water remaining in the glass rinse water bottle.

4 Perform [Probe Rinse] three times.

^ Reference
"4.5.8 Wash" P.119

5 Discard any waste fluid remaining in the waste container.

^ Reference
"3.3.2 Checking the Waste Container" P.28

! WARNING

• Do NOT lift the instrument by the top or front cover. Use care when handling the cables and tubing 
connected to the instrument.

! CAUTION

• Ensure that these instruction manuals are transferred if the user or site of use changes.

• Contact your Shimadzu representative for product installation, adjustment, or re-installation after 
product movement, or for service and repairs.
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7.1.2 Cleaning with Ethanol
If this instrument will be unused for longer than 2 weeks, follow the procedures below to clean the rinse 
water suction line with ethanol.

1 Perform procedures 1 to 5 in "7.1.1 Rinse Water Removal" P.237.

2 Put at least 300 mL of ethanol in a beaker or similar container and insert both of the 
rinse water tubes into the container.

3 Perform [Probe Rinse] three times.

^ Reference
"4.5.8 Wash" P.119

4 Remove the rinse water tubes from the ethanol, and place them on a wipe or other dust-
free surface.

5 Perform [Probe Rinse] three times.

6 Discard any waste fluid remaining in the waste container.

^ Reference
"3.3.2 Checking the Waste Container" P.28

7.2 Instrument Relocation
Observe the following precautions when relocating the instrument.

! CAUTION

• Before moving the instrument, the drives must be fastened with the transportation fixtures.
Contact your Shimadzu service representative.

• Remove the LAN cable that connects to the PC.

• Do NOT hold the top cover when moving the instrument.

• Take care to prevent your hands and fingers being caught in gaps in the instrument exterior.
This may result in injury.

• Do NOT bump the instrument or subject it to excessive vibrations.
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7.3 Storage

7.3.1 Instrument Storage
The following conditions must be satisfied when storing the instrument.

• Site with minimal temperature variations
• Dust should be minimal.
• Vibrations should be minimal.
• No corrosive gases should be produced at the site.
• No significant magnetic fields or abnormal radio waves should be present.
• The instrument should not be subject to jarring or excessive vibrations.

7.3.2 Microchip Storage
If microchips are not to be used for a long period (two weeks or more), perform [Chip Washing] (see "4.5.8 
Wash" P.119) and then return them to their original plastic case for storage. They may become 
contaminated with dust if left installed in the instrument.

 

• If separation buffer is left in the microchip flow channels or on the surface, and it is allowed to dry, salts 
and polymers will precipitate, rendering the chip unusable. If rinsing with the instrument is insufficient, 
rinse them manually as per "6.2.6 Inspecting and Washing Microchip Reservoirs" P.204.

• The plastic case they were in when purchased has been treated with a desiccant. Be sure that the 
microchips are dry for storage.

7.3.3 Peristaltic Pump Storage
If the instrument will be stored for an extended period (for 1 month or more), remove and store the 
peristaltic pump cartridge. However, if "4.5.10 Periodic Maintenance" P.120 will be performed during this 
time (within 1 month), the pump cartridge does not need to be removed. If the pump cartridge is not 
removed for an extended period (3 months or more) and periodic maintenance is not performed, pump 
performance may decrease. If this occurs, replace the pump cartridge according to the procedure 
described in "6.3.6 Pump Cartridge Replacement" P.223.

7.4 Inspection Following Long-Term Storage
Check the following points before using the instrument after it has been stored for an extended period.

If the instrument has been stored in a cold state and not used for a long period, perform a warming up 
operation.

Operation of the instrument in a cold state may cause drive shaft errors (home position sensing error). If 
repeated warming up operations do not resolve these errors, contact your Shimadzu service 
representative.
For details on the warming up operation procedure, see "7.5 Warming Up Operation" P.240.

7.4.1 Connections
Verify that the instrument and PC are connected properly, as per "3.2 Startup and Shutdown" P.22.
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7.4.2 Syringe

1 Remove the syringe cover as per "6.3.4 Plunger Replacement" P.213, step 3.

2 Select [Wash] on the [Instrument] menu in the MultiNA window and select [Probe Rinse].

3 The syringe plunger moves up and down (water supply operation), verify that no air 
bubble forms on the syringe tip.
If an air bubble remains, remove the syringe as per "6.3.4 Plunger Replacement" P.213, remove the air 
(Procedure 7), and then reattach it.

4 Replace the syringe cover.

7.4.3 Checking Analysis Performance
Inspect the analysis performance according to "4.5.6 Check Analysis Performance" P.114.

7.5 Warming Up Operation
Follow the procedure below to perform a warming up operation.

1 Turn ON the instrument.

2 Start the control software, and confirm that the instrument and PC are connected.

3 Select [Move All Axes to Home Position] from the [Instrument] menu in the MultiNA 
window.

4 Wait for 30 minutes, with the top cover closed.

5 After 30 minutes, operate the instrument as usual.
If the error continues, wait another 30 minutes before starting the instrument.
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8Troubleshooting

8.1 Troubleshooting
This section describes typical causes and corrective measures sorted by the "Symptom". Refer to the 
"Reference Page" in the table below for detailed corrective measures.

If the symptom is not remedied by the corrective measures described, or if the problem has not been 
described, contact your Shimadzu service representative.

! CAUTION

• If the instrument malfunctions, contact your Shimadzu service representative immediately.

• When removing the microchips, rinse them with water according to "6.2.6 Inspecting and Washing 
Microchip Reservoirs" P.204.
If the instrument is left unchecked after malfunctioning, the microchip and sample probe may become blocked 
due to dried separation buffer.

• If the instrument is shut down by a power failure rather than a malfunction, rinse the microchips 
according to the procedures above, and rinse the sample probe according to "6.2.2 Sample Probe 
and Aspirator" P.200.
After rinsing, verify that the sample probe is not obstructed according to "6.3.4 Plunger Replacement" P.213.

Symptom Typical Causes Corrective Measures

Before Analysis

The indicator LED is not lit, 
even though the power is 
ON.

The power cable is not plugged in. Plug in the power cable into the outlet properly. "9.3.1 
Connecting the Instrument to the Power Outlet" P.267

The power supplied does not meet the 
specifications for the instrument.

Use a power supply that meets the power 
specifications for the instrument. "9.3.1 Connecting the 
Instrument to the Power Outlet" P.267

A fuse has blown. Replace the fuses as per "6.3.10 Fuse Replacement" 
P.234.

The instrument and PC are 
not connected.

The LAN cable is not connected. Connect the LAN cable properly.

The PC or instrument IP address is not 
set properly.

Set the IP address as per "9.5.2 IP Address" P.274.

The instrument is being blocked by the 
PC's Windows firewall.

Confirm that the [MultiNA Control Software] check box 
has been selected on the [Exceptions] tab in the 
[Control Panel] - [Windows Firewall].

Communications failed to initialize 
between the instrument and computer.

Switch the instrument power OFF and shut down the 
computer. Next, switch the instrument power ON. 
Lastly, boot the computer and try connecting again.

After Analysis Starts

The baseline fluctuates. Separation buffer and dye are not mixed 
evenly.

Add dye to a new batch of separation buffer, and 
agitate it sufficiently.

Rinse water is insufficient. Verify that there is rinse water in the glass rinse water 
bottle.
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Analysis Results (Peak Resolution)

Peaks do not separate. The correct separation buffer is not 
used.

Check the reagent kit.

The separation buffer or marker has 
deteriorated.

Verify that they have been stored at the specified 
temperature, and that they have not exceeded their 
"use by" date.

The microchips have deteriorated. Perform the procedure described in "4.5.6 Check 
Analysis Performance" P.114 and then check the 
condition of the microchip. If the microchip fails in the 
inspection, perform the procedure described in "6.2.9 
Chip Cleaning" P.209 or replace the microchip with a 
new one.

The sample concentration or salt 
concentration in the sample is too high.

Dilute the sample.
Desalt the sample.

An air bubble has formed in the syringe. Examine the inside of the syringe according to "6.3.4 
Plunger Replacement" P.213. If an air bubble has 
formed, remove the syringe, remove the air bubble 
(step 7), and then reattach the syringe.
If the symptom is not remedied, replace the syringe.

The prescribed sample quantity is not 
added to the reservoir.
The sample probe has deteriorated 
(due to blockage or bending).

Contact your Shimadzu service representative.

The ladder does not 
separate in the first 
analysis.

Microchip washing is insufficient.
More than two weeks have elapsed 
since the last analysis was performed.

Before analysis, automatically rinse the microchips 
(see "4.5.8 Wash" P.119).
Perform [Probe Rinse].

Analysis Results (Peak Detection Position)

The peak detection position 
fluctuates for the same 
microchip.

The room temperature has changed 
suddenly.

Install the instrument in a room with as little thermal 
variation as possible.

The correct separation buffer is not 
used.

Check the reagent kit used.

The microchip is clogged. Remove the microchips and rinse them with water as 
per "6.2.6 Inspecting and Washing Microchip 
Reservoirs" P.204. If the obstruction is not removed, 
replace with new microchips.

Separation buffer and dye are not mixed 
evenly.

Agitate the separation buffer solution thoroughly.

There is a difference in 
peak detection times 
between multiple 
microchips.

A deteriorated microchip is used. Contamination within the microchip channels can lead 
to slower peak detection times.
Perform the procedure described in "4.5.6 Check 
Analysis Performance" P.114 and then check the 
condition of the microchip. If the microchip fails in the 
inspection, perform the procedure described in "6.2.9 
Chip Cleaning" P.209 or replace the microchip with a 
new one.

Symptom Typical Causes Corrective Measures
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Analysis Results (Peak Detection State)

None of the microchips 
detect peaks for markers or 
samples.

Incorrect usage of microchips, reagent, 
rinse water, glass rinse water bottle, or 
waste container.

Verify that the microchips, reagent, rinse water, glass 
rinse water bottle, and waste containers have been 
used properly. If the problem reappears after 
confirmation, contact your Shimadzu service 
representative.

The sample salt concentration is too 
high.

Check that the salt concentration in the sample is within 
the permissible salt concentration range of the reagent 
kit.

The microchip surface is contaminated. Check the microchip surfaces for contamination. If they 
are contaminated, rinse them (see "6.2.6 Inspecting 
and Washing Microchip Reservoirs" P.204).

Upper marker or lower 
marker peaks are detected, 
but the sample/ladder 
peaks are not.

The sample concentration is lower than 
the concentration limit of detection.

Check the specifications for the minimum concentration 
for the reagent kit used.

The sample size is outside of the size 
range for the separation buffer.

Check the size range specifications for the reagent kit 
used.

On-chip mixing mode:
The volume of sample solution in the 
sample tubes is less than the 
prescribed quantity.

For on-chip mixing, provide at least 5 µL of sample. 
Attach the aluminum seal to the sample plate to 
prevent evaporation.

On-chip mixing mode:
The sample solution evaporates inside 
the instrument, reducing the volume.

Attach the aluminum seal to the sample plate.

Only lower marker peaks 
are detected. Upper marker 
and sample/ladder peaks 
are not detected.

Dye is not added to the separation 
buffer. 
The dye added to the separation buffer 
has deteriorated.

Use new separation buffer to which freshly prepared 
dye solution is added.

Although the lower marker 
and sample/ladder peaks 
are detected, the upper 
marker is not detected.

The marker solution has degraded. Check whether the solution was stored at the specified 
temperature, whether the solution was excessively 
agitated in a vortex mixer, etc., or whether the solution 
is still within the recommended usage period.

The sample concentration or salt 
concentration in the sample is too high.

Dilute the sample.
Desalt the sample.

Enzymes in the sample were not 
inactivated.

Inactivate the enzyme activity according to the 
manufacturer's instruction.

The sample/ladder peaks 
are detected, but the 
marker peaks are not.

Premix mode The marker solution has not been mixed with the 
sample/ladder.
Verify that the marker solution was mixed with the 
sample/ladder.

Analysis Results (Peak Height)

There is a difference in 
peak detection sensitivity 
between chip positions.

The microchip surfaces are 
contaminated.

If the surfaces are contaminated, rinse them (see "6.2.6 
Inspecting and Washing Microchip Reservoirs" P.204).

Microchip flow channel positions are 
offset from the detector.

If the microchips were rinsed manually, verify that they 
are positioned properly in the chip frame (see "6.2.6 
Inspecting and Washing Microchip Reservoirs" P.204).

The objective lens is contaminated. Clean the objective lens (see "6.2.7 Chip Stage and 
Objective Lens" P.207).

Analysis Results (Peak Recognition)

Peaks other than the 
marker peaks are 
recognized as marker 
peaks.

Another peak near the marker is 
mistakenly recognized as the marker.

Set the correct marker peak using the [Manual Edit 
Mode] accessible from the [Reanalysis] menu in the 
Viewer window (see "5.7.2 Manual Edit Mode" P.185).

Symptom Typical Causes Corrective Measures
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8.2 Error Messages

8.2.1 MultiNA Control Software
Errors are classified as "fatal", "error", or "warning" depending on the details. Point to [View] menu on the 
MultiNA window and select [Log]. The error details will be displayed even after the message window has 
been closed.

^ Reference
"4.4.3 Log" P.105

Check the following items when an error message is displayed.

1 Where did the error occur in the analysis schedule?
Find the location of the error in the MultiNA window well status display or analysis schedule status display. 
The error location can also be found using the well display in Viewer window.

^ Reference
"4.1.3 Well Status Display" P.75, "4.1.4 Analysis Schedule List" P.76, "5.1.4 Well Display" P.129

The ladder fragment peaks 
are confused with 
inappropriate peaks.

A peak not derived from the ladder is 
mistakenly recognized as a ladder-
derived peak.

Set the correct fragment peak using the [Manual Edit 
Mode] accessible from the [Reanalysis] menu in the 
Viewer window (see "5.7.2 Manual Edit Mode" P.185).

Analysis Results (Size Accuracy)

Analysis performance 
deviates from specification 
around the lower end of the 
size range.

The ladder size and target fragment 
size are too far separated from one 
another.

Use an optional ladder or user ladder instead.
Adjust the diluted ladder solution according to the salt 
concentration of the sample. Because measurement 
peaks tend to be lower as salt concentration increases, 
increase the concentration of the ladder until peak 
detection is performed correctly. 
Ex) DNA-12000

Ladder concentration: 20 ng/μL
Ladder salt concentration: 50 mM KCl

Use a different type of calibration curve.

The estimated size value is 
different from the actual 
size.

The sample concentration is too high. A high sample concentration can cause a small 
estimated size value. Dilute the sample.

The nucleic acid in the sample was 
formed into structures.

If the nucleic acid in the sample is not linear, the 
estimated size value may differ from the actual size.

Printing

The contents displayed in 
the print preview are not 
printed properly.

An older version of the printer driver is 
being used.

Obtain and install the newest printer driver from the 
printer manufacturer. If the problem persists, contact 
your Shimadzu service representative.

Symptom Typical Causes Corrective Measures
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2 Where did the error occur in the instrument?
The source is displayed at the end of the error message (shown in the frame on the sample message in 
the figure below). The source can also be found by clicking [View] - [Log]. The source is noted in the 
[Source] column.

Typical causes and corrective measures are described by type and source of error.

If the same error occurs repeatedly even after taking the described corrective measures, or if a message 
occurs that is not described here, contact your Shimadzu service representative and explain the message 
details.
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Fatal
A "fatal" error means that the instrument must be checked. Use of the instrument in its current state is 
either impossible or dangerous.

If this type of error occurs, the instrument immediately shuts down and a buzzer sounds until the 
instrument power supply is turned OFF. Immediately turn OFF the instrument power supply. Check the 
error message displayed on the PC and perform the corrective measures described in the following table.

 

Source Message Typical Causes and Corrective Measures

Temperature 
Control

Temperature error. 
(Unchanged 
temperature) - 
Immediately turn 
OFF power switch.
       |
(Click [OK])
       |
Remove the 
microchips and 
wash them 
immediately.

<Typical Causes>
• The environment temperature is outside the installation condition range 

(low temperature).
• The chip base temperature fuse has blown.
<Instrument Operations>
The analysis schedule is immediately aborted. The microchips are not rinsed.
<Corrective Measures>
• Turn the instrument OFF immediately. 
• If the temperature in the installation environment is low, warm the room 

temperature using a heater to within the installation condition range (18 °C 
to 28 °C).

• Wait until the inside of the instrument has warmed up and then turn the 
instrument back ON.

If this fails to correct the error, turn the instrument OFF immediately.
• Contact your Shimadzu service representative. 
• Open the top cover.
• If the autosampler and pneumatic unit are at the home position, open the 

chip cover, remove the microchips, and wash them with water according to 
the procedure described in "6.2.6 Inspecting and Washing Microchip 
Reservoirs" P.204.

Temperature error. 
(Initial temperature 
is below lower 
limit.) - 
Immediately turn 
OFF power switch.

<Details>
The chip stage temperature was below the lower limit (10 °C).
<Typical Causes>
• The environment temperature is outside the installation condition range 

(low temperature).
• The chip stage is cold because the instrument was stored in a low 

temperature environment.
<Instrument Operations>
The temperature control function has not started.
<Corrective Measures>
• Immediately turn OFF the instrument power supply.
• If the temperature in the installation environment is low, warm the room 

temperature using a heater to within the installation condition range (18 °C 
to 28 °C).

• Wait until the inside of the instrument has warmed up and then turn the 
instrument back ON.

If this fails to correct the error, contact your Shimadzu service representative. 
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Communi-
cation Port 
(M)

Transmit retry 
error. 
Immediately turn 
OFF power switch.
       |
(Click [OK])
       |
Remove the 
microchips and 
wash them 
immediately.

<Typical Causes>
The instrument has communication fault with local system.
<Instrument Operations>
The analysis schedule is immediately aborted. 
The microchips are not rinsed.
<Corrective Measures>
• Turn the instrument OFF immediately. 
• Contact your Shimadzu service representative. 
• Open the top cover.
• If the autosampler and pneumatic unit are at the home position, open the 

chip cover, remove the microchips, and wash them with water according to 
the procedure described in "6.2.6 Inspecting and Washing Microchip 
Reservoirs" P.204.

High Voltage 
ch1
High Voltage 
ch2
High Voltage 
ch3
High Voltage 
ch4

Abnormal voltage 
error. Immediately 
turn OFF power 
switch.
       |
(Click [OK])
       |
Remove the 
microchips and 
wash them 
immediately.

<Details>
A constant voltage was detected when no high voltage was applied or, the 
voltage detected was outside of the specified range.
<Typical Causes>
Malfunction of the high voltage board
<Instrument Operations>
The analysis schedule is immediately aborted. 
The microchips are not rinsed.
<Corrective Measures>
• Turn the instrument OFF immediately. 
• Contact your Shimadzu service representative. 
• Open the top cover.
• If the autosampler and pneumatic unit are at the home position, open the 

chip cover, remove the microchips, and wash them with water according to 
the procedure described in "6.2.6 Inspecting and Washing Microchip 
Reservoirs" P.204.

Power 24 V power supply 
error. Immediately 
turn OFF power 
switch. 
       |
(Click [OK])
       |
Remove the 
microchips and 
wash them 
immediately.

<Details>
The voltage of the 24 V internal power supply exceeded the normal range 
during operation.
<Typical Causes>
 The control PCB or power supply unit is broken.
<Instrument Operations>
The analysis schedule is immediately aborted. 
The microchips are not rinsed.
<Corrective Measures>
• Turn the instrument OFF immediately. 
• Contact your Shimadzu service representative. 
• Open the top cover.
• If the autosampler and pneumatic unit are at the home position, open the 

chip cover, remove the microchips, and wash them with water according to 
the procedure described in "6.2.6 Inspecting and Washing Microchip 
Reservoirs" P.204.

15 V power supply 
error. Immediately 
turn OFF power 
switch.
       |
(Click [OK])
       |
Remove the 
microchips and 
wash them 
immediately.

<Details>
The voltage of the 15 V internal power supply exceeded the normal range 
during operation.
<Typical Causes>
The control PCB or power supply unit is broken.
<Instrument Operations>
The analysis schedule is immediately aborted. 
The microchips are not rinsed.
<Corrective Measures>
• Turn the instrument OFF immediately. 
• Contact your Shimadzu service representative. 
• Open the top cover.
• If the autosampler and pneumatic unit are at the home position, open the 

chip cover, remove the microchips, and wash them with water according to 
the procedure described in "6.2.6 Inspecting and Washing Microchip 
Reservoirs" P.204.

Source Message Typical Causes and Corrective Measures
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Error
The "error" category refers to a problem that renders continued automatic analysis impossible.

There are two types depending on the details: "aborted immediately" and "analysis will be completed for 
samples now loading or under analysis".

In some cases automatic rinsing (which includes rinsing the chips with water) is performed before analysis 
completion, while in other cases, it is not performed.

Source Message Typical Causes and Corrective Measures
(Not Displayed)
Error occurs 
before analysis 
begins.

Cannot start 
analysis schedule.
+ 24 V DC power 
supply is not ready.

<Details>
The internal control voltage did not stabilize.
<Typical Causes>
• The power supply is broken.
• Analysis was started immediately after turning the power ON or 

immediately after waking from sleep mode.
<Instrument Operations>
Analysis does not start.
<Corrective Measures>
• Wait for about 10 seconds and then start the analysis again.
• If analysis still does not start, turn the instrument power OFF once 

and then turn it back ON again.
If the corrective measure above does not solve the problem, contact your 
Shimadzu service representative.

Cannot start 
analysis schedule.
+ 15 V DC power 
supply is not ready.

<Details>
The internal control voltage did not stabilize.
<Typical Causes>
• The power supply is broken.
• Analysis was started immediately after turning the power ON or 

immediately after waking from sleep mode.
<Instrument Operations>
Analysis does not start.
<Corrective Measures>
• Wait for about 10 seconds and then start the analysis again.
• If analysis still does not start, turn the instrument power OFF once 

and then turn it back ON again.
If the corrective measure above does not solve the problem, contact your 
Shimadzu service representative.
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(Not Displayed)
The error occurs 
during analysis 
confirmation.

Cannot continue. 
Sample holder is 
not present.

<Typical Causes>
• The sample holder is not properly installed.
• The sensor that detects the sample holder is broken.
• The number of runs for the sample probe has exceeded the 

replacement guideline.
<Instrument Operations>
Analysis does not start.
<Corrective Measures>
Verify that the sample holder is properly installed ("3.5.4 Sample Holder 
Installation" P.50).
If the problem is not corrected, contact your Shimadzu service 
representative.

Cannot continue. 
Chip # is not 
present.

<Typical Causes>
• The microchips specified in the [Chip Management] window are not 

properly installed.
• The sample probe is damaged.
• The sensor that detects microchips is broken.
• The number of runs for the sample probe has exceeded the 

replacement guideline.
<Instrument Operations>
Analysis does not start.
<Corrective Measures>
Verify that the microchips are properly installed. ("3.3.5 Microchip 
Installation" P.32). 
If the problem is not corrected, contact your Shimadzu service 
representative.

Cannot continue. 
Remaining amount 
of separation buffer 
xxxx is not 
sufficient.

<Details>
The volume of separation buffer in the reagent holder is deemed to be 
less than the required amount as a result of liquid level detection by the 
sample probe.
<Typical Causes>
• Separation buffer is placed at an incorrect position.
• The volume of separation buffer placed in the reagent holder was 

insufficient.
• The sample probe is bent.
• The sensor that detects the liquid level is broken.
<Instrument Operations>
Analysis does not start.
<Corrective Measures>
Dispense at least the required amount of separation buffer into a 
recommended container, and place it in the correct reagent holder 
position ("4.1.6 Reagent Information" P.77).
If the problem is not corrected, contact your Shimadzu service 
representative.

Cannot continue. 
Remaining amount 
of marker solution 
xxxx is not 
sufficient.

<Details>
The volume of marker solution in the reagent holder is deemed to be less 
than the required amount as a result of liquid level detection by the 
sample probe.
<Typical Causes>
• Marker solution is placed at an incorrect position.
• The volume of marker solution placed in the reagent holder was 

insufficient.
• The sample probe is bent.
• The sensor that detects the liquid level is broken.
<Instrument Operations>
Analysis does not start.
<Corrective Measures>
Dispense at least the required amount of separation buffer into a 
recommended container, and place it in the correct reagent holder 
position ("4.1.6 Reagent Information" P.77).
If the problem is not corrected, contact your Shimadzu service 
representative.

Source Message Typical Causes and Corrective Measures
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(Not Displayed)
The error occurs 
during analysis 
confirmation.

Cannot continue. 
Remaining amount 
of chip cleaning 
solution is not 
sufficient.

<Details>
The volume of chip cleaning solution in the reagent holder is deemed to 
be less than the required amount as a result of liquid level detection by 
the sample probe.
<Typical Causes>
• Chip cleaning solution was placed at an incorrect position.
• The volume of chip cleaning solution placed in the reagent holder 

was insufficient.
• The sample probe is bent.
• The sensor that detects the liquid level is broken.
<Instrument Operations>
Analysis does not start.
<Corrective Measures>
Dispense at least the required amount of chip cleaning solution into a 
recommended container, and place it in the correct reagent holder 
position ("4.1.6 Reagent Information" P.77).
If the problem is not corrected, contact your Shimadzu service 
representative.

I/O Top cover switch 
error. Immediately 
turn OFF power 
switch.
       |
(Click [OK])
       |
Remove the 
microchips and wash 
them immediately.

<Typical Causes>
The top cover has opened during operation or it was not closed securely.
<Instrument Operations>
The analysis schedule is immediately aborted. The microchips are not 
rinsed.
<Corrective Measures>
(1) Open the top cover, and close it again securely.
(2) Perform the procedures in "4.5.5 Move All Axes to Home Position" 

P.114.
(3) Open the top cover and chip cover, remove the microchips, and rinse 

them according to "6.2.6 Inspecting and Washing Microchip 
Reservoirs" P.204.

(4) Reenter the analysis schedule before proceeding with analysis.
If the problem is not corrected, contact your Shimadzu service 
representative.

Chip cover switch 
error. Immediately 
turn OFF power 
switch.
       |
(Click [OK])
       |
Remove the 
microchips and wash 
them immediately.

<Typical Causes>
The chip cover has opened during operation or it was not closed 
securely.
<Instrument Operations>
The analysis schedule is immediately aborted. The microchips are not 
rinsed.
<Corrective Measures>
(1) Open the top cover, and securely close the chip cover.
(2) Close the top cover, and perform the procedures in "4.5.5 Move All 

Axes to Home Position" P.114
(3) Open the top cover and chip cover, remove the microchips, and rinse 

them according to "6.2.6 Inspecting and Washing Microchip 
Reservoirs" P.204.

(4) Reenter the analysis schedule before proceeding with analysis.
If the problem is not corrected, contact your Shimadzu service 
representative.

Source Message Typical Causes and Corrective Measures
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Autosampler X
Autosampler Y
Autosampler Z
Syringe unit
Pneumatic unit Y
Pneumatic unit Z

Home position 
sensing error.
       |
(Click [OK])
       |
(After finishing 
analysis schedule)
Remove the 
microchips and wash 
them immediately.

<Typical Causes>
The position of drives is out of alignment due to interference, wear, or 
vibration.
<Instrument Operations>
Analysis of the sample is aborted at the time the error occurred. Analysis 
is completed for the samples currently under analysis or now loading. 
Then the analysis schedule is aborted. The microchips are not rinsed.
<Corrective Measures>
(1) Open the top cover, and determine if the axes are interfering with 

each other.
(2) If no interference is found, close the top cover, and perform the 

procedures in "4.5.5 Move All Axes to Home Position" P.114.
(3) Open the top cover and chip cover, remove the microchips, and rinse 

them according to "6.2.6 Inspecting and Washing Microchip 
Reservoirs" P.204.

(4) Contact your Shimadzu service representative.
Autosampler Z Level sensor 

detection error. 
(Detection area 
ended)
       |
(Click [OK])
       |
(After finishing 
analysis schedule)
Remove the 
microchips and wash 
them immediately.

<Typical Causes>
• Leaks or evaporation have depleted the reagent volume.
• The sensor that detects the liquid level is broken.
<Instrument Operations>
Analysis of the sample is aborted at the time the error occurred. Analysis 
is completed for the samples currently under analysis or now loading. 
Then the analysis schedule is aborted. The microchips are not rinsed.
<Corrective Measures>
(1) Open the top cover, and determine if the axes are interfering with 

each other.
(2) If no interference is found, close the top cover, and perform the 

procedures in "4.5.5 Move All Axes to Home Position" P.114.
(3) Open the top cover and chip cover, remove the microchips, and rinse 

them according to "6.2.6 Inspecting and Washing Microchip 
Reservoirs" P.204.

(4) Reenter the analysis schedule before proceeding with analysis.
If the problem is not corrected, contact your Shimadzu service 
representative.

Autosampler Z Level sensor 
detection error. 
(Inconsistent 
amount of liquid)
       |
(Click [OK])
       |
(After finishing 
analysis schedule)
Remove chips and 
wash them 
immediately.

<Typical Causes>
• The level of the separation buffer or marker solution has risen.
• Liquid remained in the microchip reservoir after an aspirator suction 

operation.
• The sample probe is blocked by foreign material.
<Instrument Operations>
Analysis of the sample is aborted at the time the error occurred. Analysis 
is completed for the samples currently under analysis or now loading. 
Then the analysis schedule is aborted. The microchips are not rinsed.
<Corrective Measures>
(1) Open the top cover, and determine if the axes are interfering with 

each other.
(2) If no interference is found, close the top cover, and perform the 

procedures in "4.5.5 Move All Axes to Home Position" P.114.
(3) Open the top cover and chip cover, remove the microchips, and rinse 

them according to "6.2.6 Inspecting and Washing Microchip 
Reservoirs" P.204.

(4) Reenter the analysis schedule before proceeding with analysis.
If the problem is not corrected, contact your Shimadzu service 
representative.

Source Message Typical Causes and Corrective Measures
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Autosampler Z Shock sensor 
detection error. 
(Detection fault)
       |
(Click [OK])
       |
(After finishing 
analysis schedule)
Remove chips and 
wash them 
immediately.

<Typical Causes>
The sample plate or sample tube is not properly installed.
<Instrument Operations>
Analysis of the sample is aborted at the time the error occurred. Analysis 
is completed for the samples currently under analysis or now loading. 
Then the analysis schedule is aborted. The microchips are not rinsed.
<Corrective Measures>
(1) Open the top cover, and determine if the axes are interfering with 

each other.
(2) If no interference is found, close the top cover, and perform the 

procedures in "4.5.5 Move All Axes to Home Position" P.114.
(3) Open the top cover and chip cover, remove the microchips, and rinse 

them according to "6.2.6 Inspecting and Washing Microchip 
Reservoirs" P.204.

(4) Properly position the sample, and reenter the analysis schedule 
before proceeding with analysis.

If the problem is not corrected, contact your Shimadzu service 
representative.

Autosampler X
Autosampler Y
Autosampler Z

Shock sensor 
detection error. 
(False detection)
       |
(Click [OK])
       |
(After finishing 
analysis schedule)
Remove chips and 
wash them 
immediately.

<Typical Causes>
• The sample holder is not properly installed. 
• The shock sensor is blocked by foreign material.
<Instrument Operations>
Analysis of the sample is aborted at the time the error occurred. Analysis 
is completed for the samples currently under analysis or now loading. 
Then the analysis schedule is aborted. The microchips are not rinsed.
<Corrective Measures>
(1) Open the top cover. Check on the sample holder installation and for 

drive axis interference.
(2) If no interference is found, close the top cover, and perform the 

procedures in "4.5.5 Move All Axes to Home Position" P.114.
(3) Open the top cover and chip cover, remove the microchips, and rinse 

them according to "6.2.6 Inspecting and Washing Microchip 
Reservoirs" P.204.

(4) Properly install the sample holder, and reenter the analysis schedule 
before proceeding with analysis.

If the problem is not corrected, contact your Shimadzu service 
representative.

Temperature 
Control

Temperature error. 
(Temperature 
exceeds upper 
limit.)

<Typical Causes>
The environment temperature is outside the installation condition range 
(high temperature).
<Instrument Operations>
The analysis schedule is not aborted. The microchips are rinsed.
<Corrective Measures>
• If the temperature in the installation environment is high, cool the 

room temperature using a cooler to within the installation condition 
range (18 °C to 28 °C).

If the problem is not corrected, contact your Shimadzu service 
representative.

Temperature 
timeout error.

<Typical Causes>
• The environment temperature is outside the installation condition 

range (low temperature).
• The chip base temperature fuse is blown.
<Instrument Operations>
The analysis schedule is not aborted. The microchips are rinsed.
<Corrective Measures>
• Turn the instrument OFF, and then turn it ON again.
• If the temperature in the installation environment is low, warm the 

room temperature using a heater to within the installation condition 
range (18 °C to 28 °C).

If the problem is not corrected, contact your Shimadzu service 
representative.

Source Message Typical Causes and Corrective Measures
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Network 
Connection

Failed to connect to 
port 1.

<Typical Causes>
Communication between the instrument and PC could not be performed.
<Corrective Measures>
1) Verify that the instrument is ON and that the instrument and PC are 

properly connected by a LAN cable. 
2) Then connect them according to "3.2 Startup and Shutdown" P.22.
If the problem is not corrected, contact your Shimadzu service 
representative.

No response from 
port 1. Connection 
closed.
       |
(Click [OK])
       |
Connection error. 
Unable to check chip 
status. 
Remove the 
microchips and 
immediately wash 
them.

<Typical Causes>
During communication between the instrument and PC, communication 
from the instrument was disrupted for more than 10 seconds so the 
connection was closed.
<Instrument Operations>
The analysis schedule is interrupted during execution. If the instrument is 
operable, the microchips are rinsed.
<Corrective Measures>
1) Verify that the instrument is ON and that the instrument and PC are 

properly connected by a LAN cable.
2) Establish a connection according to the procedure described in "3.2 

Startup and Shutdown" P.22.
3) If the instrument is in an operable state, return the drives to the home 

position according to the procedure described in "6.1.1 Moving All 
Axes to Home Position" P.198.

If the problem is not corrected, contact your Shimadzu service 
representative.

No transmission 
from port 2. 
Connection closed.
       |
(Click [OK])
       |
Connection error. 
Unable to check chip 
status.
Remove the 
microchips and 
immediately wash 
them.

<Typical Causes>
During communication between the instrument and PC, communication 
from the instrument was disrupted for more than 10 seconds so the 
connection was closed.
<Instrument Operations>
The analysis schedule is interrupted during execution. If the instrument is 
operable, the microchips are rinsed automatically.
<Corrective Measures>
1) Verify that the instrument is ON and that the instrument and PC are 

properly connected by a LAN cable.
2) Establish a connection according to the procedure described in "3.2 

Startup and Shutdown" P.22.
3) If the instrument is in an operable state, return the drives to the home 

position according to the procedure described in "6.1.1 Moving All 
Axes to Home Position" P.198.

If the problem is not corrected, contact your Shimadzu service 
representative.

Source Message Typical Causes and Corrective Measures
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High Voltage ch1
High Voltage ch2
High Voltage ch3
High Voltage ch4

Chip # has an error.
       |
(Clicking [OK])
       |
(At analysis schedule 
end)
Error occurred. 
Chip # is now 
unavailable.

<Details>
The test current value for the chip that generated "fill check NG" was also 
outside the standard range after the separation buffer refill.
<Instrument Operations>
The microchip that generated the error is washed automatically and 
becomes unavailable in the software.
The analysis schedule is rescheduled and continues to execute only 
using the available microchips.
<Corrective Measures>
• After analysis, open the top cover and chip cover and remove the 

affected microchip.
• Confirm that it is unobstructed according to the procedure described 

in "6.2.6 Inspecting and Washing Microchip Reservoirs" P.204.
• To reuse a microchip that was unobstructed (or for which the 

blockage was resolved), clear the unavailable state according to the 
procedure described in "4.5.3 Chip Management" P.110.

Overcurrent error. <Details>
An excessive current value was detected.
<Typical Causes>
• A short circuit was caused by leaking separation buffer or sample 

solution on the microchip surface where the sample's salt 
concentration was outside the specification range.

<Instrument Operations>
Analysis is aborted for the sample being analyzed at the time the error 
occurred. Subsequent sample analyses proceed, ending with automatic 
rinsing of the microchips.
<Corrective Measures>
• Check that the salt concentration of the sample is within the 

specification range.
• After analysis is complete, check the microchip surfaces and chip 

stage for separation buffer or sample solution. 
If spillage occurred, clean the microchips and chip stage according to 
the procedure described in "6.2.6 Inspecting and Washing Microchip 
Reservoirs" P.204 and "6.2.7 Chip Stage and Objective Lens" P.207.

Undercurrent error. <Details>
An insufficient current value has been detected.
<Typical Causes>
• The microchip was clogged.
• Air bubbles were mixed into the separation channel.
<Instrument Operations>
Analysis is aborted for the sample being analyzed at the time the error 
occurred. Subsequent sample analyses proceed, ending with automatic 
rinsing of the microchips.
<Corrective Measures>
• Return the drives to home position as in "6.1.1 Moving All Axes to 

Home Position" P.198. 
• Open the top cover and chip cover and remove the affected 

microchip.
• Rinse the microchips according to the procedure described in "6.2.6 

Inspecting and Washing Microchip Reservoirs" P.204.

Source Message Typical Causes and Corrective Measures
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High Voltage ch1
High Voltage ch2
High Voltage ch3
High Voltage ch4

Current accuracy 
error
       |
(Click [OK])
       |
(At analysis schedule 
end)
Error occurred. 
Chip # is now 
unavailable.

<Typical Causes>
The HV voltage monitor value has fallen outside the specified range.
<Instrument Operations>
The microchip that generated the error is washed automatically and 
becomes unavailable in the software.
The analysis schedule is rescheduled and continues to execute only 
using the available microchips.
<Corrective Measures>
• After analysis, open the top cover and chip cover and remove the 

affected microchip.
• Confirm that it is unobstructed according to the procedure described 

in "6.2.6 Inspecting and Washing Microchip Reservoirs" P.204.
• To reuse a microchip that was unobstructed (or for which the 

blockage was resolved), clear the unavailable state according to the 
procedure described in "4.5.3 Chip Management" P.110.

Detector ch1
Detector ch2
Detector ch3
Detector ch4

Cannot detect usable 
signal.
       |
(Click [OK])
       |
(At analysis schedule 
end)
Error occurred. 
Chip # is now 
unavailable.

<Details>
A significant signal was not detected after a certain period after migration 
start.
<Typical Causes>
• No dye added to the separation buffer.
• Malfunction of the detector
<Instrument Operations>
The microchip that generated the error is washed automatically and 
becomes unavailable in the software.
The analysis schedule is rescheduled and continues to execute only 
using the available microchips.
<Corrective Measures>
• After analysis, open the top cover and chip cover and remove the 

affected microchip.
• Confirm that it is unobstructed according to the procedure described 

in "6.2.6 Inspecting and Washing Microchip Reservoirs" P.204.
• To reuse a microchip that was unobstructed (or for which the 

blockage was resolved), clear the unavailable state according to the 
procedure described in "4.5.3 Chip Management" P.110.

Signal exceeded 
measurement limit.
       |
(Click [OK])
       |
(At analysis schedule 
end)
Error occurred. 
Chip # is now 
unavailable.

<Details>
A signal outside the measurement range continued for a given length of 
time.
<Typical Causes>
• The concentration of dye in the separation buffer was incorrect.
• The sample concentration is outside the specification range.
• Stray light entered the detection unit or the detection unit is broken.
<Instrument Operations>
The microchip that generated the error is washed automatically and 
becomes unavailable in the software.
The analysis schedule is rescheduled and continues to execute only 
using the available microchips.
<Corrective Measures>
• Check that conditions such as the separation buffer mix and sample 

concentration are correct.
• After analysis, open the top cover and chip cover and remove the 

affected microchip.
• Confirm that it is unobstructed and the surface is not contaminated 

according to the procedure described in "6.2.6 Inspecting and 
Washing Microchip Reservoirs" P.204.

• To reuse a microchip that was unobstructed (or for which the 
blockage was resolved), clear the unavailable state according to the 
procedure described in "4.5.3 Chip Management" P.110.

Source Message Typical Causes and Corrective Measures
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Warning
A "warning" error means that while automatic analysis may continue, there may be an influence on the data. 

Accurate results may not be obtainable if a "warning" occurs during the analysis sequence. Examine the 
analysis results, and repeat the analysis if there is a problem.

Source Message Cause and Actions

High Voltage 
ch1
High Voltage 
ch2
High Voltage 
ch3
High Voltage 
ch4

Chip # filling check 
error.

<Details>
The test current value for the microchip at chip stage number # was also 
outside the standard range after the separation buffer fill. 
<Typical Causes>
• Microchip obstruction
• The separation buffer used was different to the separation buffer registered 

in the schedule.
<Instrument Operations>
The analysis schedule continues. The applicable microchip is refilled with 
separation buffer.

Current accuracy 
error

<Details>
The HV current monitor value was outside the specification range.
<Typical Causes>
• The salt concentration of the sample was outside the usable range.
• The reagent kit used was different to the reagent kit registered in the 

schedule.
<Instrument Operations>
• Analysis schedule execution continues.
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8.2.2 MultiNA Viewer Data Analysis Software
If the symptom is not remedied by the corrective measures described, or if the problem has not been 
described, contact your Shimadzu service representative.
 

Message Typical Causes Corrective Measures

File-Related Messages

File: (File name) is already opened 
by another MultiNA Viewer 
program. OK to open file in read-
only mode?

The selected file is already open in 
another instance of MultiNA Viewer.

Click [OK] to open the file in read-only 
mode. Click [Cancel] to cancel the file 
open process.

To view analyzed data, select 
[Automatic] from [Reanalysis] 
menu.

There is no analysis (*.MLA) data 
file associated with the selected raw 
(*.MLT) data file.

Select [Automatic] on the 
[Reanalysis] menu and click 
[Standard] to generate an analysis 
(*.MLA) data file.

Some samples do not have a 
usable ladder. To estimate the 
sample's size or concentration, 
select [Change Ladder and 
Analyze] on the [Reanalysis] menu.

A ladder is not entered in the 
analysis schedule or the ladder 
analysis failed. As a result, there 
are samples with no usable ladder 
for analysis in the data file.

Click [Change Ladder and Analyze] 
on the [Reanalysis] menu to add a 
previously analyzed ladder file and 
reanalyze the data.

Cannot open file: (File name) The file is deleted, or the network 
connection has been lost. As a 
result, the file to open does not exist 
or is unreadable.

Use Windows [Explorer] to confirm 
the existence of the file, and 
determine if it is readable.

Cannot write to folder. File will be 
opened in read-only mode. 

The data file to open is located in a 
read-only folder.

Examine the write protection settings 
for the folder, and the remaining disk 
space.

This file is already open in another 
folder.

A data file with the same name in 
another folder is already open.

Close the file with the same name, 
and then reopen the intended file.

File cannot be saved using the 
same name as another file that is 
open in MultiNA Viewer. Specify a 
different name.

The name of the file to be saved is 
the same as that of another file 
already open in MultiNA Viewer.

Specify another file name or close the 
other open file before saving.

Insufficient memory. Close other 
applications or files and retry. 

PC memory is insufficient while 
there was an attempt to open a file 
during analysis, or the user clicked 
[View] - [Refresh] during analysis.

Close the other files open in MultiNA 
Viewer, or close any other 
applications to free up PC memory. 
Then repeat the operations. If this 
memory appears frequently, a PC 
memory upgrade is recommended.

Cannot create CSV file. During export, a CSV file could not 
be created. This is because HDD 
space is insufficient, or the folder is 
write protected.

Check the remaining disk space and 
the folder write permission settings.

Reanalysis Messages

Separation buffer types are 
different. Cannot change ladder.

The user clicked [Change Ladder 
and Analyze] to specify a ladder file, 
but selected a ladder obtained with 
a different type of separation buffer. 

Select a ladder obtained with the 
same type of separation buffer (and 
the same microchip (ID).

Chip ID is different. Cannot change 
ladder.

The user clicked [Change Ladder 
and Analyze] to specify a ladder file, 
but selected a ladder obtained with 
a different microchip (ID).

Select a ladder obtained with the 
same microchip ID (and same type of 
separation buffer).

Ladder validation failed. Cannot 
change ladder.

The user clicked [Change Ladder 
and Analyze], but the ladder 
analysis results for the file specified 
are inappropriate.

Preview the ladder file and select a 
ladder for which appropriate peaks 
and analysis results are obtained.
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Cannot load LDR file. The user clicked [Change Ladder 
and Analyze] and selected a 
corrupted ladder file.

Select another ladder obtained with 
the same microchip ID and type of 
separation buffer
If the problem persists, contact your 
Shimadzu service representative.

Error occurred while processing 
ladder.

A program error occurred when 
opening the ladder file.

Restart the program or the PC. If the 
problem persists, contact your 
Shimadzu service representative.

Error occurred while adding peak. A program error occurred when the 
user selected [Manual Edit Mode] 
and added a peak.

Restart the program or the PC. If the 
problem persists, contact your 
Shimadzu service representative.

Error occurred while deleting peak. A program error occurred when the 
user selected [Manual Edit Mode] 
and deleted a peak.

Restart the program or the PC. If the 
problem persists, contact your 
Shimadzu service representative.

Error occurred while changing 
peak information.

A program error occurred when the 
user selected [Manual Edit Mode] 
and configured a marker peak.

Restart the program or the PC. If the 
problem persists, contact your 
Shimadzu service representative.

Error occurred while setting to 18S 
rRNA peak.

A program error occurred when the 
user selected [Manual Edit Mode] 
and configured 18S rRNA.

Restart the program or the PC. If the 
problem persists, contact your 
Shimadzu service representative.

Error occurred while setting to 28S 
rRNA peak.

A program error occurred when the 
user selected [Manual Edit Mode] 
and configured 28S rRNA.

Restart the program or the PC. If the 
problem persists, contact your 
Shimadzu service representative.

Error occurred while setting to 
lower marker.

A program error occurred when the 
user selected [Manual Edit Mode] 
and configured a lower marker.

Restart the program or the PC. If the 
problem persists, contact your 
Shimadzu service representative.

Error occurred while setting to 
upper marker.

A program error occurred when the 
user selected [Manual Edit Mode] 
and configured a upper marker.

Restart the program or the PC. If the 
problem persists, contact your 
Shimadzu service representative.

Cannot register changes to sample/
ladder (Sample No.,welll name) due 
to the following errors.

The following error occurred when 
the user selected [Manual Edit 
Mode] and edited the sample or 
ladder peaks.

• Too many ladder data peaks 
(ladder fragments and markers). 
Delete peak(s) from ladder data.

The number of peaks is larger than 
the number of detected ladder 
fragments.

Delete all except the ladder fragment 
peaks.

• Not enough ladder data peaks 
(ladder fragments and markers). 
Add peak(s) to ladder data.

The number of peaks is smaller 
than the number of detected ladder 
fragments.

Add ladder fragment peaks.

• Invalid ladder data. Edit ladder or 
select [Change Ladder and 
Analyze] from [Reanalysis] menu.

No marker or fragment peaks are 
detected for the configured ladder.

Select [Manual edit Mode] and 
reconfigure the ladder data marker 
and fragment peaks, or click [Change 
Ladder and Analyze] and repeat the 
analysis using other ladder data.

• Upper marker not found. Designate 
the upper marker.

An upper marker peak is not 
detected.

Add an appropriate peak for the 
upper marker. 

• Lower marker not found. Designate 
the lower marker.

A lower marker peak is not 
detected.

Add an appropriate peak for the lower 
marker. 

Cannot load analysis parameters. "Parameter.ini", a file required 
during analysis, could not be read.

Reinstall the program from the 
MultiNA software CD-ROM provided.

Error occurred while processing 
sample.

A program error occurred during 
analysis.

Restart the program or the PC. If the 
problem persists, contact your 
Shimadzu service representative.

Message Typical Causes Corrective Measures
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Error occurred while reanalyzing. A program error occurred during 
reanalysis.

Restart the program or the PC. If the 
problem persists, contact your 
Shimadzu service representative.

Cannot save LDR file. Ladder analysis data cannot be 
saved to a file.
• The HDD may be full.
• The folder may be write 

protected.

Check the remaining disk space and 
the folder write permission settings.

Cannot save MLA file. The analysis data cannot be saved 
to a file.
• The HDD may be full.
• The folder may be write 

protected.

Check the remaining disk space and 
the folder write permission settings.

[Comparison] Messages

Added data has not been analyzed. 
Cannot compare.
Comparison data has not been 
analyzed. Cannot compare.

The analysis data or file is being 
compared to a file that does not 
contain analysis data.

For the file with no analysis data, 
select [Reanalysis] - [Automatic] to 
create analysis data, and the proceed 
with comparison.

Separation buffer types are 
different. Cannot compare.

An attempt is being made to 
compare data from different 
separation buffers.

Select data with the same separation 
buffers for comparison.

Cannot add data to comparison - 
exceeds upper limit (120 entries).

An attempt is being made to add 
more than 120 data entries to the 
compare table.

Delete unnecessary data before 
adding entries.

Messages Related to Analysis Performance Check Results

To view analysis performance 
check results, select [Automatic] 
from [Reanalysis] menu.

The analysis file contains only raw 
(*.MLT) data, but no corresponding 
analysis (*.MLA) data.

Select [Automatic] on the 
[Reanalysis] menu and click 
[Standard] to generate analysis data.

Cannot start 'Notepad' program. "Notepad.exe" required to display 
the analysis performance inspection 
results, cannot be opened.

If "Notepad.exe" does not exist, install 
it on the PC from the Windows CD-
ROM.
If "Notepad.exe" does exist but the 
problem persists, contact your 
Shimadzu service representative.

Failed to create log file. The analysis performance 
inspection results cannot be saved 
to a file. 
• The HDD may be full.
• The folder may be write 

protected.

Check the remaining disk space and 
the folder write permission settings.

Cannot read current data. The analysis performance check 
results cannot be displayed. The 
analysis data file is likely corrupted.

Repeat the analysis performance 
check with the MultiNA Control 
Software.

Current data length is short. The analysis performance check 
results cannot be displayed. The 
analysis data file is likely corrupted.

Repeat the analysis performance 
check with the MultiNA Control 
Software.

Other Messages

Printer is not installed. Cannot 
print. 

The user has attempted to print, but 
no printer has been configured in 
Windows.

Configure a printer in Windows before 
printing.

No help files found. Install these 
files from MultiNA Setup CD-ROM. 

The help files are not in the program 
folder, or they are corrupted.

Install the files using the provided 
MultiNA software CD-ROM.

Message Typical Causes Corrective Measures
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9 Installation

This instrument will be installed and adjusted by a Shimadzu technician or field engineer. To ensure safe 
product operation, read and follow all of the WARNING and CAUTION instructions given in this section. 
Install the instrument in a proper location.

9.1 Installation Site

9.1.1 Installation Site Preparation
To ensure safe and proper use of this instrument, observe the following conditions and install the 
instrument in a proper location.

! WARNING

• Fire is prohibited in the vicinity of the instrument.
Fire must not be used at the site where the instrument is installed. In addition, avoid installation in the 
same room with equipment that generates sparks. Do NOT use flammable sprays (such as hairsprays 
or aerosol insecticides) or flammable solvents in the vicinity of this instrument. Provide fire 
extinguishers in case of an emergency.

• Install a sink in the vicinity of this instrument.
If reagent chemicals come in contact with the eyes or skin during operation, flush them away immediately 
with a large quantity of water. A sink should be installed in the vicinity of this equipment if at all possible.
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! CAUTION

• Installation of the instrument is prohibited at sites exposed to corrosive gases, or to 
significant debris and dust.
To ensure the life of the instrument and to maintain its operation, avoid installation at sites exposed to 
corrosive gases or to significant debris and dust.

• Do NOT install the instrument near equipment that generates strong magnetic fields.
To ensure normal operation of this instrument, avoid installation at sites subject to strong magnetic 
fields. In addition, install power line noise filters if there is significant noise from the power source.

• To maintain performance, observe the following site conditions.
• Rooms with an ambient temperature between 18°C and 28°C, and minimal daily temperature 

fluctuations
If the ambient temperature exceeds 28°C, a temperature control error can occur and instrument 
operation may stop.

• Sites where the instrument is protected from direct exposure to drafts from coolers, heaters or air 
conditioners

• Sites protected from exposure to direct sunlight
• Sites not exposed to vibrations
• Sites where humidity is maintained between 40% and 80%
• Sites where condensation does not occur
• Sites with a maximum altitude of 2000 m.

• During analysis, ensure that the drain tube ports and the gap between the top cover and the 
instrument are not directly exposed to light sources, such as desktop fluorescent lamps, 
flashlights, and camera flashes.
This may interfere with the operation of the detector and result in noise.
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9.1.2 Installation Space

! CAUTION

• This instrument weighs 43 kg. When installing the system, consider the total weight 
including PC and other system.
Install the instrument on a flat, stable desk or stand, capable of supporting the total system weight.

• Install the instrument on a flat desk or stand.
If the instrument is placed on a surface which is not horizontal, the analysis performance will be 
adversely affected.

• Installation space for the instrument, PC, and glass rinse water bottle must be at least 
1,015 mm to 1,165 mm W (if a desktop PC is used) by 600 mm D by 980 mm H.
(See " Example Installation 1: Waste container positioned in front of the instrument" P.264.)
These dimensions do not include the waste container, which is placed on the floor. The height reflects 
the maximum size with the cover open.

• When installing the instrument against a wall, leave a gap of at least 50 mm between the 
rear of the instrument and the wall.
If this condition is not met, fan-driven air cooling will not be sufficient and the instrument may 
overheat, reducing performance. In addition, it will not be possible to fully open the top cover.

• Install the instrument at a site where the rear of the instrument can be accessed easily.
The syringe cover on the rear of the instrument must be opened when replacing the syringe or 
plunger.

• Ensure at least a 100 mm space in front of the instrument.
The front cover must be opened to replace the pump cartridges.

• When installing the instrument, leave enough space to operate the power switch at the 
bottom right side at the back.
The power must be turned OFF quickly in the event of a problem with the instrument or other 
emergency.

• Place the waste container on the floor.
Waste fluid is conveyed to the waste container by the difference in water level. Install the container at 
a position lower than the instrument.

• Note the following cautions regarding the waste tubing. Cut the tubing as necessary to suit 
the installation site.

• The tubing should not be bent.
• The tubing should not be elevated.
• The tip of the tubing should not be immersed in the waste fluid inside the waste container.

• If necessary, install safety fasteners and other earthquake measures.
Recommended product: Part No. S037-62401-03, FASTENER, RT-400 GRAY (set of two)
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Example Installation 1: Waste container positioned in front of the instrument

Example Installation 2: Waste container positioned to the right of the instrument
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9.2 Installation Procedures

9.2.1 Rinse Water Tubing

Requirements
• Glass rinse water bottle containing Milli-Q ultrapure water.

^ Reference
"  Glass Rinse Water Bottle" P.285

Procedures

1 Connect the two rinse water tubes and the suction tube ASSY.
This instrument has two rinse tubes-one for the syringe pump (marked with an "F") and another 
(unmarked) for the rinse pool.

2 Insert both of the suction filters to the bottom of the rinse water bottle containing the 
Milli-Q ultrapure water.
The standard accessory cap fits the recommended glass bottle.

! CAUTION

• Connect the tubing correctly. 
Attach the tubes marked with an "F" to each other and the unmarked tubes to each other.

• Ensure that the tubing is not bent. Do NOT over-tighten the fittings.
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9.2.2 Waste Tubing
Arrange the waste tubing to collect the rinse water, separation buffer, and sample waste fluids used during 
analysis.

Requirements
• Waste container

^ Reference
"  Waste Container" P.285

Procedures

1 Verify that the waste container is empty.

2 Insert the waste tubing into the drain hook ASSY provided as a standard accessory.

3 Do NOT bend the waste tubing, pull the tip of the tubing to the top of the waste 
container.
Cut the waste tubing if it is too long.

4 Using the drain hook assembly, fasten the tip of the waste tubing to the waste container.

Waste tubing

Drain hook

Drain hook
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9.3 Power Source Connection

9.3.1 Connecting the Instrument to the Power Outlet

! WARNING

• Always supply power from a power supply equipped with an electrical leakage breaker.

• The instrument's power supply voltage and power consumption are as follows. The power 
supply voltage is indicated on the label on the power connector on the back of the 
instrument. Connect the instrument to a suitable power source.
Connecting it to an improper power source may result in fire or shock.
The intended performance may not be obtained if the power supply voltage is unstable or the power 
capacity is insufficient. Check the power requirements for the entire system before arranging a 
suitable power source.

•  Handle the power cable carefully.
If the following cautions are not observed, the cable may be damaged, resulting in fire, electric shock, 
or malfunction. If the cord does become damaged, contact your Shimadzu service representative 
immediately.

• Do NOT place the power cord under heavy objects.
• Do NOT place the cord near heating equipment.
• Do NOT modify the cord.
• Do NOT forcibly bend or stretch the cord.
• Hold the plug when inserting and removing the cord.

! CAUTION

• Verify that the instrument power switch is OFF, before plugging the cord into the outlet.

Voltage (Indicated on the Label On 
the Back of the Instrument) 100-120/220-240 V ~

Power consumption 300 VA

Frequency 50/60 Hz

Voltage fluctuation Less than ±10%

Interrupting capacity 40 A

Installation category II

Pollution degree 2
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1 Insert the power cable connector into the power connector on the rear of the instrument.

2 Then insert the power cable plug into the power outlet.

9.3.2 Grounding

For 3-pronged power outlets

The instrument ground is provided by the power cable.

! CAUTION

• Do NOT pull on the power cord to remove the plug from the power outlet.

! WARNING

• Ground the instrument to prevent electric shock and ensure stable operation.

• Do NOT insert or touch the power adaptor's ground lead to the power outlet.
This may result in fire or electric shock.

• Never connect the ground lead to a gas pipe, water main, or telephone line. This may result 
in accident or malfunction.
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For 2-pronged power outlets

If the instrument uses a 2-pronged power outlet, ground the instrument reliably using the adaptor ground 
provided.

9.4 Connecting the Instrument to a Computer (PC)
This instrument uses an Ethernet connection (100BASE-TX) to communicate with the PC. The network 
controller port built into the PC is used to connect to the instrument. Use the Windows [Device Manager] to 
confirm that the network controller is operating normally. 

Prepare and connect an expansion network controller (such as a USB LAN adaptor) if connecting the PC 
with another LAN.

^ Reference
"9.5.2 IP Address" P.274

9.4.1 Connection

Requirements
• LAN cable ASSY (Standard accessory)

Procedures

1 Place the PC beside the instrument, and connect the keyboard, mouse, and monitor.

2 Connect the accessory LAN cable to the LAN port on the back of the instrument, and to 
the Ethernet port (RJ-45) on the PC.

3 Connect the PC and monitor power cables to the prescribed outlets.

Power plug

Power outlet

Ground terminalGround lead wire
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9.5 Software Installation
This section describes how to install the MultiNA software (instrument control software and data analysis 
software) on the PC using the provided CD-ROM.

Software installation requirements are listed below.

Follow these procedures to install the following two types of MultiNA software.
• MultiNA Control Software: Controls the instrument. 
• MultiNA Viewer: Displays, prints, and re-analyzes the data obtained. 

9.5.1 Installation

1 Start the PC. Login to Windows as a user with administrative privileges.

2 Place the MultiNA software CD-ROM in the CD-ROM drive.
The [MultiNA Software] setup program will automatically start.
(If it does not start automatically, use Windows Explorer to open the "setup.vbs" file in the CD-ROM drive.)

Do NOT start up "setup.exe". If "setup.exe" is started on a PC where the MultiNA software is already 
installed, the setting values of the preinstalled projects (DNA-500_on-chip, DNA-500_Premix, DNA-
1000_on-chip, DNA-1000_Premix, DNA-2500_on-chip, DNA-2500_Premix, mRNA, and TotalRNA) 
will revert to their default values. Be sure to start up "setup.vbs".

3 The following window is displayed.
Click [OK].

Installation Requirements

• At least 500 MB of free disk space is required on the PC.

• A monitor resolution of at least 1024 x 768 pixels is required.

• Adobe® Reader® from Adobe or other PDF viewing software (provided free) is required to view the PDF manual 
files. Adobe® Reader® (Ver. 4 or later) can be downloaded from the following website:

http://www.adobe.com/products/acrobat/readstep2.html

! CAUTION

• Close all of the other software during the installation.
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4 Click [Next] in the window below.

5 Click [Change] to select a different software installation folder.

Click [Next] to leave the installation folder unchanged.

The folder selection window is displayed.
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6 Select the software installation folder and click [OK].

7 Click [Change] to select a different data storage folder.
Click [Next] to leave the data storage folder unchanged.

8 The folder selection window is displayed.
Select the data folder and click [OK].
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9 Click [Next].
Installation begins.

The following window is displayed when installation finishes normally.

10 Click [Finish].

Installation is complete.
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11 Remove the MultiNA software CD-ROM from the CD-ROM drive.

9.5.2 IP Address
The initial IP address for the instrument, and the recommended IP address for the PC are as follows.

• Initial instrument IP address 172.31.87.45
• Recommended PC IP address 172.31.87.44
• Subnet mask 255.255.255.0

This section describes how to configure the recommended PC IP address. If the IP address of the PC 
connected to the instrument is changed, the software will need to be re-installed (see "9.5.1 Installation" 
P.270) and the following procedures performed.

1 Start the PC. Login to Windows as a user with administrative privileges.

2 On the [Start] menu, select [Control Panel] and click [Network Connections] to open the 
network connections window.

! CAUTION

The following items are automatically configured during installation. Do NOT change these items. If 
these items are changed, the PC may enter standby or halt mode during analysis, or may 
automatically restart.

• [Control Panel] - [Power Options] - [Power Schemes] 
[Always On] is automatically selected. [System standby] and [System hibernates] must be set to 
[Never].

• Windows Automatic Update
This is set to ensure that the PC does not automatically restart after automatic updates.
The following registry value is set to [1].
HKLM\SOFTWARE\Policies\Microsoft\Windows\WindowsUpdate\AU\NoAutoRebootWIthLoggedOnUsers

• Automatic Execution of Windows Disk Defragmenter
Configure settings to disable automatic execution of Windows Disk Defragmenter.
Window Disk Defragmenter rearranges all hard disk content, including data, system files, and 
program files. Disk Defragmenter may affect batch analysis and data if executed during analysis. The 
default setting for Windows XP is OFF and every Wednesday for Windows 7.

! CAUTION

• The PC may also be connected with another LAN through an expansion network controller.
Check with the system administrator at the installation site to ensure that the instrument and PC IP 
addresses do not conflict with the expansion LAN address.

• If they do conflict, contact your Shimadzu service representative and provide the instrument 
and PC IP addresses.
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3 Open the network controller connected with the instrument. Click [Properties].

4 Click the [Internet Protocol (TCP/IP) Properties] item. Enter "172.31.87.44" in the [IP 
Address] field. Enter "255.255.255.0" in the [Subnet mask] field.

5 Click [OK] to close the window.
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9.5.3 Uninstalling the Software
Follow the procedures below to uninstall the MultiNA software from the PC.

1 On the [Start] menu, select [Control Panel] and click [Add or Remove Programs] to 
display the [Add or Remove Programs] window.

2 Select [MultiNA Software] and click [Change/Remove].

3 Select [Remove] and click [Next].

4 Click [Yes] to start the removal process.
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5 The following window is displayed when the removal process is complete.

Click [Finish] to exit.
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10Parts Specifications

10.1 Instrument Components

Components

Standard Accessories

Part Name Quantity Remarks

MULTINA SYSTEM ASSY 1

Standard Accessories 1 set See the table below for parts specifications.

Part Name Part No. Quantity Remarks

IM, MULTINA (E) S292-36026 1 Instruction Manual

QIM, MULTINA (E) S292-28465 1 Quick Manual

CORD, EC-651-N01 S071-60821-09 1 Power cable, 250 VAC, 10 A with earth terminal

CABLE ASSY, LAN IV S292-28124-93 1 LAN crossover cable, 2 m, for connecting the PC with 
this instrument

FUSE, 218 004XP S072-02004-22 2 Fuse 250 V 4 A

MULTINA CD-ROM (J-
E)

S292-36330-91 *1 1 MultiNA software setup CD-ROM

SUCTION TUBE ASSY S292-35753-91 1 Rinse water filter

SAMPLE HOLDER 0.6, 
TABLE

S292-27734-03 1 Sample tube and sample plate fixtures

CAP, 9000-0007 S038-02031-06 1 Cap for glass rinse water bottle (screw cap, standard 
GL45)

SYRINGE, SS-01T S046-00045-01 1 Disposable syringe, 1 mL (for microchip maintenance)

SEAL TIP L S228-40339 1 (For microchip maintenance)

SYRINGE ADAPTER S228-40340 1 (For microchip maintenance)

FILTER, 13A S670-12540-02 1 (For microchip maintenance)

DRAIN HOOK ASSY S292-28021-91 1 Component for fastening the waste fluid tube to the 
waste container

*1 Refer to the release notes for the part numbers of previous software versions (select [All Programs] - [MultiNA] - 
[Release Notes] in the Windows start menu).
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10.2 MultiNA Special Consumables and Maintenance 
Parts

Microchip

^ Reference
"2.1 Microchip" P.17

Reagent Kit

Periodic Replacement Parts

Part Name Part No. Specification

Microchip Type WE-C S292-36000-91 Material: High purity synthetic quartz

Microchip Type WT S292-36010-41 Material: High purity synthetic quartz

Chip cleaning kit -RA S292-35925-91 250 mL, main constituent: ethanol

Open-hole screw cap S292-36329 Cap for chip cleaning solution

Part Name Part No. Remarks

DNA-500 KIT ASSY S292-27910-91 DNA-500 kit (1,000 analyses)

DNA-1000 KIT ASSY S292-27911-91 DNA-1000 kit (1,000 analyses)

DNA-2500 ASSY S292-27912-91 DNA-2500 kit (1,000 analyses)

DNA-12000 ASSY S292-36600-91 DNA-12000 kit (1,000 analyses)

RNA KIT ASSY S292-27913-91 RNA kit (1,000 analyses)

Part Name Part No. Remarks

MICRO SYRINGE 1750C S228-25237-04

PLUNGER ASSY, 1750 S228-25237-14 Plunger

CASSETTE HEAD, SR10/30-N2* S042-00405-13 Pump cartridge*1
Applicable instrument: 292-28000-2X/3X

CASSETTE, WPM1-P2(140)-B S292-96682 RoHS compliant pump cartridge*1
Applicable instrument: 292-28000-4X/5X

*1 Pump cartridges are not compatible between different pumps. Check the type of pump cartridge installed on the 
instrument and replace it with an identical one.
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Maintenance Parts

10.3 Reagents and Apparatus Required for Analysis

DNA Analysis

Part Name Part No. Remarks

SUCTION TUBE ASSY S292-35753-91

STAINLESS STEEL FILTER 
ELEMENT ASSY

S228-45707-91

WARNING LABEL S228-42603 Warning label: Fuse

LABEL, HOT SURFACE S037-72999-12 Warning label: HOT SURFACE (autosampler 
motor)

LABEL, LED S292-27990 Warning label: CLASS 1 LED Product

LABEL, SAFETY ALERT SYMBOLS S037-72999-02 Warning label: Safety alert symbols

LABEL, WARNING S292-27778-07 Warning label: With the exception of locations 
specified in the manual, only a certified Shimadzu 
field engineer should disassemble the instrument.

Product
Vendor

(Manufacturer in 
Parentheses)

Part No.
(Catalog No.) Remarks

Dye

SYBR® Gold Invitrogen S-11494 Mix with separation buffer (dilute 
to 1/10000)

GelStar® TAKARA BIO INC. 
(FMC)

F0535 Mix with separation buffer (dilute 
to 1/20000)

Ladder
25 bp DNA ladder Invitrogen 10597-011 Use with DNA-500, dilute to 1/50
pUC19Hpa II Digest 
(option ladder)

Applied Biosystems AM7770 Use with DNA-500, dilute to 1/50

φX174 DNA/Hae III Markers Promega G1761 Use with DNA-1000, dilute to 
1/100

100 bp DNA Ladder 
(option ladder)

TAKARA BIO INC. 3407A Use with DNA-1000, dilute to 1/10

pGEM® DNA Markers Promega G1741 Use with DNA-2500, dilute to 
1/100

2-Log DNA Ladder 
(0.1 to 10.0 kb)

New England 
Biolabs Inc.

N3200S
N3200L

Use with DNA-12000, dilute to 
1/100

TE buffer - - 10 mM Tris-HCl pH 8.0
Microtube - - 200 μL to 1.5 mL capacity

Use in the preparation of diluted 
dye solution and ladder solution
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Sample tube (single) Recommended sample container

MicroAmp® Reaction Tube Applied Biosystems N801-0533

Sample tubes (8-strip) Recommended sample container

MicroAmp® strip tubes (without 
cap, 8 tubes/strip)

Applied Biosystems N801-0580

8-strip PCR tubes Nippon Genetics 
(ABgene)

AB-0452

8-strip PCR tubes (low profile) 
*1

AB-0771

Sample tubes (12-strip) Recommended sample container
12-strip PCR tubes Nippon Genetics 

(ABgene)
AB-1112

12-strip PCR tubes (low profile) 
*1

AB-0847

Sample plate Recommended sample container

MicroAmp® Optical 96-well 
Reaction Plate

Applied Biosystems N801-0560 

Thermo-Fast® 96 PCR Plate 
Non-Skirted

Nippon Genetics 
(ABgene)

AB-0600

Aluminum seal
Adhesive PCR Foil Seals Nippon Genetics 

(ABgene)
AB-0626

Buffer bottle Assist (Sarstedt) 60,558S Skirted tube (conical, screw cap) 
5 mL
500 (10 × 50 packs)

Product
Vendor

(Manufacturer in 
Parentheses)

Part No.
(Catalog No.) Remarks
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RNA Analysis

Vial BM Equipment NC-502 Capless tube 0.6 mL
1000 tubes/pack (no caps)

Micropipette and tip - - Designed for capacity of 0.5 μL to 
5 mL

Protective equipment - - Protective glasses, protective 
mask, and protective gloves

Vortex mixer - -
*1 Since the tubes have tabs at both ends, they cannot be used with the extra sample stand.

Product
Vendor

(Manufacturer in 
Parentheses)

Part No.
(Catalog No.) Remarks

Product
Vendor

(Manufacturer in 
Parentheses)

Part No.
(Catalog No.) Remarks

SYBR® Green  II Invitrogen S-7564 Separation buffer and mixture

Ladder

RNA6000 ladder Applied Biosystems AM7152 Dilute to 1/6

Formamide
Deionized for biochemical use

UltraPure®formamide

Wako Pure 
Chemical Industries
Invitrogen

066-02301

15515-026

-

RNase ZAP® Applied Biosystems AM9780 Probe rinsing solution

THE RNA Storage Solution Applied Biosystems AM7001 -

TE buffer - - 10 mM Tris-HCl pH 8.0

Microtube - - 200 μL to 1.5 mL capacity
Use in the preparation of diluted 
dye solution and ladder solution

Sample tube (single) Recommended sample container

MicroAmp® Reaction Tube Applied Biosystems N801-0533
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Sample tubes (8-strip) Recommended sample container

MicroAmp® strip tubes (without 
cap, 8 tubes/strip)

Applied Biosystems N801-0580

8-strip PCR tubes Nippon Genetics 
(ABgene)

AB-0452

8-strip PCR tubes (low profile) 
*1

AB-0771

Sample tubes (12-strip) Recommended sample container

12-strip PCR tubes Nippon Genetics 
(ABgene)

AB-1112

12-strip PCR tubes (low profile) 
*1

AB-0847

Sample plate Recommended sample container

MicroAmp® Optical 96-well 
Reaction Plate

Applied Biosystems N801-0560 

Thermo-Fast® 96 PCR Plate 
Non-Skirted

Nippon Genetics 
(ABgene)

AB-0600

Aluminum seal

Adhesive PCR Foil Seals Nippon Genetics 
(ABgene)

AB-0626

Buffer bottle Assist (Sarstedt) 60,558S Skirted tube (conical, screw cap) 
5 mL
500 (10 × 50 packs)

Product
Vendor

(Manufacturer in 
Parentheses)

Part No.
(Catalog No.) Remarks
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10.4 Other Equipment Required for Analysis

Glass Rinse Water Bottle
The following glass rinse water bottle is recommended, as the screw top can be fastened with the cap 
provided as a standard accessory.

Recommended product: LABORATORY BOTTLE (DURAN®), thread standard GL45, 
Cat. No. 21 801 63 5, Capacity 2,000 mL (http://www.duran-group.com/)

Waste Container
Prepare a waste container (glass bottle or plastic tank) with a minimum 2 L capacity. Attach the waste 
tubing using the standard accessory drain hook.

^ Reference
"9.2.2 Waste Tubing" P.266

Microchip Cleaning Wipes
Lint free wipes are recommended for cleaning the microchips.

Recommended product: BEMCOT LINTFREE PS-2 
(http://www.asahi-kasei.co.jp/bemliese/en/industrial_02.html)

^ Reference
"6.2.6 Inspecting and Washing Microchip Reservoirs" P.204

Vial BM Equipment NC-502 Capless tube 0.6 mL
1000 tubes/pack (no caps)

Cap Use in the thermal denaturation of 
ladder and sample solution

MicroAmp®Caps, 8Caps/strip - N801-0535

Oil-free thermal cycler - - Use in the thermal denaturation of 
ladder and sample solution
Designed for rapid cooling after 
heating to 65 °C

Micropipette and tip - - Designed for capacity of 0.5 μL to 
5 mL

Protective equipment - - Protective glasses, protective 
mask, and protective gloves

Vortex mixer - -

*1 Since the tubes have tabs at both ends, they cannot be used with the extra sample stand.

Product
Vendor

(Manufacturer in 
Parentheses)

Part No.
(Catalog No.) Remarks
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10.5 Replacement Guidelines
^ Reference

"6.2 Daily Maintenance" P.199

The following parts must be replaced by a field engineer. Contact your Shimadzu service representative.

Part Guidelines for 
Replacement Part No. Part Name Remarks

Microchip When separation 
performance 
deteriorates

 S292-36000-91
 S292-36010-41

MICROCHIP,TYPE WE-C
MICROCHIP,TYPE WT

Plunger 5,000 analyses
(2 months)

S228-25237-14 PLUNGER ASSY,1750

Syringe 15,000 analyses
(6 months)

S228-25237-04 MICRO SYRINGE 1750C This includes the 
plunger.

Pump cartridge 500 hours
(1 year)

S042-00405-13 CASSETTE HEAD,SR10/
30-N2*

Five are used in the 
instrument.

RoHS compliant pump 
cartridge

500 hours
(1 year)

S292-96682 CASSETTE, WPM1-
P2(140)-B

A RoHS compliant 
dedicated part. Five 
are used in the 
instrument.

Suction filter 2 years S228-45707-91 STAINLESS STEEL 
FILTER ELEMENT ASSY

This instrument uses 
one filter.

Fuse 4 years S072-02004-22 FUSE,218 004 Two are used in the 
instrument.

Part Guidelines for 
Replacement Part No. Part Name Remarks

Sample Probe 80,000 analyses
(2 years)

S292-28054-94 PROBE ASSY 
(with packing)

Air cylinder 1 year or 200,000 
analyses

S292-36075-92 AIR CYLINDER ASSY

Piercing needle 2 years S292-28403 PREPUNCH PIN

Peristaltic pump 1,000 hours
(2 years)

S292-28046-91 PUMP UNIT ASSY Five are used in the 
instrument.

RoHS compliant 
peristaltic pump

1,000 hours
(2 years)

S292-32044-42 PUMP UNIT 2 ASSY A RoHS compliant 
dedicated part. Five 
are used in the 
instrument.
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11

11Appendix

Sections 11.1 to 11.5 briefly explain the preparation of each reagent kit. 

For preparation details, see the sections of this instruction manual listed below.

^ Reference
"3.5 Preparation for DNA Analysis" P.44
"3.6 Preparation for RNA Analysis" P.52
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11.1 Preparation of the DNA-500 Kit (On-Chip Mix)

Requirements

When using an optional ladder, see "11.7 Using Optional Ladders" P.294.

Protocol (Necessary Time: 5 to 10 min.)

Reagent DNA-500 separation buffer (stored at 4°C to 8°C)

DNA-500 marker solution (stored at -20°C)

Diluted dye solution (GelStar® or SYBR® Gold diluted to 100 times using TE buffer)

DNA ladder (Size markers: 25 bp DNA ladder diluted to 1/50, concentration 20 ng/μL; 
pUC19Hpa II Digest (option ladder) diluted to 1/50, concentration 10 ng/μL)

Containers and 
utensils

Sample containers (200-μL tube, 96-well plate + aluminum seal) 

Micropipette (10 μL, 100 μL, 1000 μL)

1 Mix the diluted dye solution into the DNA-500 
separation buffer and agitate using a vortex 
mixer.

 

• Dispense diluted dye solution and separation buffer into a 
buffer bottle.

GelStar®: Dilute to 200 times (final concentration at 
20,000 times)

SYBR® Gold: Dilute to 100 times (final concentration at 
10,000 times)

* For 24 analyses: 1,000 μL of buffer
* For 96 analyses: 3,000 μL of buffer

2 Pour the DNA ladder into a sample tube and 
set it on the extra sample stand.

• When four chips are used for analysis, the DNA ladder is 
analyzed four times, once per chip.

* For 4 analyses: 11 μL of DNA ladder
• Multiple analyses can be performed on the extra sample 

stand.
3 Pour the DNA-500 marker solution into a vial 

and place it in the blue reagent holder position.
• Necessary amount: 2 x (the number of analyses) + 40 μL

4 Put the sample into a 96-well plate, seal with 
the aluminum seal, and place it on the sample 
stand.

• On the sample stand, only one analysis is performed per 
well. 

• For up to 12 samples, put 9 μL of the sample in the tube. 
Aluminum seal is unnecessary.

5 Uncap the buffer bottle, place it in the blue 
reagent holder position and install the sample 
holder on the sample stand. 

1 Separation Buffer

Extra Sample Stand

3 Ladder / Sample

Sample Stand

!
!

2 Marker Solution

Do NOT cap the 
bottle. Cover the sample tube and 

sample plate with the sample 
holder.
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11.2 Preparation of the DNA-1000 Kit (On-Chip Mix)

Requirements

When using an optional ladder, see "11.7 Using Optional Ladders" P.294.

Protocol (Necessary Time: 5 to 10 min.)

Reagent DNA-1000 separation buffer (stored at 4°C to 8°C)

DNA-1000 marker solution (stored at -20°C)

Diluted dye solution (GelStar® or SYBR® Gold diluted to 100 times using TE buffer)

DNA ladder (Size markers: φX174 DNA/Hae III Markers diluted to 1/100, concentration 
10 ng/μL; 100 bp DNA Ladder (option ladder) diluted to 1/10, concentration 13 ng/μL)

Containers and 
utensils

Sample containers (200-μL tube, 96-well plate + aluminum seal) 

Micropipette (10 μL, 100 μL, 1000 μL)

1 Mix the diluted dye solution into the DNA-1000 
separation buffer and agitate using a vortex 
mixer.

 

• Dispense diluted dye solution and separation buffer into a 
buffer bottle.

GelStar®: Dilute to 200 times (final concentration at 
20,000 times)

SYBR® Gold: Dilute to 100 times (final concentration at 
10,000 times)

* For 24 analyses: 1,000 μL of buffer
* For 96 analyses: 3,000 μL of buffer

2 Pour the DNA ladder into a sample tube and set 
it on the extra sample stand.

• When four chips are used for analysis, the DNA ladder is 
analyzed four times, once per chip.

* For 4 analyses: 11 μL of DNA ladder
• Multiple analyses can be performed on the extra sample 

stand.
3 Pour the DNA-1000 marker solution into a vial 

and place it in the green reagent holder position.
• Necessary amount: 2 x (the number of analyses) + 40 μL

4 Put the sample into a 96-well plate, seal with the 
aluminum seal, and place it on the sample 
stand.

• On the sample stand, only one analysis is performed per 
well. 

• For up to 12 samples, put 9 μL of the sample in the tube. 
Aluminum seal is unnecessary.

5 Uncap the buffer bottle, place it in the green 
reagent holder position, and install the sample 
holder on the sample stand. 

1 Separation Buffer

Extra Sample Stand

3 Ladder / Sample

Sample Stand

!
!

2 Marker Solution

Do NOT cap the 
bottle. Cover the sample tube and 

sample plate with the sample 
holder.
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11.3 Preparation of the DNA-2500 Kit (On-Chip Mix)

Requirements

Protocol (Necessary Time: 5 to 10 min.)

Reagent DNA-2500 separation buffer (stored at 4°C to 8°C)

DNA-2500 marker solution (stored at -20°C)

Diluted dye solution (GelStar® or SYBR® Gold diluted to 100 times using TE buffer)

DNA ladder (Size marker: pGEM® DNA Markers diluted to 1/100, Concentration: 10 ng/μL)

Containers and 
utensils

Sample containers (200-μL tube, 96-well plate + aluminum seal) 

Micropipette (10 μL, 100 μL, 1000 μL)

1 Mix the diluted dye solution into the DNA-2500 
separation buffer and agitate using a vortex 
mixer.

 

• Dispense diluted dye solution and separation buffer into a 
buffer bottle.

GelStar®: Dilute to 200 times (final concentration at 
20,000 times)

SYBR® Gold: Dilute to 100 times (final concentration at 
10,000 times)

* For 24 analyses: 1,000 μL of buffer
* For 96 analyses: 3,000 μL of buffer

2 Pour the DNA ladder into a sample tube and 
set it on the extra sample stand.

• When four chips are used for analysis, the DNA ladder is 
analyzed four times, once per chip.

* For 4 analyses: 11 μL of DNA ladder 
• Multiple analyses can be performed on the extra sample 

stand.
3 Pour the DNA-2500 marker solution into a vial 

and place it in the purple reagent holder 
position.

• Necessary amount: 2 x (the number of analyses) + 40 μL

4 Put the sample into a 96-well plate, seal with 
the aluminum seal, and place it on the sample 
stand.

• On the sample stand, only one analysis is performed per 
well. 

• For up to 12 samples, put 9 μL of the sample in the tube. 
Aluminum seal is unnecessary.

5 Uncap the buffer bottle, place it in the purple 
reagent holder position, and install the sample 
holder on the sample stand. 

1 Separation Buffer

Extra Sample Stand

3 Ladder / Sample

Sample Stand

!
!

2 Marker Solution

Do NOT cap the 
bottle. Cover the sample tube and 

sample plate with the sample 
holder.
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11.4 Preparation of the DNA-12000 Kit (On-Chip Mix)

Requirements

Protocol (Necessary Time: 5 to 10 min.)

Reagent DNA-12000 separation buffer (stored at 4°C to 8°C)

DNA-12000 marker solution (stored at -20°C)

Diluted dye solution (GelStar® or SYBR® Gold diluted to 100 times using TE buffer)

DNA ladder (Size marker: 2-Log DNA Ladder (0.1-10.0 kb) diluted to 1/100, Concentration: 
10 ng/μL)

Containers and 
utensils

Sample containers (200-μL tube, 96-well plate + aluminum seal) 

Micropipette (10 μL, 100 μL, 1000 μL)

1 Mix the diluted dye solution into the DNA-
12000 separation buffer and agitate using a 
vortex mixer.

 

• Dispense diluted dye solution and separation buffer into a 
buffer bottle.

GelStar®: Dilute to 200 times (final concentration at 
20,000 times)

SYBR® Gold: Dilute to 100 times (final concentration at 
10,000 times)

* For 24 analyses: 1,000 μL of buffer
* For 96 analyses: 3,000 μL of buffer

2 Pour the DNA ladder into a sample tube and 
set it on the extra sample stand.

• When four chips are used for analysis, the DNA ladder is 
analyzed four times, once per chip.

* For 4 analyses: 11 μL of DNA ladder 
• Multiple analyses can be performed on the extra sample 

stand.
3 Pour the DNA-12000 marker solution into a vial 

and place it in the pink reagent holder position.
• Necessary amount: 2 x (the number of analyses) + 40 μL

4 Put the sample into a 96-well plate, seal with 
the aluminum seal, and place it on the sample 
stand.

• On the sample stand, only one analysis is performed per 
well. 

• For up to 12 samples, put 9 μL of the sample in the tube. 
Aluminum seal is unnecessary.

5 Uncap the buffer bottle, place it in the pink 
reagent holder position, and install the sample 
holder on the sample stand. 

1 Separation Buffer

Extra Sample Stand

3 Ladder / Sample

Sample Stand

!
!

2 Marker Solution

Do NOT cap the 
bottle. Cover the sample tube and 

sample plate with the sample 
holder.
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11.5 Preparation of the RNA Kit

Requirements

Protocol (Necessary Time: 15 to 20 min.)

Reagent RNA separation buffer (stored at 4°C to 8°C)

RNA marker solution (stored at -20°C)

SYBR® Green II storage solution (diluted to 1/100 with 1xTE buffer) 

RNA ladder (RNA6000 ladder diluted to 1/6, concentration: 25 ng/μL)

Formamide

THE RNA Storage Solution (Applied Biosystems)

Containers and 
utensils

Sample containers (200-μL tube, 96-well plate + aluminum seal) 

Micropipette (10 μL, 100 μL, 1000 μL)

1 Add SYBR® Green II storage solution and 
formamide to RNA separation buffer and mix 
them with a vortex mixer.

 

• For 22 analyses, put 790 μL of separation buffer, 10 μL of 
SYBR® Green II storage solution, and 200 μL of 
formamide in the buffer bottle. 

2 Mix the RNA ladder and RNA marker solution in 
the 200-μL sample tube to a 1:1 volume ratio.

• When four chips are used for analysis, the RNA ladder is 
analyzed four times, once per chip.

* Mix 7.5 μL of RNA ladder and 7.5 μL of RNA marker. 
• Multiple analyses can be performed on the extra sample 

stand.
3 Mix the sample and RNA marker solution them 

in the 96-well plate to a 1:1 volume ratio, and 
seal with the aluminum seal.

• Blank (THE RNA Storage Solution) is analyzed first 
(before the ladder) per microchip.

• Mix 3 μL of the sample and 3 μL of RNA marker for each 
well.

• On the sample stand, only one analysis is performed per 
well. 

4 Heat-denature the RNA ladder and sample. • Cap the sample tube.
• Temperature condition: 65°C for 5 min. -> 4°C for 5 min. 

5 Uncap the buffer bottle and place it in the pink 
reagent holder position. Do NOT cap the 
sample tube. Install the sample holder on the 
sample stand.

1 Separation Buffer

Extra Sample Stand

2 Ladder / Sample

Sample Stand

!
!

Do NOT cap the 
bottle. Cover the sample tube and 

sample plate with the sample 
holder.
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11.6 Changing the Type of Dye to Be Used
• Continuous usage of different dye types may have an adverse effect on analysis results.
• When changing the type of dye used by the same microchip, wash the microchip as described in the 

following procedure.

1 Place the microchip in the MultiNA instrument.

^ Reference
"3.3.4 Microchip Registration" P.30
"3.3.5 Microchip Installation" P.32

2 Select [Chip Cleaning] from the [Instrument] menu. Select 1 time for the number of times 
to perform cleaning.

^ Reference
"6.2.9 Chip Cleaning" P.209

3 Prepare separation buffer according to the analysis conditions of the new dye.
DNA Analysis
Mix the diluted dye solution and separation buffer.

^ Reference
"3.5.1 Diluted Dye Solution and Separation Buffer Preparation" P.44

RNA Analysis
Mix the separation buffer and formamide solution. Do not add the diluted dye solution at this point.

^ Reference
"3.6.1 Diluted Dye Solution and Separation Buffer Preparation" P.52

4 Prepare the sample solution and marker solution.
DNA Analysis
Place the TE buffer in the sample stand and the marker solution in the reagent holder (for on-chip mixing).
Alternatively, mix twice the volume of marker solution into the TE buffer and place it in the sample stand 
(premix).

^ Reference
"3.5.2 Ladder, Sample, and Marker Preparation" P.47

RNA Analysis
Mix equal volumes of THE RNA Storage Solution and marker solution and place it in the sample stand.

^ Reference
"3.6.2 Ladder, Sample, and Marker Preparation" P.54

5 Perform analysis three times for the target chip.

^ Reference
"3.7.2 Starting Analysis" P.58
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11.7 Using Optional Ladders
Optional ladders are available for use with DNA-500, and DNA-1000 kits. The optional ladders and dilution 
conditions that can be used with respective kits are indicated below. 

Type and Dilution Conditions for Optional Ladders 

The Ladder Type ID is used by the software to differentiate between ladder types. The ID for standard 
ladders is "Standard (STD)".

When using an optional ladder, analysis performance, such as size accuracy, may not reach the analysis 
performance specifications of the MCE-202 MultiNA (using a standard ladder, see "1.4 Specifications" P.3).

Requirements 
• Optional ladder to be used (see the "Type and Dilution Conditions for Optional Ladders" table above) 
• TE buffer
• Microtube (volumes from 200 µL to 1.5 mL) 
• Micropipettes
• Vortex Mixer 

Procedures 

1 Use a micropipette to dispense TE buffer in the microtube. 
For 1/100 dilutions, dispense 99 μL in the tube, for 1/50 dilutions, dispense 49 µL, and for 1/20 dilutions, 
dispense 19 μL. (Confirm dilution conditions in the "Type and Dilution Conditions for Optional Ladders" 
table above.) 

2 Add 1 μL of optional ladder to the microtube and agitate the solution with a vortex mixer 
for at least 10 seconds. 

Applicable Kit Ladder Type ID 
(abbreviated name) Supplier Name Catalog No. Dilution

DNA-500 Ladder1 (LD1) Applied Biosystems pUC19Hpa II UDigest AM7770 1/50 dilution

DNA-1000 Ladder1 (LD1) Takara Bio 100bp DNA Ladder 3407A 1/10 dilution
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11.8 User Ladders
Ladders that satisfy predetermined conditions can be used as user ladders in DNA analysis.

The recommended conditions for ladders that can be used as user ladders are indicated in the table below. 
Adopt a dilution factor that achieves DNA fragment concentration and DNA total concentration within the 
recommended condition range.

• Recommended conditions for user ladders

• When using user ladders, analysis performance, such as size accuracy, may not reach the analysis 
performance specifications.

• Select a suitable ladder appropriate to the analysis performance of the MultiNA. Peaks that cannot be 
separated or peaks outside the size range may indicate false recognition of such peaks.

• Dilute with TE buffer so that the DNA fragment concentration and DNA total concentration are within the 
recommended condition range. False recognition of peaks can be caused by an unsuitable dilution factor.

• Ladders mixed with loading dye cannot be used.

• The [Point To Point] setting is applied to the size calibration curve of user ladders.

Flow of Operations

Reagent Kit Size Range DNA Fragment 
Concentration

DNA Total 
Concentration

DNA-500 10 to 600 bp 0.5 to 2 ng / μL 1 to 10 ng / μL
DNA-1000 10 to 2000 bp
DNA-2500 10 to 4000 bp
DNA-12000 100 to 12000 bp 0.5 to 1 ng / μL 1 to 10 ng / μL

Registration

Analysis of the user ladder

•Analyze the user ladder as a sample.

•Check the analysis results and register the user ladder.
• Enter ladder information
• Perform analysis
• Check the detected peaks
• Check the calibration curve
• Register ladder information

Use the user ladder

•Use the registered user ladder in analysis.
• Create a project
• Perform analysis
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Procedure

1 Register an analysis schedule that contains the target user ladder.
Register the sample position for placing the user ladder as a sample in the analysis schedule.

^ Reference
"3.4 Analysis Schedule Registration" P.34

2 Prepare the reagent and sample and execute the analysis schedule created in step 1.

^ Reference
"3.5 Preparation for DNA Analysis" P.44, "3.7 Analysis" P.57

3 Register user ladder information.

1 Once analysis is complete, display the data file in the MultiNA Viewer.

^ Reference
"3.8.1 Displaying Data" P.62

2 Click the check box of the target user ladder data.

Click the check boxes of all the user ladder data to analyze the target user ladder at one time.

3 Click [Analyze As Ladder] on the [File] menu.
The [Analyze As Ladder] window is displayed.

^ Reference
"5.2.13 Analyze As Ladder" P.159

4 Enter the required information that includes ladder name, abbreviation, peak table details.
5 Click [Analyze].

The peak detection results are displayed in the MultiNA Viewer.
6 Check the peak detection results and the size calibration curve in the MultiNA Viewer and click 

[Register] if they are satisfactory.
Reanalysis starts and the [Analyze As Ladder] window closes.

The analysis results are not saved when the [Register] button is clicked.

7 Exit the MultiNA Viewer.
A confirmation message for saving the analysis results is displayed.
Click [Yes] to save the analysis results.

^ Reference
"5.2.2 Close" P.140

4 Create a new project that employs the user ladder.

1 Display the [Project Settings] window and enter the required information.

^ Reference
"3.4.1 Project Settings" P.35

2 Click the [Sample] tab and select the newly registered ladder for [Ladder type].
3 Click [OK].

The project settings are saved.
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5 Performing analysis using the created project automatically executes analysis using the 
configured user ladder.

Existing ladder settings can also be modified for ladders other than the one described above. For details on 
the operation method, see "5.2.14 Ladder List" P.161.
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